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About This Guide 

Welcome to the A/UX operating system on your Apple Macintosh computer. A/UX 
brings the Macintosh interface to the traditional UNIX® operating system environment. It 
weds Macintosh ease of use to UNIX standards, power, and programmability. 

This book, A!UX Essentials, presents the basic skills you need in order to use A/UX. 
Many of the chapters contain tutorials to help you learn the essential techniques and 
concepts. You can read through this guide in sequence or go directly to the information 
you need. However, if you are unfamiliar with A/UX, you should go through the first five 
chapters before proceeding on your own. 

This Preface contains the following sections: 

• What is A/UX? 

• Who should use this guide 

• How to use A!UX Essentials 

• Conventions used in this guide 

What is A/UX? 
A/UX brings together two outstanding computing environments: UNIX and the 
Macintosh. 



~ Pref ace 

Why UNIX? 

The UNIX operating system is important because it is a standards-compliant, 
multitasking, multi-user operating system. 

A standards-compliant system is one that complies with industry-wide standards 
that allow it to function on a network with a wide variety of hardware and software. 

A multitasking system is one that allows you to run many processes at the same 
time. Thus, instead of having to wait while your computer prints a text file, you can work 
on another project while the printing is in progress. 

A multi-user system is one that allows many users to work on the same system at 
the same time. This enables them to share files and information. 

The basic A/UX operating system is a combination of UNIX systems 
(AT&T System V.2 and extensions from BSD 4.2 and 4.3). 

Why the Macintosh interface? 

A/UX enhances the UNIX operating system with the Macintosh Finder interface. This 
enhancement differentiates A/UX from all other versions of UNIX. With A/UX you can 
perform the following tasks: 

• Use menu commands and manipulate icons to open, move, rename, or copy files 
and applications on the A/UX and the Macintosh file systems concurrently. 

• Store Macintosh files and applications in the A/UX file system as well as in the 
Macintosh file system. For further information on file systems, see "Introducing 
A/UX" in Chapter 1, "Starting and Finishing a Work Session." 

• Use the Macintosh files or off-the-shelf Macintosh applications while running 
A/UX exactly as you use them while running the Macintosh Operating System 
(Macintosh OS). 

• Run several applications at the same time, taking advantage of both Macintosh 
features and A/UX multitasking capabilities. This applies to both A/UX and 
Macintosh applications in any combination. 



Two operating systems on one personal computer 

A/UX allows you to run Macintosh software applications while using UNIX. Furthermore, 
you can do so while UNIX processes are running. 

As shipped, A/UX sets aside a small area on your disk for the Macintosh OS. It is from 
this area (called MacPartition) that A/UX is launched. It is important to remember that 
you do not need to run your Macintosh applications from this area. You can store your 
Macintosh applications, as well as your Macintosh files, among your UNIX files. This 
gives you the advantage of using UNIX file access permissions and UNIX utilities, such as 
backup tools and file-search utilities, on your Macintosh files. 

In addition, while running A/UX you can use floppy disks configured for the 
Macintosh. You can also use additional hard disks containing the Macintosh file system. 

Thus, you can take advantage of both operating systems at the same time. 

Commando, a command-building tool 

In addition to bringing the Finder's ease of use to the capabilities of UNIX, A/UX also 
adds dialog boxes for running the more than 500 UNIX commands available in A/UX. 
This means that you can now use the many options and utilities that UNIX and A/UX 
make available without having to learn the complex commands and options themselves. 
Each dialog box allows you to use the mouse to select the options. 

Commando is described in full in Chapter 4, "Using UNIX Commands and 
Commando." 

Who should use this guide 
I 

A!UX Essentials contains information that is important to anyone who plans to use 
A/UX. It presents concise tutorials that introduce you to the Macintosh way of interacting 
with the traditional UNIX environment and that briefly explain the uses of essential parts 
of A/UX. 
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Although everyone who uses A/UX should consult A/UX Essentials to become 
familiar with A/UX, this guide is designed particularly for users who are not experienced 
with A/UX or other versions of UNIX. It will also prove useful to those who are 
somewhat new to the Macintosh computer, although this guide assumes that you are 
already familiar with basic Macintosh skills. You should be sure to read Macintosh User's 
Guide: Essentials and to follow the tour disk, Macintosh Basics. 

The road map diagram, just before the beginning of the Table of Contents, illustrates 
the learning path for A/UX . 

How to use A!UX Essentials 

This guide is an introduction to A/UX. You should read at least the first five chapters and 
work through the tutorials in those chapters. Once you are comfortable with the basics 
of A/UX, you can use this book as a reference work. 

Users who are familiar with the UNIX operating system and the UNIX command-line 
interface, but who are new to the Macintosh, should read Chapter 2 carefully ("Using 
Files, Folders, and Directories") to accustom themselves to the Macintosh-like features of 
the Finder. They should also note the flexibility and ease of manipulating CommandShell 
windows (discussed in Chapter 3, "Using CommandShell"), the extent to which 
Commando can simplify the use of UNIX commands (discussed in Chapter 4, "Using 
UNIX Commands and Commando"), and the easy-to-use UNIX Permissions dialog box 
(discussed in Chapter 5, "Permissions"). 

Users who are unfamiliar with UNIX should go through the tutorials in Chapters 3, 4, 
and 5 if there is any likelihood that they will have to use UNIX commands or adjust UNIX 
permissions. 

What's in this guide 

This guide deals with the basics of learning and using A/UX on your Macintosh. 
However, there are many situations that require more specialized information than is 
covered here. The list of topics and references in Table P-1 will tell you where to turn for 
further information. 



AIUX Essentials contains the following chapters: 

• Chapter 1, "Starting and Finishing a Work Session," teaches you how to start the 
system, log in, and log out. Chapter 1 also introduces other skills and information 
essential to getting started. 

• Chapter 2, "Using Files, Folders, and Directories," teaches you how to maneuver 
within the A/UX file hierarchy and use files and folders. It also introduces you to 
UNIX-style pathnames. 

• Chapter 3, "Using CommandShell," shows you how to use CommandShell windows, 
which provide the UNIX command-line interface. This allows you to work directly 
with the A/UX operating system using traditional UNIX commands. 

• Chapter 4, "Using UNIX Commands and Commando," describes a major innovation 
of A/UX, Commando, which allows you to run UNIX commands with Macintosh-like 
dialog boxes. It also introduces the basic concepts of using UNIX commands. 

• Chapter 5, "Permissions," introduces UNIX permissions and teaches you how to 
check them and change them. 

• Chapter 6, "Writing With TextEditor," introduces you to the Macintosh-style text 
editor, which allows you to create and edit text-only files using the Macintosh menus 
and a mouse. 

• Chapter 7, "Printing," describes the different kinds of printer connections and the 
various ways of sending a file to the printer while using A/UX. 

• Chapter 8, "Customizing Your Work Environment," explains how to use various 
devices to create precisely the work environment that you need. 

• Chapter 9, "A/UX Reference," presents a brief summary of all menus and menu 
commands in the A/UX Finder, CommandShell, and TextEditor. 

• Chapter 10, "Troubleshooting," shows how to solve some problems that can arise 
while you are using A/UX. 

• Chapter 11, "Where to Go From Here," gives you information on resources available 
for learning more about A/UX. 

• The Glossary contains definitions of all A/UX terms introduced in this guide. 

For other information about A/UX, you will want to refer to other manuals about the 
operating system. Table P-1 suggests topics you may need to know about and lists the 
books in which you will find the information. 
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Table P-1 Finding further information 

Topic Book 

Setting up and using a network AIUX Networking E'isentials; AIUX Networking System 
Administration 

Setting up a printer for one computer Setting Up Accounts and Peripherals for AIUX 

Setting up a printer for a network Af[;X Networking E'isentials 

Creating a user account Setting Up Accounts and Peripherals for AIUX 

Backing up your entire system Af[JX Local System Administration 

Setting a password for the A/UX Startup AIUX Installation Guide 
application 

Terminology: UNIX-style and Macintosh-style 

Although A/UX links the UNIX and Macintosh environments, these two environments 
use different terminology. For example, Macintosh users are familiar with the word 
"folder." It represents essentially what UNIX users call a "directory." The term 'folder" is 
particularly meaningful when you are using the Finder, where it is represented by a file­
folder icon. In the UNIX environment, however, the term "directory" is more useful. 
Therefore, when you are entering commands in a CommandShell window, it's best to 
think in terms of a directory rather than a folder, especially when you are entering such 
commands as "make directory" (mkdir) or ·'change directory" (cd). 

For that reason, this guide uses Macintosh terminology when describing how to work 
with the Finder and UNIX terminology when describing operations performed in a 
CommandShell window. 

Conventions used in this guide 

A/UX guides follow specific conventions. For example, words that require special 
emphasis appear in specific fonts or font styles. The following sections describe the 
conventions used in all A/UX guides. 



Keys and key combinations 

Certain keys on the keyboard have special names. These modifier and character keys, 
often used in combination with other keys, perform various functions. In this guide, the 
names of these keys are in Initial Capital letters followed by SMALL CAPITAL letters. 

The key names are 

CAPS LOCK DOWN ARRow ( J,) OPTION SPACE BAR 

COMMAND (3€ ) ENTER RETURN TAB 

CONTROL ESCAPE RIGHT ARRow ( ~) UP ARRow(i) 

DELETE LEFT ARROW ( ~) SHIFT 

Sometimes you will see two or more names joined by hyphens. The hyphens 
indicate that you use two or more keys together to perform a specific function. For 
example, 

Press COMMAND-K 

means "Hold down the COMMAND key and then press the K key." 

Terminology 
In A/UX guides, a certain term can represent a specific set of actions. For example, the 
word enter indicates that you type a series of characters on the command line and press 
the RETURN key. The instruction 

Enter ls 

means "Type ls and press the RETURN key." 

Here is a list of common terms and the corresponding actions you take. 
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Term 

Click 

Drag 

Choose 

Select 

Type 

Enter 

Action 

Press and then immediately release the mouse button. 

Position the mouse pointer, press and hold down the mouse button 
while moving the mouse, and then release the mouse button. 

Activate a command in a menu. To choose a command from a pull­
down menu, position the pointer on the menu title and hold down the 
mouse button. While holding down the mouse button, drag down 
through the menu until the command you want is highlighted. Then 
release the mouse button. 

Highlight a selectable object by positioning the mouse pointer on the 
object and clicking. 

Type a series of characters without pressing the RETURN key. 

Type the series of characters indicated and press the RETURN key. 

The Courier j Ont 

Throughout A/UX guides, words that appear on the screen or that you must type exactly 
as shown are in the Courier font. 

For example, suppose you see this instruction: 

Type date on the command line and press RETURN. 

The word date is in the Courier font to indicate that you must type it. 

Suppose you then read this explanation: 

After you press RETURN, information such as this appears on the screen: 

Tues Oct 17 17:04:00 PDT 1989 

In this case, courier is used to represent the text that appears on the screen. 
All A/UX manual page names are also shown in the Courier font. For example, 

the entry 1 s(l) indicates that 1 s is the name of a manual page in an A/UX reference 
manual. See "Manual Page Reference Notation," later in this preface for more information 
on the A/UX command reference manuals. 



Font styles 

Italics are used to indicate that a word or set of words is a placeholder for part of a 
command. For example, 

cat filename 

tells you that filename is a placeholder for the name of a file you want to display. For 
example, if you wanted to display the contents of a file named E 1 vis, you would type 
the word El vis in place of filename. In other words, you would enter 

cat Elvis 

New terms appear in boldface where they are defined. Boldface is also used for 
steps in a series of instructions. 

AIU¥ command syntax 
A/UX: commands follow a specific command syntax. A typical A/UX: command gives the 
command name first, followed by options and arguments. For example, here is the 
syntax for the we command: 

we [-1] [-w] [-cl [filename] ... 

In this example, we is the command, -1, -w, and -c are options and filename 
is an argument. Brackets ([ ]) enclose elements that are not necessary for the command 
to execute. The ellipsis( ... ) indicates that you can specify more than one argument. 
Brackets and ellipses are notto be typed. Also, note that each command element is 
separated from the next element by a space. 

The following table gives more information about the elements of an A/UX: 
command. 
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Element 

command 

option 

argument 

[ l 

Description 

The command name. 

A character or group of characters that modifies the command. Most 
options have the form - option, where option is a letter representing an 
option. Most commands have one or more options. 

A modification or specification of a command, usually a filename or 
symbols representing one or more filenames. 

Brackets used to enclose an optional item-that is, an item that is not 
essential for execution of the command. 

Ellipses are used to indicate that you can enter more than one 
argument. 

For example, the wc command is used to count lines, words, and characters in a 
file. Thus, you can enter 

wc -w Priscilla 

In this command line, -w is the option that instructs the command to count all of the 
words in the file, and the argument Priscilla is the file to be searched. 

Manual page reference notation 

The A!UX Command Reference, the A/UX Programmer's Reference, the A/UX System 
Administrator's Reference, the Xl 1 Command Reference for AIUX, and the Xl 1 
Programmer's Reference for A!UX contain descriptions of commands, subroutines, and 
other related information. Such descriptions are known as manual pages (often 
shortened to man pages). Manual pages are organized within these references by section 
numbers. The standard A/UX cross-reference notation is 

command (section) 

where command is the name of the command, file, or other facility; and section is the 
number of the section in which the item resides. 



• Items followed by section numbers (lM) and (8) are described in the A!UX System 
Administrator's Reference. 

• Items followed by section numbers (1) and (6) are described in the A!UX Command 
Reference. 

• Items followed by section numbers (2), (3), ( 4), and (5) are described in 
the A!UX Programmer's Reference. 

• Items followed by section number (lX) are described in the Xl 1 Command 
Reference for A!UX. 

• Items followed by section numbers (3X) and (3Xt) are described in theXl 1 
Programmer's Reference for A/UX. 

For example 

cat(l) 

refers to the command cat, which is described in Section 1 of the A!UX Command 
Reference. 

You can display manual pages on the screen by using the man command. For 
example, you could enter the command 

man cat 

to display the manual page for the cat command, including its description, syntax, 
options, and other pertinent information. To exit a manual page, press the SPACE BAR 
until you see a command prompt, or type q at any time to return immediately to your 
command prompt. 

For more information 

To find out where you need to go for more information about how to use A/UX, see 
Road Map to A!UX. This guide contains descriptions of each A/UX guide and ordering 
information for all the guides in the A/UX documentation suite. 
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1 Starting and Finishing a 
Work Session 

This chapter introduces you to A/UX; it then explains how to start and end a work 

session and what to do when you're ready to quit working for the time being. It also 

explains how to shut down the computer. Chapter 1 covers the following topics: 

• Introducing A/UX 

• Starting the computer 

• Starting A/UX 

• Logging in 

• You're ready to work 

• What are you allowed to do? 

• Logging out 

• Shutting down A/UX 

• About system administration 

Although this chapter is designed to be read in sequence, you can also use it as a 

reference work by going directly to the section that contains the material you need. 



Introducing A/UX 

A/UX joins two systems that have different histories and different styles of operation, but 
that now work together. They are the UNIX® operating system (in Apple Computer's 
version, called A/ill) and the Macintosh Finder, which is familiar to all those who have 
used the Apple Macintosh computer. In practical terms, this means that you are using the 
UNIX operating system through the Macintosh user interface. This allows you to use 
Macintosh icons and mouse operations to manipulate the commands and utilities that 
give UNIX its flexibility and power. 

Although this guide speaks of using A/UX instead of the Macintosh Operating System 
(OS), in fact, there is one area of your startup disk, called MacPartition, that contains the 
Macintosh OS. This is used to start the computer and to give the computer the command 
to load and launch A/UX. MacPartition contains a Macintosh file system; the files on the 
rest of the disk are contained in one or more UNIX file systems. 

While you are running A/UX, the Finder allows you to open files and folders, close 
them, copy them, and move them, and to perform a variety of other functions as well. 
You can use the Finder to manipulate all files and folders that you have permission to 
manipulate (UNIX permissions are discussed in Chapter 5, "Permissions"). This is true 
whether they are stored in a UNIX file system or in the Macintosh file system. 

In summary, A/UX offers you three distinct environments: 

• The A/UX Finder, which provides access to both your UNIX and your Macintosh file 
systems. 

• The Macintosh OS, which provides access only to files and folders that are in 
MacPartition or in a Macintosh file system on some other disk. Files and folders 
contained in a UNIX file system are not visible from the Macintosh OS Finder. 
Chapter 2 contains a section that tells you how to turn on the Macintosh OS ("Getting 
to the Macintosh OS"). 

• CommandShell (a UNIX command-line interface) provides access only to UNIX file 
systems. CommandShell cannot work with any material stored in a Macintosh file 
system, such as MacPartition. 
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Starting the computer 

Before you start the computer, you or the system administrator should set up your 
hardware according to the instructions that were packaged with it, install A/UX by 
following the directions in the A!UX Installation Guide. Consult Setting Up Accounts and 
Peripherals for A!UX for connecting and setting up peripheral devices such as printers. 

Turn on the computer as follows: 

• Press the POWER ON key. 

The POWER ON key is the key with a small triangle. It is at the top of the keyboard, either 
in the middle or in the right corner. The Macintosh SE/30 has its power switch on the 
back of the computer. 

r~ 
• • • POWER ON key • • . . 

·. . . 

The computer starts up and displays the message Welcome to Macintosh, which 
indicates that the computer is starting the Macintosh OS. A/UX will be launched from the 
Macintosh OS. Proceed to "Starting A/UX." 
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Starting A/UX 

There are two ways to start A/UX: 

• Automatically, by presetting your system so that the A/UX Startup application 
launches as soon as the computer begins to run the Macintosh OS 

• Manually, by following the directions in "Starting A/UX Manually" 

If A/UX is set to start automatically, the system loads and launches A/UX now. If your 
system launches in this way, continue with "Loading and Launching," later in this 
chapter. 

A/UX does not start up automatically unless you or the system administrator have set 
it to start automatically. Although the installation instructions advise setting automatic 
startup, your system can be set for manual startup of A/UX. 

If you wish to set your system to start A/UX automatically, proceed to the next 
section, "Setting Automatic A/UX Startup." 

If your system is not set to start A/UX automatically and you wish to start A/UX 
manually, proceed to "Starting A/UX Manually," later in this chapter. 

Setting automatic A/UX startup 

If your system is not set to start A/UX automatically, you can set it to do so after the 
MacPartition disk icon is displayed (Figure 1-1), and before you start A/UX manually. 

1. 
MacP art;tion 

Figure 1-1 The MacPartition icon 

Follow these steps: 

1 Position the mouse pointer in the Control Panels icon of the Apple ( 9) menu 
and release the mouse button to display the Control Panels window. 

1-4 Chapter 1 Starting and Finishing a Work Session 



D Control Panels 
18 items 52 .4 MB io disk 22.5 MB available 
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Startup Disk control panel icon 

2 Double-click the Startup Disk control panel icon. 

The following window appears. 

§0 Startup Disk 

Seo le-ct a Startup Disk : 

- ~ llNfiUIMii Extra Mac Disk 

3 Click on the MacPartition icon to select it and click the close box to close the 
control panel. 

4 Double-click the MacPartition icon (at the right edge of the screen) to display 

the MacPartition window, if it is not already displayed. 

The MacPartition icon is shown in Figure 1-1. 
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5 Create an alias of the A/UX Startup application by clicking the A/UX Startup 
icon in the MacPartition window and choosing Make Alias from the File menu. 

A duplicate of the A/UX Startup application icon appears beside the original, with the 
name A!UX Startup alias. 

!U Mac Partition 
8 items 2 .5 MS in disk 1 .3 MB available 

llJ CJ 

I 
System Folder bin 

~I ~I 
~A~ ~.,.;m 

boot....od es oh launch 

6 Open the System Folder icon in the MacPartition window by double-clicking 
its icon. 

=o System Folder 
11 items 2.7 MB in disk 1 .1 MB available 

Ci]~~ §(g) 
Apple Menu Items ExtenS1ons Clipboard Control Panels Finder 

~ m [@:] LillJ 
Preferences System Scrapbook File Startup Items 

7 Drag the A/UX Startup alias icon to the Startup Items icon to place it in the 
Startup Items folder. 

8 Close the System Folder by clicking its close box. 

The next time you start the computer, the process described later in this chapter, in 
"Loading and Launching," starts automatically. 

For further information on setting automatic A/UX startup, see A/UX Local System 
Administration. 
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Starting A/UX manually 

If A/UX is not set to start automatically, you must start A/UX by running the A/UX 
Startup application manually. Follow these steps to start up A/UX manually: 

1 Double-click the MacPartition icon, which is located at the right edge of the 
screen. The MacPartition icon is shown in Figure 1-1. 

The A/UX Startup icon appears in the MacPartition disk window. 

D Mac Partition 0ii 
6 items 1 .4 MB in disk 2 .4 MB •v •il•b le 

~~I 
~~ 

R/UM Imm 
Sy stem Folder bin A /UX Startup ~ 

.L -0 
¢Jimmrrr::m:::::::::::::::::::::::::::::::::::::::::::::::1~w:::::::::::::::::::1 l c:> '2l 

A/UX Startup icon ___/ 

2 Double-click the A/UX Startup icon to launch A/UX. 

A/UX begins the loading and launching process. 

Loading and launching 

As the A/UX Startup program runs, a series of screens appears to inform you of its 
progress. One of these screens is shown in Figure 1-2. 

The A/UX Startup application checks the condition of the file systems each time you 
start A/UX and fixes problems identified during the check. For example, problems can 
be caused if the system was shut down improperly the last time it was used. This check 
can last for several minutes. 

~~I Welcome to R/UH. 
~~ 

RtuM Checking root file system ... 

·····=========:J (Messages J 

Figure 1-2 A startup status screen 
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+ Note During the loading and launching process, the screen might flicker or even 
become blank for a moment. However, the progress bar reappears quickly and the 
process continues. • 

The Cancel and Messages buttons in the Startup screen 
When the startup process begins, a Cancel button is available at the right of the progress 
bar (shown in Figure 1-2). You can cancel the Startup program by clicking the Cancel 
button. 

The Cancel button changes to a Messages button after a few seconds. If you click the 
Messages button, a small window appears that displays status messages describing the 
progress of the startup process. If you are a nontechnical user, you probably will not use 
this feature. 

6 Important A/UX might report alert messages during the startup sequence. In some 
cases, you must supply information in response to the message. If this happens, an alert 
box appears and tells you that there is a message for you. When you click OK in the alert 
box, an A/UX System Console window appears, into which you can enter any 
information that the program requests. For further information on the A/UX System 
Console window, see "Using the A/UX System Console" in Chapter 3, "Using 
CommandShell." 1\ 

Logging in 

At the end of the startup process, the Login dialog box appears. Proceed with the 
next section, "Logging In," to learn about logging in to different accounts in A/UX. 

Unlike the Macintosh OS, A/UX supports many users on a single computer. Therefore, 
you must identify yourself to the system before you can be permitted to use it. This 
procedure is called logging in. 
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User accounts and home directories 

The terms user account and home directory (or home directory folder) appear 
frequently in A/UX manuals, as they do in the documentation of all UNIX systems. A 
brief discussion of these terms follows. 

The user account 

Just as you must have a bank account in order to use the services of a bank, so you must 
have an account on an A/UX system before you can use A/UX. This allows you to 
protect your files and information from being used by others, in the same way that your 
bank account protects your deposits and information about your deposits from outsiders. 
Your files are protected by a scheme of permissions that is discussed in detail in 
Chapter 5, "Permissions." 

As shipped, A/UX contains a Guest account to which anyone can log in, and a start 
account which is used for tutorial purposes. In addition, your system administrator might 
have created a user account that is meant for your personal use. 

The start account and the Guest account can be used by several users, although your 
system administrator might require use of a password to log in to those accounts in order 
to limit the number of people who have access to them. For information on passwords, 
see the information on logging in later in this chapter, and see "Changing Your 
Password" in Chapter 8, "Customizing your Work Environment." 

If you are a regular user of the system, you should have your own user account. Your 
system administrator assigns a login name (also called the user name and the user 
account name) to you when he or she creates your user account. If you are acting as 
your own system administrator, you can find instructions for creating a user account in 
Setting Up Accounts and Peripherals for A!UX. 

The home directory folder 

Your login name is simply a designation that tells the system that you are a legitimate 
user with an account. Your home directory folder, however, is an actual folder that 
contains your own files. It is common practice to name the home directory folder with 
the users login name. Whenever you log in to A/UX, an alias of your home directory 
folder icon appears near the right edge of the screen. Figure 1-3 shows the alias of the 
home directory folder for the start account. 
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Figure 1-3 The home directory folder alias for the start account 

An alias of a file or folder is an icon that is linked to the original file or folder so that it 
can be manipulated like the original. However, you can put the alias in a different place 
in the file hierarchy without moving the original file or folder. In addition, the alias is 
usually normally given the name of the original file or folder plus the word alias. Since 
the name of your home directory folder is likely to be your login name, the folder that 
appears at the right edge of the screen is named with your login name plus alias, for 
example, start alias. 

If the folder has been moved to another part of the screen, it appears in its new 
position when you next log in. 

Your home directory folder is your home base on the computer while you are using 
A/UX. Although you can spend as much time as you want away from home, your home 
remains your headquarters and is probably the place where you keep most of your 
belongings. 

The phrase home directory folder is an adaptation of the standard UNIX term home 
directory. What the UNIX world calls a directory is called a folder in the Macintosh 
world, and appears in the A/UX Finder with a folder icon. Therefore the name home 
directory folder has been coined. 

You can deny other users permission to add files to your home directory folder or to 
remove files from it, and you also can control their ability to read or change any files that 
you have created, whether or not these files are situated in your home directory folder. 
For further information on these file- and folder-protection schemes, see Chapter 5, 
"Permissions." 

Your login name 

For purposes of your A/UX system, you are identified by the name under which you 
logged in. Moreover, your login name determines the name of your home directory and 
which files and folders you have permission to use. 
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The Login dialog box 

When you log in, you give the system two pieces of information: 

• your login name 

• your password 

You can log in to any one of several types of accounts: 

• the start account for tutorials 

• the Guest account for guest users (if the system administrator has restricted access to 
the start account) 

• your own user account (if the system administrator has assigned you one) 

• the root account for system administrators 

This section describes how to log in to these accounts. 
As soon as A/UX Startup finishes running, the Login dialog box appears. You can log 

in whenever you see the Login dialog box, shown in Figure 1-4. 

+ Note Several login options are available while the Login dialog box is displayed. 
These options include changing your password. If you are a new user, your system 
administrator might have assigned you a temporary password with the understanding 
that you would use the Change Password login option to choose your own password as 
soon as possible. To do so, see "Changing Your Password," in Chapter 8. Other login 
options are also explained in Chapter 8; see "Changing Your Session Type." • 

c!-~ Welcome to H/UH Startup. 
A/UM 

Log in as: 

O Guest 
® Registered User 

Name: I root 
:=::==========: 

Password: ~II _____ ~ 

( Login )J 

Figure 1-4 The Login dialog box 
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To log in means to enter the name of the account you are about to use and to enter 
the account's password (if required). The three sections that follow describe how to log 
in to the start account, the Guest account, and the user and root accounts. Refer to the 
section of this chapter that describes how to log in to the account you want to use. 

Important UNIX is case sensitive, that is, it distinguishes between uppercase and 
lowercase letters. If your login name is supposed to be john, but you type John, 

A/UX won't recognize it because of the uppercase J. This is true of all character 
sequences that A/UX reads, such as commands, passwords, folder names, and so on. 

Logging in for the tutorials 

The start account contains the files associated with the various tutorials in this book. Log 
in to this account whenever you use a tutorial presented in this guide. 

To log in to the start account, follow these steps: 

1 While the Login dialog box is displayed, click the Registered User button to 
select it, unless it is already selected. 

2 Type start as the login name. 

The login name for the tutorial account is st art. Notice that all the letters in the name 
start are lowercase. Remember to enter the login name exactly as specified, using 
lowercase letters unless capital letters are indicated. 

3 Press RETURN. 

This action moves the cursor to the Password text box. You also can press TAB or click 
the Password text box to move there. A/UX asks you for a password to ensure system 
security. Each account has a password so that only the person who is entitled to use that 
account has access to it. 
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4 Type my. passwd or use the password given to you by the system 
administrator. 

Note that the period in my. pas swd has no spaces before or after it. 

A gray rectangle expands through the Password text box as you type each character. 

Since the password my .passwd appears in this book, it's a good idea to change this 
password immediately, to prevent anyone from breaking into your system by using the 
start account. Your system administrator might already have changed the password. 

To change the password for your account, see "Changing Your Password," in 
Chapter 8, "Customizing your Work Environment." 

5 Click Login or press RETURN. 

If the password and the login name are correct, you're logged in and the Finder appears 
after a few moments. If you type the wrong login name or password, a warning dialog 
box appears. Try again, and be sure that you are typing lowercase and uppercase letters 
as required. 

If you make a mistake while typing your login name or password, click the Name or the 
Password field to select it; then press the DELETE key. . 

Type the login name or password again and click Login or press RETIJRN. 

Proceed to "You're Ready to Work," later in this chapter. 

Logging in to the Guest account 

If your system administrator has not set up a user account for you, you can use the 
Guest account. 

To log in to the Guest account, follow these steps: 

1 While the Login dialog box is displayed, click Guest 

The system administrator might have set up the system so that you do not need to enter 
the Guest account password. 
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• If you aren't required to enter a password, the Password field does not appear when 
you click the Guest radio button. 

• If you are required to enter a password, the Password field appears in the Login 
dialog box. If you do not know the password, see your system administrator or the 
person in charge of the Guest account. 

2 If a password is required, type the password. 

3 Click Login or press RETURN. 

See "Changing Your Password" in Chapter 8, "Customizing Your Work Environment," for 
more information on security and passwords. 

If you make a mistake while typing your password, click the Password field to select it; 
then press the DELETE key. Type the password again and click Login or press RETURN. 

If the password is correct, you're logged in and the Finder appears after a few moments. 
Proceed to "You're Ready to Work," later in this chapter. 

Logging in to your user account or the root account 

Your personalized user account allows you full use of the files that you create. It also 
contains files that specify preferences about your work habits, such as the pattern of 
your desktop. Your system administrator has set up the account by using the adduser 

script described in Setting Up Accounts and Peripherals for A/UX or by following 
standard UNIX procedures for setting up a user account. You should log in to this 
account whenever you're working with A/UX, except when using the tutorials in this 
book, in which case you should log in to the start account. 

If you are authorized to have access to all files in the file system in order to perform 
system maintenance and system administration tasks, and if you know the password for 
the root account, you also can use these instructions to log in to the root account. 
Substitute the name root for your user name. 
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To log in to your user account or the root account, follow these steps: 

1 While the Login dialog box is displayed, click the Registered User button, unless 
it is already selected. 

2 Type your login name. 

If you are logging in to the root account, type root. If you are logging in to a user 
account, type the login name assigned to you by your system administrator. Remember 
to enter the login name exactly as specified, using lowercase letters unless uppercase 
letters are indicated. 

3 Press RETIJRN. 

This action moves the cursor to the Password text box. You also can press TAB or click 
the Password text box to move the cursor there. A/UX asks you for a password to ensure 
system security. Each user account has its own password. To change your account 
password, see "Changing Your Password," in Chapter 8, "Customizing Your Work 
Environment." 

If the system administrator created your user account without assigning a password, you 
might be asked to assign your own password by typing it into the space provided. 

4 Type your password. 

A gray rectangle expands through the Password text box as you enter each character. 

5 Click Login or press RETIJRN. 

If you make a mistake while typing your login name or password, click the Name or 
Password field to select it; then press the DELETE key. 

Type the login name or password again and click Login or press RETURN. 

If the password and the login name are correct, you're logged in and the Finder appears 
after a few moments. Proceed to the section called "You're Ready to Work." 
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You're ready to work 

The Finder now appears, as shown in Figure 1-5. This is a special application that 
manages the desktop. It displays icons that represent the available UNIX and Macintosh 
file systems. The Finder makes it easy to work with disks and many types of files, such as 
text files, programs, and utilities. Use the Finder to open a folder or a file or to execute a 
program by double-clicking its icon. 

If you started A/UX manually, by opening the MacPartition folder and double­
clicking the A/UX Startup icon, the MacPartition folder might still be open. You can close 
it by clicking the close box at the upper left of the MacPartition window. If your system 
starts A/UX automatically, the MacPartition folder is probably not open when the Finder 
appears. 

Figure 1-5 The A/UX Finder 
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The Secure Startup feature 

If the MacPartition icon does not appear in your Finder, it means that your system 
administrator has activated a feature called Secure Startup. This is a security feature that 
prevents users from opening the MacPartition window. If Secure Startup is running, your 
system launches A/UX automatically; you do not need to open MacPartition to launch it. 
Only users logged in to the root account can see and open MacPartition. 

For further information on Secure Startup, see A/UX Installation Guide. 

Locating the start folder 

If your system administrator has set up a user account for you, an alias of your home 
directory folder, labeled with your login name and the word alias, appears near the right 
edge of your screen. If you logged into the start account (or the Guest account), the start 
(or Guest) folder is your home directory folder. 

+ Note If others have used your system before you, you can see the same windows 
that were displayed when the previous user logged out. It's possible, therefore, that a 
window is covering the icon for your home directory folder. If so, you can move some of 
the windows to find the icon. • 

If you are not logged in to the start account, but you want to use the st art folder 
for the tutorials in this book, locate the start folder as follows: 

1 Double-click the UNIX file hierarchy icon, at the upper right of the screen. 

This is the disk icon with the slash(;) label. This action opens the I folder, which is at 
the top of the UNIX file system. The icon is called either the UNIX file hierarchy icon or 
the slash (I) folder icon. 

1. 
I 
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2 Double-click the folder labeled users. 

Both the start and the Guest folders are now visible. Other users' home directory folders 
also can be located here. 

I 
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3 Select the start folder icon. 

4 Choose Make Alias in the File menu. 

A new icon labeled start alias appears. 

5 Drag the start alias icon to the desktop. 

You can double-dick the start alias icon to open the st art folder and use its files. 

The next section, "What Are You Allowed to Do?" describes the tasks you can 
perform while using different login accounts. 
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What are you allowed to do? 

Table 1-1 shows the types of actions you can perform in the different types of login 
accounts. It also tells you where you can find more information about these tasks. 

Table 1-1 What you can do 

Who you are Tasks you can perform 

Registered user Log in and log out 

Guest user 

Root user 

Use UNIX programs and utilities 

Create, print, manage, and store documents 

Use Macintosh Applications 
and desk accessories 

Change your password 

Connect to a network 

Same as registered user 

All the above, plus: 
Add user accounts 

Shut down the system and start it up again 

Add and manage peripheral devices 

Set up and manage a network 

Where to find information 

Chapter 1 

Chapters 2 and 4 

Chapters 2 and 7 

Macintosh Reference; 
Application user's guide 

Chapter 8 

A!UX Networking Essentials 

Setting Up Accounts and 
Peripherals for A!UX 

Chapter 1 

Setting Up Accounts and 
Peripherals for AIUX; A!UX 
Local System Administration 

A!UX Network System 
Administration; A!UX 
Networking Essentials 

When you're ready to stop working, see the next section "Logging Out," for 
instructions on logging out of A/UX. 
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Logging out 

When you finish your work with A/UX, end your work session by logging out. If you 
walk away from your computer without logging out, anyone who uses your computer 
has access to all your files, just as you do. If you log out, the next user must log in to his 
or her own account to gain access to the system . 

.._ Warning Logging out is not the same as shutting down the computer. When you log 
out, the computer continues to run. In order to shut down the computer, you must be 
logged in to the root account or you must know the root password. For information on 
shutting down, see "Shutting Down A/UX" later in this chapter. A. 

Log out as follows: 

1 Choose Finder in the Applications menu to be sure that the Finder is the active 
application. 

The Applications menu appears when you click the icon at the far right of the menu bar. 

2 Choose Logout in the Special menu under the A/UX Finder. 

The system reminds you to save all your unsaved work. 

After you log out, the Login dialog box reappears, indicating that you have logged out 
successfully. The computer remains on, ready for the next user to log in. 

Shutting down A/UX 

When you finish working you should log out, not shut down the computer. For 
information on logging out, see "Logging Out," earlier in this chapter. 

Sometimes you need to shut down A/UX to do system maintenance, such as adding 
peripheral devices, adding your system to a network, or repairing a file system. To shut 
down the system properly, you need to know the password for the root account. 
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.A. Warning Don't use the switch on the back of the Macintosh computer to tum it off 
while A/UX is running. Doing so might corrupt the file system and cause a loss of data. 
Always use the correct shutdown procedure to tum off the computer. .A 

Shutting down the computer 

Follow these steps to shut down the computer: 

1 With either the Finder or the Login dialog box displayed, choose Shut Down 
from the Special menu. 

If you want to shut down and start up again immediately, choose Restart, instead of Shut 
Down, from the Special menu. The Restart dialog box appears. The procedure is the 
same as the shutdown procedure. 

If you are not logged in to the root account, you see the Shut Down dialog box. 

Shut Down ... 

You must haue root priuileges to shut 
this system down. 

Root password: I 
~------~ 

Cancel } f( Shut Down J 

2 Enter the root password in the appropriate text box. 

3 If others are using the system, type a warning message in the next text box. 

Your message is sent to other users. 

If you are the sole user of this system, you are not asked for this information. 

4 Type a number specifying the delay, in minutes, between the time the message 
is transmitted and the time the other users must finish logging out. 
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Give the other users a reasonable amount of time to save their work and to log out. 

If you are the sole user of this system, you are not asked for this information. 

5 Click Shut Down. 

About system administration 

When several people use an A/UX system, a system administrator must maintain the 
system. The system administrator sets up user accounts, backs up the system, sends 
messages regarding procedures and schedules, maintains system security, and serves as 
a troubleshooter for any problems that arise. 

You might be the only person using the computer. In this case, you must act as your 
own system administrator, using the root account to perform maintenance tasks. This 
account has access to all files in the entire file system. Thus, if you're the system 
administrator for your A/UX system, you should log in to your user account to do your 
normal work. When you need to perform a maintenance task, you must log in to the 
root account. 

Maintaining the start account 

The start account is meant to be used by new users. After someone uses it for tutorials, 
the material in the start folder might well be altered. To restore it to its original condition, 
run the setup script as follows: 

• Double-click the setup icon in the start folder. 

The start folder is restored to its original form. 

For further information on administering a system that is not part of a network, see 
Setting Up Accounts and Peripherals for A!UX and A/UX Local System Administration. 
For information on administering a system connected to a network, see A/UX Networking 
Essentials and A!UX Network System Administration. 
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2 Using Files, Folders, 
and Directories 

This chapter describes situations in which the use of folders and files in the A/UX Finder 

differs from their use in the Macintosh OS. It also defines pathnames, that is, the way the 

UNIX operating system describes the locations of files and directories in the file 

hierarchy. 

• The Finder in A/UX 

• Using the Finder 

• The Finder icons 

• · Using files and folders in the Finder 

• Working with Macintosh files 

• Getting to the Macintosh Operating System 

• Backing up and restoring files 

• UNIX pathnames 



The Finder in A/UX 

As the Preface to this guide states, you should be acquainted with the basics of using the 
Macintosh, including all the elements of moving, copying, opening, closing, naming, and 
displaying files and folders in the Finder. Since these basic techniques are the same in the 
A/UX Finder as they are in the Macintosh OS Finder, they are not taught in this guide. 

There are a number of unique features in the A/UX Finder. This chapter concentrates 
on these features and the ways in which they affect you. 

Using the Finder 

This section identifies the various objects that appear in the Finder in A/UX. You will 
recognize the similarity between the A/UX Finder (shown in Figure 2-1) and the 
Macintosh Finder. Note that the MacPartition folder is not open in Figure 2-1. As you 
learned in Chapter 1, "Starting and Finishing a Work Session," this window is open if you 
have started A/UX manually. It might not be displayed if you have set A/UX to start 
automatically. If Secure Startup is turned on (see "The Secure Startup Feature" in 
Chapter 1), the MacPartition is not visible at all. 

The A/UX Finder allows you to work with different A/UX and Macintosh applications 
concurrently. You can copy and paste information between documents and applications 
easily and quickly, without having to save the file from one application before you open 
a file from an other application. 

The Finder icons 

The A/UX operating system contains many files and folders, each of which is represented 
by an icon in the Finder. This section illustrates the icons you see and describes what 
they represent. 
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Figure 2-1 The A/UX: Finder 

Folders and directories 

A/UXfile 
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Home directory 
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MacPartition 
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A reminder about terminology: In traditional UNIX terminology, the term directory is 
used for the object that is called a folder in the Macintosh environment. Thus, in 
traditional UNIX terms, the file system contains directories, which, in turn, can contain 
files and other directories. This is also true of the UNIX file systems supported by A/UX. 

Although users who are using UNIX in CommandShell (described in Chapter 3, 
"Using CommandShell") will find it useful to think in traditional UNIX terms, and will 
refer to directories rather than folders, those who are using the Finder will prefer to think 
in terms of the folder and file icons. Because the Finder is discussed in this section, the 
term folder is used consistently here. In sections that discuss the A/UX command-line 
interface, which is in the style of the UNIX system (for example, in "UNIX Pathnames," 
later in this chapter), the word directory is used. 
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The icon for a given file or folder changes according to user permissions (for a 
description of permissions, see Chapter 5, "Permissions"). Icons that are shaded, for 
example, indicate that you have neither read nor write permission. Note that this refers 
only to your permissions. Other users might have different permissions, and their own 
permissions are reflected in the icons they see. 

Folder icons 

This section illustrates the different folder icons that you might see in the Finder. 

CJ 
Guest 

LJ 
start.bak 

LiJ 
locked folder 

r1J 
drop box 

(}] 
Sy stem Folder 

Folder: These two icons represent folders for which you have read 
and execute permission, that is, the ability to open the folder and see 
what files or folders are in it. You might or might not have write 
permission, that is, the ability to add, rename, or remove items. The 
marked tab on the bottom folder indicates that you own the folder, that 
is, you created it, or ownership has been transferred to you. 

Locked folder: This icon indicates that you cannot open this folder, 
nor can you change any of its contents. 

Drop box: This icon represents a folder for which you have write and 
execute permission only. You cannot open the folder or read the files 
in the folder, but you can place files in it. 

Active System Folder: This icon represents the System Folder that the 
system is currently using. 

Home directory folder: This icon represents the alias of your home 
directory folder. When it appears automatically, at the right edge of the 
Finder screen, the name of the folder is normally your login name and 
the word alias. 
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File, application, and utility icons 

The following icons represent various kinds of files in A/UX. They include files that are 
commands, scripts, applications, and text documents. 

iJ 
passwd 

I 
john 

~ 
lflJ 

nextunix 

grep 

basename 

A/UX text files: These icons represent a text file for which you have 
read permission (top) and one for which you do not have read 
permission (bottom). When you double-dick the icon on the top, the 
file opens using the default text editor. You cannot open the file on the 
bottom because you do not have read permission. For information on 
the default text editor, see "Changing the Default Text Editor" in 
Chapter 8, "Customizing Your Work Environment." 

Binary data file: This icon represents a file that is not a text file; it 
contains code that can only be read by the computer or by a program. 
You can neither read nor execute this file. 

UNIX command: This icon represents a UNIX command. When you 
double-dick this icon, a Commando dialog box appears, which allows 
you to run the command. Commando is described in Chapter 4, "Using 
UNIX Commands and Commando." 

Shell script: A shell script, often called simply a script, is an 
executable text file that contains a series of commands for the 
computer to carry out. Many scripts are created by system 
administrators and by users on site and are not an integral part of the 
UNIX operating system. Note the similarity between this icon and the 
A/UX command icon shown above it. This icon functions as though it 
were a UNIX command icon, that is, double-clicking the icon displays 
a Commando dialog box. If no Commando dialog box has been 
created for the shell script, a default dialog box appears. For further 
information on options and arguments and on Commando dialog 
boxes, see Chapter 4, "Using UNIX Commands and Commando." For 
information on creating scripts, see A!UXShells and Shell 
Programming. 
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App lic:ation 

HyperCard 

Executable file (without read permission): This icon represents a 
file that you can run (such as an application), but for which you do not 
have read permission. Many applications (such as those supplied by 
third-party developers) represent their products with their own 
custom-designed icons, which appear in place of this icon. 

HyperCard application icon: This icon is an example of a Macintosh 
application (the HyperCard application). Under A/UX, you can run 
Macintosh applications, such as HyperCard, by double-clicking the 
icon just as you do under the Macintosh OS. 

File system icons 

This section describes icons that represent the UNIX and Macintosh file systems. 

I. UNIX file system (or I folder) icon: This icon represents the root 

1. 

/ level of the UNIX file system. For a discussion of the traditional 
representation of the UNIX file system as an inverted tree, see "UNIX 
Pathnames," later in this chapter. 

MacP artition 

Macintosh file system: This icon represents a partition or a hard disk 
that contains a Macintosh file system. 

text backup 

Macintosh floppy disk: This icon represents a floppy disk with a 
Macintosh file system. A floppy disk that is formatted with a UNIX file 
system does not display an icon. You can access it only through UNIX 
commands in CommandShell. See "Inserting and Formatting Floppy 
Disks," later in this chapter. 

Using files and folders in the Finder 

Although the A/UX Finder allows you to use files and folders as you use them in the 
Macintosh OS, A/UX does impose some of its own rules and limitations. 
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Permissions limitations 

Under A/UX, every file and folder has specific permissions that determine which users 
are allowed to open a file or a folder, change a file's or a folder's contents, or run a 
program. If you attempt to open a file or a folder or to change its contents when you lack 
the necessary permission, an error message is displayed and you cannot proceed. An 
example is shown in Figure 2-2. 

For details on UNIX permissions, see Chapter 5, "Permissions." 

The folder "sample_dir" could not be 
opened, because you do not haue enough 
access priuileges. 

Figure 2-2 The warning that you do not have the appropriate UNIX 
permissions to open a folder 

Naming or renaming files and folders 

When you name or rename files and folders, observe the following restrictions: 

1. Names can have no more than 31 characters. 

2. Use only letters, numbers, or the underline character. 

3. Do not use slash characters(;), spaces, or colons (:).Although slashes and spaces 
work in the Macintosh environment, UNIX interprets a slash to mean that the 
characters after the slash represent the next item in a pathname (for details, see 
"UNIX Pathnames," later in this chapter). UNIX interprets a space to mark the end of a 
filename or directory name. Use an underscore ( _) instead of a slash or a space. 

For example, avoid the following constructions: 

A/UX file 1 

The preferred form is as follows: 

A_UX_file_l 
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Working with Macintosh files 
You can easily move your Macintosh applications and files to your UNIX file system, and 
you can work with them just as you do when working in the Macintosh OS. The 
advantage of moving them into the UNIX file system is that you can then use UNIX 
backup facilities, search facilities, UNIX file permissions, and other utilities with your 
Macintosh files. 

If there are applications or other items that you must use with the Macintosh OS, you 
might want to add another hard disk that contains a Macintosh file system because the 
MacPartition is small. 

If you attach a second hard disk with the Macintosh file system to your computer, 
after you log in to your account (as described in "Logging In" in Chapter 1, "Starting and 
Finishing a Work Session") an icon representing that disk appears on your screen if the 
additional disk is running. You can double-click this icon to open it and to use its files 
and folders as you normally do in the Macintosh OS. 

Getting to the Macintosh Operating System 
Sometimes you might want to use the Macintosh OS exclusively. If the power has been 
turned off, follow the directions in the next section, "If the Power is Off." The instructions 
in this section assume that Secure Startup is not turned on. If it has been turned on and if 
you are not logged in to the root account, the MacPartition icon does not appear and you 
cannot use the Macintosh OS. See "Secure Startup" in Chapter 1, "Starting and Finishing a 
Work Session." 

If A/UX is running, proceed to the section called, "If A/UX is Running." 

If the computer is off 

If the computer has been turned off, and if A/UX is set for automatic startup, you need to 
cancel the automatic startup procedure. Follow these directions: 
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1 Press the POWER ON key to tum on the computer. 

First the copyright screen appears. 

2 With the copyright screen displayed, hold down the COMMAND key while 
pressing the period key. 

If the copyright screen disappears before you have done this, a startup screen appears. 

3 If the copyright screen vanishes before you perform step 2, click Cancel in the 
Startup screen during the first five seconds of the startup procedure. 

If Secure Start is not running, you see the A/UX Startup window with the A/UX 

Startup# prompt. 

4 Choose Quit from the File menu. 

The Macintosh OS Finder appears. Icons for the Macintosh HFS hard disks connected to 
your system appear on the right side of the screen. Note that the icon for the UNIX file 
hierarchy does not appear. The Macintosh OS does not recognize the UNIX file system. 

If A/UX is running 

If the computer is on and running A/UX, follow these directions: 

1 Choose Restart from the Special menu, with either the Finder or the Login 
dialog box displayed. 

The Restart dialog box appears. 

2 Enter the root password in the appropriate text box. 

If you are already logged in as root, you are not asked for the root password here. 

3 If others are using the system, type a warning message in the next text box. 

Your message should warn other users that the system is about to be shut down and that 
they should save their work and log out. The message is broadcast to other users. 

If you are the sole user of this system, you are not asked for this information. 
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4 Type a number specifying the number of minutes users have until the system 
actually shuts down. 

Give other users a reasonable amount of time to save their work and to log out. 

If you are the sole user of this system, you are not asked for this information. 

5 Click Restart. 

6 With the copyright screen displayed, hold down the COMMAND key while 
pressing the period key. 

If the copyright screen disappears before you to do this, a startup screen appears. 

7 If the copyright screen disappears before you perform Step 6, click Cancel in 
the Startup screen during the first five seconds of the startup procedure. 

8 Choose Quit from the File menu. 

The Macintosh OS Finder appears. Icons for the Macintosh OS hard disks connected to 
your system appear on the right side of the screen. Note that the A/UX I disk does not 
appear. The Macintosh OS does not recognize the A/UX file system. 

To begin using a file on your Macintosh HFS hard disk, open it by double-clicking its 
icon. Refer to the Hard Disk SC Owner's Guide or to the owner's guide that came with 
your hard disk or your computer for information about setting up and using files and 
folders on this disk. 

Backing up and restoring files 

This section shows you how to make backup copies of your critical files on floppy disks 
and to restore them from floppy disks. 

It is important that you make backup copies of individual files as you create and 
revise them, and that your system administrator back up the entire system periodically. 
This prevents you from losing data or programs should your disk or your system fail. 
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For information on backing up your entire system, see A/UX Local System 
Administration. 

Inserting and formatting floppy disks 

Before you can use a brand new floppy disk, you must format the disk. This means that 
the computer writes information on to the disk, information that enables it to accept 
either the Macintosh or the UNIX file system. 

When you insert floppy disks, the system can respond in a variety of ways, 
depending on how the floppy disk was formatted and whether you are currently working 
in the Finder or in CommandShell. 

If you want to back up a folder or a file by dragging an icon to the floppy disk icon, 
you need to be in the Finder and to insert a formatted floppy disk. For further 
information on this method of backing up files, see "Dragging to Copy a File to a Floppy 
Disk,'' later in this chapter. 

For more information on CommandShell, see Chapter 3, "Using CommandShell." 

If you are in the Finder 

If the floppy disk that you insert is formatted for the Macintosh file system, its icon, 
shown in Figure 2-3, appears near the right edge of the screen. 

text backup 

Figure 2-3 A Macintosh floppy disk icon 

If the floppy disk has not been formatted for the Macintosh file system, you see a 
series of dialog boxes warning you that this is the case. These dialog boxes (illustrated in 
Figure 2-4) guide you through the formatting process, as follows: 
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~ This disk is unreadable: 

lD.J Do you want to initialize it? 

( Eject ) (One-Sided) (Two-Sided) 

I.\ This process will erase all 
ill information on this disk. 

( Cancel ) n Erase )J 

Figure 2-4 Disk-formatting dialog boxes 

1 In the first dialog box, click Two-Sided. 

2 When the second dialog box appears, click Erase. 

You can click Cancel if the disk contains data that you don't want to erase. 

If you are in CommandShell 

If the floppy disk that you insert contains UNIX data (for example, a UNIX file system) 
nothing happens; no icon appears and no dialog box appears. Therefore, you can work 
with it only by using UNIX command-line commands. You can use it for backing up files 
with UNIX backup utilities, such as tar or cpio (which are described in A/UX Local 

System Administration). 
If the floppy disk has never been formatted, you see the top dialog box in Figure 2-4. 

If it is a Macintosh disk, a dialog box (shown in Figure 2-5) asks you to specify whether 
you want to use it for the Macintosh file system or for a UNIX file system. A third choice is 
to eject the disk (and therefore to cancel the procedure). 

• If you click UNIX Data, after the initialization is complete, the disk behaves like the 
UNIX disk described above (that is, no icon appears). 

• If you click the Macintosh button, the ensuing dialog boxes guide you through the 
initialization process for a Macintosh file system disk, as shown in Figure 2-4. You 
must use the Macintosh disk with the Finder. 
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This is a Macintosh disk. 
What do you want to use it as? 

(UNIH Data) 

Eject ([Macintosh) 

Figure 2-5 Initializing for a Macintosh or a UNIX data dish. 

Dragging to copy a file to a floppy disk 

A/UX provides an easy way to copy files and folders. Follow these steps: 

1 Be sure that you are in the Finder. 

2 Insert a floppy disk (initialized for the Macintosh file system) into the 
disk drive. 

You see an icon representing the disk. 

3 Drag the icon of the file or folder that you want to copy to the floppy disk icon. 

A dialog box appears describing the progress of the copy operation. 

You can shift-dick to select multiple files or folders to back up. 

Dragging to restore a file 

A/UX provides an easy way to restore files or folders that were backed up by dragging 
their icons to a disk. Follow these steps: 

1 Insert in the drive the floppy disk containing the file you want to restore. 

You see an icon representing the disk. 

2 Double-click the disk icon to display a window that shows the contents 
of the disk. 
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3 Drag the icon of the file or folder that you want to restore to the folder on the 
hard disk where you want it to reside. 

A dialog box appears describing progress of the copy operation. 

You can shift-dick to select multiple files or folders to restore. 

UNIX pathnames 
This section describes the way the UNIX operating system specifies the location of files 
and directories in the UNIX file hierarchy. The tutorial exercises in Chapter 4, "Using 
UNIX Commands and Commando," make use of the information in this section. 

A/UX differs from traditional forms of UNIX in that the Finder allows you to 
manipulate files and folders by manipulating their icons. However, if you need to work 
with the command-line interface available in CommandShell, you will find it necessary to 
understand UNIX pathnames. 

The folders of the Macintosh environment correspond to the directories of the UNIX 
world. Since this section describes the traditional UNIX way of using pathnames in the 
A/UX CommandShell window, the word directory is used here. 

The UNIX file system is organized in a hierarchy traditionally represented as an 
inverted tree. Figure 2-6 shows an example of this organization. Organized from top to 
bottom, the file system begins at the top with the I directory, which is called the root of 
the file system and is always represented by the slash character(;). Branching downward 
from the root of the file system are the rest of the directories and files in the system. The 
/ directory contains a number of directories that store the operating-system files and 
programs. There is only one UNIX file hierarchy for a given system. All additional 
directories, file systems, and files fall within this hierarchy (shown in 
Figure 2-6). 

Because of its hierarchical organization, A/UX uses pathnames to refer to files and 
directories. A pathname is a name that describes where the file or directory is located in 
the hierarchy. Here is an example: 

/users/start/letterl 

Figure 2-7 shows the path that leads from the root to the file let terl and that gives 
rise to the pathname /users/start/letterl. 
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memol letterl •cshrc •clipboard •login 

Figure 2-6 Part of the A/UX file-system structure 

Here, the file named letterl is located within the start directory, which is 
located within (or below, in UNIX terminology) the users directory, which, in tum, is 
located below the I directory (indicated by the I character). 
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memol letterl 

= Currently active path 

D = Position on the path 

•cshrc •clipboard 

Figure 2-7 The pathname /users/start/letterl 
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An absolute pathname of a file shows the complete path from the root to the file in 
question, by listing all directories that lead from the I directory and concluding with the 
filename itself. The first item in an absolute pathname is always the character / , which 
indicates the root. Thereafter, the slash character is used to separate the names of the 
directories. 

We know, for example, that /users I start /letterl is an absolute pathname 
because it begins with the slash character, and is thus tracing the path from its origin at 
the root. The subsequent slash characters separate the names of the users and the 
start directories, and the names of the start directory and file let terl. 

A relative pathname lists the directories leading to the file, beginning with the 
current directory. 

The directory in which you are currently working is called the current directory. 
When you change directories, the directory you move to becomes your new current 
directory. For example, if the current directory is /users, then start/ let terl is a 
relative pathname of /users I start/ let terl. Note that a relative pathname never 
begins with the I character, because it doesn't start at the root. This can be compared 
with leaving out the area code in a telephone number if you are calling the number from 
within that same area code. 

Figure 2-8 diagrams the relative pathame start/let terl. 

The name of the file or of the directory whose path is being described is the last 
component of a pathname. 

When typing UNIX commands in the CommandShell command-line interface, if you 
want to specify a file that is in your current directory, just type the filename. You needn't 
specify its directory, because you're already working in that directory. For information on 
CommandShell, see Chapter 3, "Using CommandShell." For information on UNIX 
commands, see Chapter 4, "Using UNIX Commands and Commando." 

Two dots ( .. ) are an abbreviation for the directory that contains the current 
directory. For example, if you are in /users I start, you can specify the /users 

directory with two dots ( . . ) as a shortcut. 
Once you understand how UNIX pathnames work, you can easily learn to find your 

way around a UNIX hierarchy while working with the command-line interface. For 
further details, see the section called "Using UNIX Commands to Navigate the File 
System" in Chapter 4, "Using UNIX Commands and Commando." 
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memol letterl 

= Currently active path 

D = Position on the path 

•cshrc 

Figure 2-8 The relative pathname start /let terl 
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6 Important If you are working in the Finder and you open a new CommandShell 
window, the current directory of the CommandShell window is your home directory. If 
you bring to the foreground of the screen a CommandShell window that has been used, 
the window is still in the directory it was in when it was last used. The folder that you 
have been using in the Finder does not determine the directory in which your 
CommandShell windows are working. /'\ 
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3 Using CommandShell 

This chapter describes how to use CommandShell, an application that provides access to 

the traditional UNIX command-line interface. This chapter contains the following 

information: 

• What is CommandShell? 

• Making CommandShell active 

• Using CommandShell windows 

• Using the A/UX System Console 

• Customizing CommandShell windows 

• Using terminal emulation 

• Using Macintosh editing tools in CommandShell windows 

• Leaving CommandShell 

Start by reading the first two sections of this chapter, ("What is CommandShell?" and 

"Making CommandShell Active"). You can then consult any of the remaining sections 

that describe the tasks you want to perform. 



What is CommandShell? 
CommandShell allows you to display one or more windows in which you can 
communicate with A/UX by entering commands on a command line, as is traditionally 
done on most UNIX systems. When you do this, you can communicate with A/UX 
through any one of three standard shells: 

• C shell 

• Bourne shell 

• Komshell 

Like the Finder, a shell is a utility that establishes an interface between you and the 
operating system. It accepts the commands that you enter and passes them on to the 
operating system, which executes them. It also displays the operating system's 
responses. There are several standard shells, each of which interprets your commands 
and the operating system's responses somewhat differently than the others. Since the C 
shell is one of the most commonly used UNIX shells, it is the default shell when you log 
in to your user account (unless your system administrator has changed the default shell). 

For information on changing shells, see "Changing Shells" in Chapter 8, "Customizing 
Your Work Environment." 

Making CommandShell active 
Before you read this section, you should start A/UX and log in to your user account. 
When you log in, the A/UX Finder is active and its menu bar appears at the top of 
the screen. 

To make CommandShell active: 

• Choose CommandShell from the Applications menu, which is at the right side 
of the menu bar. 

The Applications menu is shown. 
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A window labeled CommandShell 1 appears and becomes the active window. 

CommandShell 1 
pacer.start 1 I I 

When the CommandShell window becomes active, the CommandShell menu bar 
appears. It contains commands that allow you to manipulate the CommandShell 
windows and their contents. 

Switching between CommandShell and the Finder 

You can return to the Finder by clicking on any portion of a Finder window with your 
mouse pointer or by choosing Finder in the Applications menu. You can then reactivate 
CommandShell by clicking on any portion of a CommandShell window or by choosing 
CommandShell in the Applications menu. 
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""- Important If you open a new CommandShell window, the current directory of the 
CommandShell window is your home directory. If you bring to the foreground of the 
screen a previously used CommandShell window, that window is still in the directory it 
was in when it was last used. The folder that you are using in the Finder does not 
determine the directory in which your CommandShell windows are working. 6 

Using CommandShell windows 
The following sections explain how to work with CommandShell using the menu 
commands. You can read through these sections sequentially or you can find the task 
you want to complete and go directly to the section that applies to it. 

Displaying CommandShell windows 

When you make CommandShell active, a CommandShell window appears. You can 
display additional windows in two ways: 

• Choose New from the File menu. 

• Press CoMMAND-N. 

Either of these actions makes a new window appear in front of the existing window or 
windows. The CommandShell windows are numbered in the order in which they are 
created (CommandShell 1, CommandShell 2, and so on). 

+ Note You can open up to 15 windows. It is best to use a large-screen monitor when 
you work with many windows at the same time. • 
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Arranging CommandShell windows 

You can arrange CommandShell windows on the screen in three ways. 

• Standard positions: When you create a new window, it appears in front (and 
slightly below and to the right) of the previously created window, partially obscuring 
the windows behind it (Figure 3-1). 

• Tiled positions: You can tile the windows to arrange them alongside each other 
with their edges touching, like tiles on a floor. For information on different tiling 
patterns, see "The CommandShell Environment" in Chapter 9, "A/UX Reference." 
Tiling windows reduces the size of the windows so that they fit on the screen. 

• Manual positions (resizing and dragging): You can arrange CommandShell 
windows on your desktop manually by using their resize boxes to resize the 
windows and by clicking their title bars to drag them to new locations on the 
desktop. 

_I: ''ih .. ..l.Ll.. J_ 

p Comm11ndShell 2 l 
p~ Comm11ndShell 3 J_ 
pd~D Comm11ndShell 4 t!J-

pacer. start 1 ll! I ~ 

........, izy ....... 
~ 

Figure 3-1 Windows in standard position 
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.&. Warning Unlike a standard Macintosh window, if a CommandShell window is so 
reduced in size (because of tiling or resizing) that its contents cannot be seen, 
CommandShell erases the obscured screen output. You cannot retrieve it by enlarging 
thewindow . .A 

For further information on tiling, sizing, moving, and hiding CommandShell 
windows, see "The CommandShell Window Menu" in Chapter 9, "A/UX Reference." 

Recording the contents of a window 

As you add new lines to a CommandShell window, the top lines can scroll past the top 
edge of the window, as shown in Figure 3-2. CommandShell automatically records a 
preset number of these lines. This allows you to review them by scrolling upward. 

By default, CommandShell records 1000 lines. For information on how to change this 
default, see "Customizing CommandShell Windows," later in this chapter. 

Figure 3-2 Recording window contents as they scroll off the top 

Figure 3-3 shows how the window looks after you use the scroll bar to redisplay the 
recorded lines. The dotted line across the window marks the top of the most recent 
screen. It separates the active area (the material below the dotted line) from the recorded 
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area (the material above the dotted line). You can change the material in the active area 
(that is, the area that contains material that has not yet scrolled off the top of the 
window) but not the material in the recorded area. 

CommandShell 1 
./ .kshrc .profile -0 

=d!~'~ ;~::~::, '' '" ;~~~~• ~E,'o'"~ oH- ~ 
tot" I 4220 i!i!i! 
I rwxrwxrwx 1 st"rt project 42 Nov 11 15: 24 Desk top Fo Ider -> /users/s iiiiii := ................................................................................................................................................................................................................................................ I""' 
t"rt/. m"c/ I oc" I host/Desk top Fo Ider b;r, 
-r--r--r-- 1 root root 487 155 Oct 28 13 : 04 FI LES !iii!! 
drwxr-xr-x 2 bin bin 2560 Oct 28 19: 35 bin !iii!! 
drwxr-xr-x 12 b i n sys 2048 Nov 11 15 : 24 dev ;!!!;! 

Active area ~~~~~~~~~~ 1 ~ mt mt :~~~ ~~~ ~~ lm~ mt+ found i1i1il 

drwxrwxrwx 2 root root 5 12 Oct 24 22 : 0 1 mn t !H!!! 
-rw-r--r-- 11 rro

0
o
0

tt root 815257 Oct 25 04: 19 newunix ~ 
-rw-r--r-- root 5 Oct 25 04: 19 nextunix .-r;o 

drwxr-xr-x 2 root root 512 Oct 28 19:21 root ~ 
drwxr-xr-x 2 root root 512 Oct 28 19:23 shlib l2J 

Figure 3-3 Viewing recorded window contents 

+ Note CommandShell does not save the recorded lines for use after you close the 
window. If you have accumulated data that you want to save, select it and copy it to a 
file in a text editing or word processing program. See "Saving a Selection in a New File," 
later in this chapter. + 

Canceling the recording of window contents 
You can stop CommandShell from recording the top lines of the active window as 
follows: 

• Choose Don't Record Lines Off Top from the Commands menu. 

This command causes CommandShell to stop recording lines as they scroll past the top 
of the active window. Any lines already recorded are saved and are still available for 
review. The command name in the Commands window changes to Record Lines Off 
Top. Choose this to begin recording the lines again in the same window. 
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Erasing recorded window contents 

To erase recorded lines, do the following: 

• Choose Clear lines Off Top from the Commands menu. 

The recorded lines are erased and are no longer available for review. The scroll bar 
becomes white. This command operates only on the active window. 

Closing CommandShell windows 

Before you can close a window, it must be the active window. The active window has 
horizontal stripes running across its title bar. To make a window active, point to it with 
the mouse cursor and press the mouse button. 

Closing a window 

There are three ways to close an active window: 

• Choose Close from the File menu. 

• Press CoMMAND-W. 

• Click the close box of the window. 

In each case, the CommandShell window disappears from the screen. 

+ Note CommandShell does not save any lines after you close the window. If you 
don't want to lose your work, save the contents to a file. To save the text of A/UX 
command lines to a file, see "Saving a Selection in a New File," later in this chapter. • 

If you close a window in which a process or program is running, the process or 
program halts. An alert box warns you of this and gives you the option to keep the 
window open. 
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Closing all open windows 
You can close all the open windows at once, as follows: 

• Choose Close All Windows from the File menu. 

The CommandShell windows disappear from the screen. 

If one or more of the windows contains a process or a program that is running, the 
process is halted. An alert box warns you of this. 

Close "CommandShell I" 
euen though there are jobs 
running? 

([ OK B Cancel 

Using the A/UX System Console 

When you are working in A/UX, the system might generate messages regarding its 
status. In a traditional UNIX environment, these messages appear on a console terminal. 
Typically, the system administrator monitors these messages, which alert the 
administrator to take action to avert or remedy a problem. In A/UX, the system messages 
appear in the A/UX System Console, a CommandShell window that you display by 
choosing its name from the Window menu. 

Using the A/UX System Console 3-9 



Displaying at the A/UX System Console window 

To view the contents of the A/UX System Console window, follow these steps: 

1 Choose CommandShell from the Applications menu. 

This action displays an active CommandShell window and makes the CommandShell 
menu commands available. 

2 Choose A/UX System Console from the Windows menu, or press CoMMAND-0 
(that is, the number "zero"). 

This action displays the A/UX System Console window. For more information on the 
messages that you might see in the window or for information on how to respond to a 
request for information, see A!UX Local System Administration. 

Clearing the A/UX System Console window 

To clear the messages from the A/UX System Console window, follow this step: 

• Choose Clear Lines Off Top from the Commands menu. 

This action clears all the information from the window. You should clear this window 
periodically so that you can tell when new messages appear. 

Closing the A/UX System Console window 

Close the A/UX System Console window just as you close any CommandShell window 
(see "Closing CommandShell Windows" earlier in this chapter). Note that unlike other 
CommandShell windows, when you close the A/UX System Console window, nothing in 
the window is lost. Closing the System Console window is equivalent to "hiding" it. 
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How A/UX warns you of an alert 

If A/UX needs to bring an alert to your attention (for example, if the system administrator 
is preparing to shut down the system), an icon flashes in the menu bar and an alert box 
appears. If CommandShell is not the active application, a diamond-shaped symbol also 
appears alongside CommandShell in the Applications menu. Choose this to activate 
CommandShell; then choose A/UX System Console from the Windows menu to display 
the alert message. 

You can change this default to suppress the alert box, the flashing menu-bar icon, 
or both. 

To change this default, do the following: 

1 Choose Notification Levels in the Preferences menu. 

The Notification Levels dialog box appears. 

Set the notification leuel to be used when 
CommandShell is not the front application. 

When a console message is receiued: 

+ O Only display • in s menu 

g • O Also flash icon in menu bar 

lbJ &::!! • ® Also display alert 

!bl 0 Only display alert 

When 11 process needs input from the console: 

• 0 Only display + in s menu 

g • O Also flash icon in menu bar 

lbJ &::!! • ® Also display alert 

( Cancel ) K OK ) 

2 After you click the appropriate buttons, click OK. 
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Customizing CommandShell windows 

If you use CommandShell windows often, you might find it convenient to establish an 
ideal arrangement of windows, so that as soon as you log in to A/UX, the windows 
appear exactly the way you want. 

Presetting window defaults 

The Active Window Settings command in the Preferences menu allows you to do the 
following steps: 

• save an initial command to execute upon activating CommandShell 

• change the title of the window 

• change the number of lines to record 

You can preset window defaults as follows: 

• Choose Active Window Settings in the Preferences menu. 

The Active Windows Settings dialog box appears. 

Rctiue Window Settings 

Window title: 

Window position: 

Top: 1124 I 
Left: 1225 I 

181 Record lines off top 

Window size: 

Rows:§] 

Columns:~ 

Maaimum number of lines: I • 000 I 
Initial command: 

( Terminal Settings ... J (cancel) ~ 

The name of the active window is highlighted in the top line. 
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You can change any or all of the settings in this dialog box. After you click OK, the 
new settings affect the active window. If you saved the new settings by choosing Save 
Preferences in the Preferences menu, the new settings become the new defaults for 
displayed windows. See "Saving the Layout of Your CommandShell Windows," later in 
this chapter. 

Notice that the check box "Record lines off top" is selected by default. If you click it, 
the X mark disappears and recording of lines is turned off. You also can change the 
maximum number of lines recorded, but only if "Record lines off top" is selected. 

In the "Initial command" text box, you can enter a command to run automatically as 
soon as you activate CommandShell. 

Presetting the appearance of new windows 

You can change the default settings that control the appearance of new windows before 
you create them. Follow these steps: 

• Choose New Window Settings from the Preferences menu. 

The New Windows Settings dialog box appears. 

New Window Settings 

Window Title PrefiH: l~i· ~~~giiiiiiiillJ 

Use Hctiue Window Settings 

Window Cascade Origin: 

Top:~ 
Left: Ll 

Font: I UT100 I Size: W 

Window Size: 

Hows:~ 
Columns:~ 

MaHimum number of lines recorded off top: I 1000 

( Terminal Settings ... J (Cancel J (( OK )J 
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You can extend the active window settings to all new windows. To do so, click Use 
Active Window Settings. 

If you want to label new windows with a prefix other than "CommandShell," type the 
prefix in the Window Title Prefix text box. 

You also can preset the window size, the screen font to be used in the window, and 
the maximum number of lines to be saved by typing your choices in the appropriate 
boxes. 

To preset a default position for the upper-left corner of the first window of a group of 
stacked windows, enter the coordinates (in pixels) in the Window Cascade Origin text 
box. 

Saving the layout of your CommandShell windows 

The Save Preferences command (in the Preferences menu) allows you to save the 
following specifications: 

• notification level preferences (see "How A/UX Warns You of an Alert," earlier in this 
chapter) 

• the positions and sizes (in rows and columns) of all CommandShell windows 

• the stacking order of the windows 

• the titles of the windows 

• the fonts and point sizes of text in the windows 

• whether a given window is visible or hidden 

• whether a given window is zoomed (that is, enlarged to full-screen size with the 
Zoom Window command in the CommandShell Window menu) and the sizes (in 
pixels) of its zoomed and unzoomed states 

• whether lines are to be recorded off the top of the screen, and the number of lines to 
be recorded (see "Recording the Contents of a Window" and "Presetting the 
Appearance of New Windows," earlier in this chapter) 

• the initial command to be run in the window (see "Presetting Window Defaults," later 
in this chapter) 

• terminal emulation information 
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To save the settings you choose, follow these steps: 

1 Arrange the windows just as you want them to be. 

Be sure that you have chosen any special formatting features that you want 
(such as fonts). 

2 Choose Save Preferences in the Preferences menu. 

Restoring the window layout to the saved preference 

If you have saved your window preferences but have changed the window layout on 
your screen, you can instantly restore your preferred layout as follows: 

• Choose Restore From Preferences in the Preferences menu. 

When you log out or shut down the system, if you have changed your window 
preferences with the Active Window Settings or the New Window Settings dialog box, 
but have not saved them by choosing Save Preferences in the Preferences menu, you are 
asked whether you want to save the changed preferences. 

Do you want to saue your 
changed preferences? 

([ Yes )J No 

Click Yes or press RETURN to save the changed preferences or click No to abandon them. 
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Using terminal emulation 
The CornmandShell window emulates the Digital Equipment Corporation VT102 
terminal. At present, this is the only termina,l emulation that CornmandShell supports, 
though it ultimately will provide other terminal emulations. Although terminal emulation 
for the VTl 02 terminal is the only one currently shipped with A/UX, you can purchase 
others from other sources. For example, there is an Apple Computer product called 
MacTerminal, which contains a VT320 emulation tool that you can install. However, 
since A/UX is shipped only with the VTl 02 tool, that is the only one discussed in this 
manual. 

In addition to the features discussed earlier in "Customizing CommandShell 
Windows," you can customize the VT102 features just as you would on a VT102 terminal, 
as follows: 

1 Choose Active Window Settings in the Preferences menu. 

2 Click the Terminal Settings button. 

The Terminal Settings dialog box appears. 

Terminal Settings t OK JI 
Emulation: CommandShe ... ~ I ( Cancel ] 

• -fiiPil 
~ 
Soreein 

Koy board 

~ Torminal Modo: I ANSI/I/Tl 02 "' I I Toxt Cursor 

ii ..... ~·==i··········~ .. ~~··~;~;···········"1 ·'.'.:I( ~~~:::lino 
111111 ................ ~.:::::!. ............... ~ .. ~:.~~.~ .. ~~.~: ....... I ..................................................... . 

I 
-0 

D Show Status Bar 

D Show Tab Rulor 

Answerbaok Message l J 
'----------' 

To the right of the word Emulation there appears a pop-up menu that will eventually 
allow you to choose between several terminal emulations. At present, only the VT102 is 
available. 
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Along the left margin of the dialog box there are four setup icons, which allow you to 
select General, Screen, Keyboard, and Character Set. 

Since most A/UX users do not have need to change the default terminal emulation 
capabilities, these capabilities are described in "Terminal Emulation" in Chapter 9, "A/UX 
Reference." 

For more information on the VT102 terminal emulator, see "VT102 Terminal 
Emulation Tool" in Apple MacTerminal, a manual that describes other terminal 
emulation tools available for the Macintosh. 

Using Macintosh editing tools in 
CommandShell windows 

You can use some of the standard Macintosh editing procedures while working in 
CommandShell windows. This allows you to paste a series of commands or a long, 
complex command into another window without having to retype it. 

The sections that follow describe how to copy or paste the contents of a window 
using the mouse and the menu commands. This material applies to command lines, 
system messages, and the output of commands. If you are using a text-editing 
application, use the editing tools provided by the application. 

Selecting text 

You must select text before you perform the editing procedures. Select text as follows: 

• Drag across text to select a single letter, word, or section of text. 

Text is highlighted when it is selected. 
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Copying text 

To copy text, follow these steps: 

1 Select the text you want to copy. 

2 Choose Copy from the Edit menu or press CoMMAND-C. 

The highlighted text is copied to the Clipboard. You can paste the Clipboard contents as 
many times as you want. For more information about the Clipboard and its contents, see 
Learning Macintosh or the Macintosh Reference. 

Pasting text 

Once you have copied text to the Clipboard, you can paste the text in a 
CommandShell window as follows: 

• Choose Paste from the Edit menu or press CoMMAND-V. 

The text is pasted at the command prompt. You can paste the Clipboard contents as 
many times as you want, until you replace them by copying or cutting something else. 
For more information about the Clipboard and its contents, see the owner's guide that 
came with your computer. For more information about the Clipboard and its contents, 
see Learning Macintosh or the Macintosh Reference. 

Changing the font or font size 

You can change the appearance of all the text in a CommandShell window by changing 
the font or font size. The choices available in the Fonts menu are the monospaced fonts 
in the System file. At the bottom of the list of available font sizes in the Font menu, the 
last item, Other, allows you to select any font size that does not appear in the list. 

+ Note If the active window uses a terminal emulation tool that does not support font 
changes, the Fonts menu is disabled. • 
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You can change the font or font size as follows: 

• Choose the font or font size you want from the Fonts menu. 

All text in the window changes to the new font or font size. 

• If you choose Other, the Font Size dialog box appears. Type the font size in 
points and click OK. 

Font size: 1~1-~ 

( Cancel ) ( OK 

The screen fonts change to the size you type. 

Saving a selection in a new file 

You can save the contents of a CommandShell window in a text file. When text is present 
in a CommandShell window, follow these steps: 

1 Select the text you want to copy into a new file. 

The text appears highlighted. 

2 Choose Save Selection from the File menu. 

The Save Selection dialog box appears. See the Macintosh Reference if you need 
assistance in saving the file to a different drive. 

la start..,. I 
D !P\h~r! 
D m~~mo! 
D Pic1\H'(1 1 
D irn1up 
O System Folder olios 
D •mm .... prnf<\, 

Desktop 

New tJ ) 

Sa1Je current selection as: ( Cancel ) 

€ }!WP J) 
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3 Type a name for the new file. 

4 Click Save. 

Printing the contents of a CommandShell window 

You can print all or part of the contents of a CommandShell window as follows: 

1 Select the portion of the window that you want to print. 

You can select the entire contents of the window by choosing Select All in the 
Edit menu. 

2 Choose Print Selection in the File menu. 

The Print dialog box appears. 

Job 
LaserWriter "Uan Horn" 1.0 ( Print J 
Copies:liMI Pages: ® Hll 0 From:~ To: ~ ( Cancel J 
Couer Page: ® No O First Page O Last Page 

Paper Source:® Paper Cassette O Manual Feed 

Print: ®Black & White O Color/Grayscale 

Destination: ®Printer O Postscript® File 

3 Click Print. 

For assistance in setting up your printer, see Setting Up Accounts and Peripherals 
forA/UX. 
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Leaving CommandShell 

Make sure that you have saved any work that you complete in CommandShell windows 
before you return to the A/UX Finder. There are several ways to leave CommandShell: 

• Choose Hide CommandShell from the Applications menu. 

This action closes all the windows and sets CommandShell aside until you reactivate it. 
This method reduces screen clutter while you work with other applications. 

• Choose another application from the Applications menu. 

This action moves the CommandShell window to the background of the screen. The 
application you have chosen becomes active. 

• Choose Quit in the File menu. 

This turns off CommandShell. The only reason for turning off CommandShell is to load 
new fonts, which you cannot do unless all applications are turned off. By default, there is 
a file in the Apple Menu Items folder (located in the System Folder). This allows you to 
tum CommandShell on again by selecting CommandShell in the Apple menu. 

If the CommandShell file has been removed from the Apple Menu Items folder in the 
System Folder, you can restart CommandShell by double-clicking the CommandShell 
icon in the /mac/bin folder. Do this as follows: 

1 Double-click the ; folder to open it. 

2 Double-click the mac folder to open it. 

3 Double-click the CommandShell icon. 

CommandShell begins to run. 
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4 Using UNIX Commands and 
Commando 

This chapter teaches you how to use UNIX commands on the command line and how to 

use Commando dialog boxes to perform a variety of useful UNIX operations. It also 

shows you how to consult information in the A!UX Command Reference on screen. The 

following information is presented in this chapter: 

• About UNIX Commands 

• What is a command? 

• Using UNIX commands to navigate the file system 

• Getting your bearings 

• Options and arguments 

• The Commando dialog box 

• Using Commando 

• Further useful UNIX operations 

If you are unfamiliar with UNIX commands, read the opening sections of this chapter in 

sequence, through "Options and Arguments." If you feel comfortable with the command­

line interface, go directly to "Using Commando." 



About UNIX commands 

Chapter 3, "Using CommandShell," tells you how to use CommandShell, the UNIX 
command-line interface. When you enter a command on the command line, you are 
instructing A/UX to run a program that performs a specific task or a specific set of tasks. 
Entering the command on the command line is the traditional UNIX way of running 
commands. You also can run these commands with the A/UX application called 
Commando, which displays a dialog box that offers you an easy way to use a UNIX 
command and to choose among the various options that the command offers. 

6 Important AB you go through the tutorials that use UNIX commands, be sure that you 
enter them exactly as specified in the exercises. Don't add or remove spaces, don't 
change a character from uppercase to lowercase, or vice versa, and be sure to use minus 
signs where appropriate. /\ 

What is a command? 

A command consists of a special kind of file called a program, which is an executable 
file, that is, a file that contains a set of instructions that makes the computer perform a 
specific task. A/UX contains over 500 such commands. 

For example, there is a command called pwd, which stands for print working 
directory. This command makes the computer display the pathname of the directory in 
which your CommandShell window is currently working (your current directory). 

To perform the following exercises, be sure that you are logged in to the start 
account. If you do not have a CommandShell window displayed, choose CommandShell 
in the Applications menu. If a CommandShell window does not appear when you 
choose CommandShell in the Applications menu, immediately choose New in the File 
menu, and a new CommandShell window appears. 
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• Enter the following command by typing the command and pressing R1mmN: 

pwd 

The pathname of your current directory (/users I start) appears in response to the 
pwd command. 

D 
pacer.start 1 • pwd 
/users/start 
pacer.start 2 • I 

CommandShell 2 

The pwd command caused the program (the executable file) called pwd to run, 
that is, to execute its instructions. The results of the command are commonly called the 
output. In the case of the pwd command (as is true of many commands), the output is 
displayed on the screen. In traditional UNIX parlance, one says that the output is 
directed to the screen. This is called the standard output. 

Later in this chapter you will see that you can instruct a command to send its output 
somewhere other than to the screen. For example, the information can be sent to a file to 
be saved or to a printer to be printed. This rechanneling of data is called redirection. 
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Using UNIX commands to navigate 
the file system 

Chapter 2, "Using Files, Folders, and Directories," tells you how CommandShell refers to 
files and directories by their pathnames (see "UNIX Pathnames"). You can use 
pathnames to determine where you are in the A/UX file system and to move from 
directory to directory in CommandShell. 

Note that although you can work within the files in MacPartition while using the 
Finder (if Secure Startup is not on; see "The Secure Startup Feature" in Chapter 1, 
"Starting and Finishing a Work Session"), you cannot use CommandShell to work with 
the contents of MacPartition or any other Macintosh file system. 

6 Important If you are working in the Finder and you open a new CommandShell 
window, the current directory of the CommandShell window is your home directory. If 
you bring to the foreground of the screen a CommandShell window that has been used, 
the window is still in the directory it was in when it was last used. The folder that you 
have been using in the Finder does not determine the directory in which your 
CommandShell windows are working. 

Getting your bearings 

This section describes how to determine what account you're using, what directory 
you're using, and how to move to another directory. 

Finding your user account name 

If you forget your login name, use the whoami command to find out what it is. 

Follow these instructions: 
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1 Choose CommandShell in the Applications menu. 

A window appears on the screen. CommandShell is described in Chapter 3, "Using 
CommandShell." 

2 Enter the whoami command. 

Remember that you enter a command by typing the command and pressing the RETIJRN 
key. In a few seconds you see a response that identifies the account name. 

Where are you? 

If you are working in CommandShell and you don't know what directory you are in, use 
the pwd command as follows: 

• Type pwd and press Return. 

The name of the current directory (the directory in which you are currently working) is 
displayed. 

For information on moving from directory to directory, see the next section: 
"Changing to a New Directory; Returning to Your Home Directory." 

Changing to a new directory; returning to your 
home directory 

Suppose you use the pwd command and find that you are working in the root directory 
(indicated by a ;) when you really want to be working in the /users/ start 

directory. To change from directory to directory, use the cd (change directory) 
command. Change to /users/start as follows: 

• Onthecommandline,enter cd /users/start 

D. Important Don't neglect to enter the space after ed. The space marks the end of the 
command and the start of the command argument (described in the next section). 
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If you enter pwd now, the response reads as follows: 

/users/start 

When you use the ca command, you can use the absolute pathname or relative 
pathname of the destination directory, whichever is easiest for you. If you aren't sure 
where you are relative to the destination directory, use an absolute pathname. 

You can always return to your home directory by entering the cd command 
without specifying any directory. 

Options and arguments 
Options and arguments modify the way a command runs and specify the files (or other 
objects) upon which the command operates. 

Options 

Most UNIX commands can run in a variety of ways to produce a variety of results. These 
variations in the way a command works are called options. 

Listing the contents of a directory: the is command options 

For example, the ls command causes the computer to list all the files in your current 
directory. However, there are various ways in which you can list the files. If you use the 
1 s command without any of its options, only the names of the files are listed, and they 
are listed in a one-column list. 

Let's say that you are working in the start directory with your CommandShell window 
displayed. To be sure that this is the case, do the following: 

1 Enter the pwd command to see what directory you are in. 

The command line should display the following response: 

/users/start 
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2 If this is not what appears enter the following: 

cd /users/start 

3 Repeat Step 1 to be sure that you are in the I us er s Is tart directory. 

For further information on the pwd and cd commands, see "Changing to a New 
Directory; Returning to Your Home Directory," earlier in this chapter. 

The following steps introduce you to several of the 1 s command options: 

4 Enter ls on the command line of a CommandShell window. 

The resulting display looks something like this: 

D 
pacer.start 1 ~ pwd 
/users/start 
pacer.start 2 ~ Is 
letter1 
rnerno1 
setup 
pacer.start 3 ~ I 

CommandShell 2 

But what if there were too many filenames to fit in one CommandShell window, so that 
the filenames at the top of the list scroll off the top of the window? You might want to 
avoid having to use the scroll bar to scroll back to the top of the list. Instead, you can 
break the list into columns so that more of the filenames can fit on one screen. 

You can do this with the -c option (which stands for columns; note that this is an 
uppercase c). Whenever you type an option in the command line it is preceded by a 
dash (sometimes called a minus); in conversation, the -c option is called minus C. 
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D Important Since UNIX is case sensitive, be sure that you do not use a lowercase c for 
the -c option. Some options call for lowercase characters and some call for uppercase 
characters. , \ 

To list the contents of the I directory in columns, follow these steps: 

1 Enter cd I to move to the / directory. 

2 Enter 1 s -c on the command line in the CommandShell window. 

Be sure th~t you leave a space between the command and the option (that is, between 
the ls and the -c). 

The screen displays the output, which looks like the following. 

pacer.start 4 I Is -C I 
Desktop dev 
Desktop Folder etc 
FILES I ib 
bin lost+found 

3 Enter cd 

mac 
mnt 
newunix 
nextunix 

root 
shl ib 
tmp 
unix 

users 
usr 

If you are logged in as start, the start directory is your home directory, so you need 
only enter cd to return to it. If you have a different login name, enter 
cd/users/start toreturntothe start directory. 

If you want to know how large a file is, who owns it, or other technical information 
about the file, you can use the 1 s command with the -1 option (note that this l is a 
lowercase ell) for a long listing. 

• Enter 1 s -1 on the command line. 

Be sure to type a space between the 1 s command and the -1 (lowercase ell) option. 
The output is shown below. 

pacer.start 6 I Is -I 
total 8 
-rw-r--r-- 1 start 
-rw-r--r-- 1 start 
-rwxr-xr-x 1 start 

project 
project 
project 

1289 Jan 17 1990 letter1 
884 Jan 17 1990 memo1 

94 May 12 1989 setup 
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The first three columns give permissions and ownership information. The next three 
columns tell the size (in bytes), the date on which the file was last changed, and the 
filename. 

Arguments 

Technically speaking, an argument is any item on the command line that modifies the 
way the command works. This guide, however, uses the word argument as it is 
commonly used, to mean the file or other object upon which the command acts. Some 
commands must have an argument, whereas others (such as 1 s) might or might not 
require an argument, and others (such as pwd) rarely or never take an argument. 

Using the 1 s command with an argument 

If you are working in the st art directory and you want to display a list of the 
contents of the I directory, you would use the 1 s command with the name of the 
root directory (designated by the I character) as the argument. 

• Enter 1 s / on the command line. 

Note the space between the command and its argument. 

A listing of the contents of the root directory appears on your screen. 

You also can list a single file by using its name as the argument. For example: 

• Enter ls -1 letterl on the command line. 

A single line appears that gives you the long listing for the file let terl, but for no 
other files in the directory. 
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The Commando dialog box 

Many UNIX commands have a large selection of options and require learning a complex 
syntax for entering these options on the command line. To make it easier for users to 
learn and to remember the various tasks that a given command can perform, and to 
simplify and to automate entering the command on the command line, A/UX contains an 
application called Commando. 

UNIX commands vary in the options they offer; therefore, Commando dialog boxes 
vary considerably from one another. However, most Commando dialog boxes have the 
same basic elements as Macintosh OS dialog boxes: radio buttons, check boxes, text 
boxes, and file buttons. In addition, all Commando dialog boxes have a Help box, 
Output and Error pop-up menus, and standard buttons, such as Cancel. Figure 4-1 shows 
an example of the elements of a Commando dialog box. 

,.-grep Options---------------------, 
r·· Required ....................................................................... , , ... operation ..................................................................... , 
! Search pattern: i ®List matching lines I 
Ill J I 0 List non-matching lines ; 
... ~ ..... -.... -..... -..... -..... -.... -..... -..... -..... -.... ~.~ .. -: .. -: .. -:.~ .. -: .. -: .. -: .. --:.-:...... I 0 List files names only 

Files to search j D Count lines . 
i.. ........................................................................................................ ; 

Output Error D Ignore case 
l..----'-----1~--------.J D Print line number(s) 
._ ____ __.. ______ D Print block number(s) 

D Suppress errors 

r:command Line 
Lreip 

Help---------------~ ( cancel ] 
Search a file for a pattern. 'grep' search p.att:erns are limited regular ;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;t,, 
expressions in the sty lei of ed. It uses a oompaot nondeterministic n ~ 

~•~lgo_r_ith_m_to_s_••_ro_h_th_• f_il•_· ----------~ ~ !.if PP ~ 

Figure 4-1 Elements of a Commando dialog box 

Using Commando 

There are three ways to display a Commando dialog box while using CommandShell: 
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• Type the name of the command and choose Commando in the CommandShell Edit 
menu. For example, type 1 s on the command line, then choose Commando in the 
Edit menu. 

• Type the name of the command, then press COMMAND-K. For example, type 1 s on 
the command line, then press COMMAND-K 

• Enter cmdo followed by a space; then type the name of the command whose 
dialog box you want to use. For example, enter cmdo ls on the command line. 

• Warning The last method of invoking Commando is not supported in 24-bit addressing 
mode. For further information on 24-bit and 32-bit addressing mode, see "Changing Your 
Session Type" in Chapter 8, "Customizing Your Work Environment." .A. 

You can see how useful Commando is by working with a command that is already 
somewhat familiar to you, the 1 s command. 

1 With the CommandShell window displayed, type ls (do not press RETURN). 

2 Either select Commando from the Edit menu or press CoMMAND-K. 

The Commando dialog box for the 1 s command appears. 

Is Options---------------------, 

Choose directories/files 

r···Mark file types ··················································; 
! @No marking ! 
i O Mark directories ! 
O Mark other types 

····Show more information·······················, 
i D List all files ! 
i D Show size in blocks ! 
! D Show i-node numbers I 

fJommand Line 

r··Listing style····························································; 
! @ Short format, one column ! 
I 0 sorted L1ertically · 
j O sorted horizontally 
! 0 Long format 
! O show IO numbers 
! O no group information 
l..? no owner information 

(More options) (Output & Error) 

Help---------------~ [ Cancel J 
L isl the contents of • dirootory •nd I or disp l•y inform•lion •bout the files e;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;; .. 
listed. n Is J .___ ________________ ____, 
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The Help box 

Commando can serve as a quick command reference. At the bottom of every Commando 
dialog box you see a box labeled Help. This box contains a brief description of the 
command or the selected option. 

1 Look at the Help box at the bottom of the dialog box. 

This gives you a quick summary of the main functions of the command. 

2 Use your mouse to point to the button labeled "Choose directories/ftles" and 
hold down the mouse button. 

Information relative to your selection appears in the Help box. 

3 Without releasing the mouse button, move the pointer away from the "Choose 
directories/ftles" button, then release the mouse button. 

4 Perform Step 2 with several of the radio buttons and check boxes to view the 
various explanations in the Help box. 

If you happen to activate any of the radio buttons or check boxes, click them again to 
deactivate them. 

The Command Line box 

Commando is a command-line building tool. This means that the Commando dialog box 
doesn't run the command directly; it creates the proper command line in the 
CommandShell window. You can then run the command by pressing RETURN, or you can 
alter it to suit your needs. 

Just above the Help box is the Command Line box. This box shows you the 
command line that the Commando dialog box is building. As long as you haven't yet 
chosen any options, only the command itself (1 s, in this case) appears in this box. 
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1 Click the Command button labeled "ls" at the lower right of the dialog box. 

The dialog box is replaced by the active CommandShell window, which contains the 
command line you have constructed thus far. The 1 s command, which was shown in 
the Command Line box, is now displayed on the command line, ready to be run. 

2 Redisplay the 1 s Commando dialog box. 

The 1 s command is already on the command line. You need only press COMMAND-K to 
redisplay the dialog box, which you will use in the following exercise. 

Choosing arguments 

The "Arguments" section earlier in this chapter points out that you can apply the 1 s 

command to a specific file or directory by using the appropriate filename or directory 
name as the argument to the 1 s command. In the Commando dialog box, you do this 
with the "Choose directories/files" button. 

• Click "Choose directories/files." 

The following dialog box appears. 

( Rdd Current Directory: ] 

I a start ,..+1----------H- Current directory 

D memo! 
D setup 
D •cshrc 
D •EHamplsBackUp 
D •kshrc 
D •login 
D •logout 
D •mac 

111111 

I -0-

Select files and/or directories: 

€ 
( 

=I 

!'jei \ 

Desktop 

Done 

cancel 

Open 

Rdd 3 
f!ernm•(J l 

This dialog box allows you to specify one or more files and directories as arguments. 
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The name of the current directory is displayed in a small box just below the Add 
Current Directory button, as shown previously. When you click this box, a pop-up menu 
appears that lists all the directories above the current directory on the directory tree. 

To list all files in both the I directory and the /users directory, do the following: 

1 The current directory, which is listed at the top of the dialog box, is start. 

Select it and hold down the mouse button; then select Desktop from the pop-up 
menu. 

The newly displayed menu lists the items on the desktop. If you are logged in to the start 
account, the start alias folder is on your desktop and is therefore listed in this menu. If 
you have inserted a floppy disk, that too is shown in the menu. 

2 Double click the ; directory icon (highlighted in the dialog box shown below) 
to make the ; directory the current directory. 

[ Rdd Current Directory: ] 

I liiiil Desktop TI 

= EHtra Mac Disk 
=Mac Partition 
<SI stort olios 
TI! hash 

Select files and/or directories: 

3 ClickAdd. 

=I 

Done 

Cancel 

Open 

I[ Hdd D 
[ f!<Jmm•e 

You have now put the root directory in the list of arguments. 
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4 To add the directory named users, double-click the highlighted I directory 
icon (just below the Desktop icon); then scroll down the list of ftles and 
directories until users is displayed; then select users and click Add. 

The arguments you are adding to the command appear in the "Select files and/or 
directories" box at the bottom of the dialog box. as shown here. 

Select files and/or directories: 

5 Click Done. 

When the Commando dialog box reappears, examine the Command Line box. You have 
constructed the following command line: 

ls I /users 

This means, "List the contents of the I directory and the directory called users, 

which is just below the / directory in the directory tree." For an explanation of 
pathnames such as /users, see "UNIX Pathnames" in Chapter 2, "Using Files, Folders, 
and Directories." 

6 Press RETURN. 

The command line appears at the command prompt, ready to run. 

7 Press RETURN to run the command. 

Choosing options: radio buttons and check boxes 

This exercise introduces more options of the 1 s command and familiarizes you with 
the use of check boxes, radio buttons, and the "More options" button. 

You have already worked with two of the options that the 1 s Commando dialog 
box offers: the -c option (to divide the listing into columns) and the -1 option (to 
create a long listing). 
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These two options are contained in the "Listing style" section of the 1 s Commando 
dialog box, which is in the right half of the dialog box. 

For the following exercise, display the 1 s Commando dialog box again if it is not 
already displayed. 

1 Use your mouse to display the help message associated with the "Long format" 
radio button (see "The Help Box" earlier in this chapter). 

Observe that the Help box tells you that this radio button controls the -1 option and 
briefly describes what the -1 option does. 

2 Examine the help message of the "sorted vertically" button (in the "Short 
format" group of buttons). 

Observe the change in the Help box, which now describes the -c option. 

3 Click the "sorted vertically" button so that it is darkened, which means that it is 
turned on. 

As in standard Macintosh dialog boxes, only one radio button in the group of radio 
buttons can be turned on at a time. The Command Line box now displays the following 
line: 

ls -c 

4 Click the "Mark directories" button (located in the "Mark file types" section, at 
the upper left of the dialog box). 

Ordinarily, you cannot tell which item in the list is a filename and which is a directory 
name. This option places a I symbol after directory names to differentiate them from 
filenames. The -p option is now added to the Command-Line box. 

5 Choose the "list all files" check box in the "Show more information" group. 

This button forces the listing to contain all filenames, including those that begin with a 
dot(.), which are normally left out of the listing. As in standard Macintosh dialog boxes, 
the difference between radio buttons and check boxes is that you can select any number 
of check boxes in a given group at the same time but only one radio button within a 
given group. 
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6 Click "More options." 

A new dialog box appears, which offers you more options. Some Commando dialog 
boxes contain several "More options" buttons to off er several levels of additional options. 

7 Click the Cancel button of the "More options" dialog box to return to the main 
Commando dialog box. 

8 Click "Choose directories/files" to choose the ; directory as the argument. 

This is described in the tutorial in "Choosing Arguments," earlier in this chapter. 

9 Click the Done button of the "Choose directories/files" dialog box. 

The Command Line box now shows that you have constructed the following command: 

ls -a -c -p I 

That is, "list (1 s) all the contents (-a) in multiple columns (-c), and place a I mark 
after directory names (-p); do all this to the I directory only(; argument). 

10 Click ls (at the lower right of the dialog box). 

The active CommandShell window appears with the command line ready to run. 

11 Press RETIJRN to run the command. 

The standard output of the command (that is, the results shown on the screen) is shown 
below. There might be differences between this illustration and the files and directories 
displayed on your screen, because as the system is used, some items are added or 
deleted and others are moved to different places in the file hierarchy. 

./ 

.. I 

. aux_prefs 

.c:shrc 

.kshrc 

. login 

. I ogout 

.m"c/ 

.profile 

Appl ic"tion 
Desk top Fo Ider/ 
FILES 
Guest alias 
TextEditor "li"s 
bin/ 
dev/ 
etc/ 

I ib/ 
I os t+ found/ 
m"c/ 
mnt/ 
newunix 
nextunix 
root/ 
shl ib/ 

start al ia:: 
tmp/ 
unix 
users/ 
usr/ 

As you can see, for the occasional user of UNIX, the Commando command-building 
tool offers a powerful and effective way of using UNIX commands. 
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Further useful UNIX operations 

The following pages show you how to use several useful features of the UNIX operating 
system. Some of these tutorials illustrate the use of more features of the Commando 
dialog boxes. 

Using a different user account after logging in 

While you're working in one login account, you might want to accomplish some task in 
a different login account without logging out of the system and logging in to the other 
account. When you do this, you become a substitute user. For example, if you need to 
perform a system-administration task, but you are currently working in a user account, 
you can temporarily use the root account, perform the task, then return to your user 
account without having to log out and log back in twice. 

You can work in any account if you know its login name and password. Becoming a 
substitute user does not log you out of your own account and in to a new account; it 
merely allows you to work in the other account temporarily. As soon as you exit from 
the other account, you are once again working in your original account. 

You can become a substitute user only while working in a CommandShell window, 
and you're a substitute user only as long as you are working in that window. When you 
return to the Finder, you automatically return to your original user account. 

1 In the active Command.Shell window, enter the command su and a space, and 
the login name of the new account. 

For example, enter su root. A/UX displays the following prompt: 

Password: 

You need to know the password for the new account (the root account, in this case) to 
complete this procedure. 
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2 Type the password. 

No characters are displayed as you type the password. 

3 Press RETURN. 

When you press RETURN, A/UX reads the password. If the login name and password are 
correct, you can begin to work in the new account. If either the login name or the 
password is incorrect, you see the following message: 

su: Sorry 

In this case, you are still working in the same account you were originally using. 

When you return to the Finder (by clicking any Finder icon or open Finder window or 
by choosing Finder in the Applications menu), you automatically return to your original 
user account. You can end the substitute user session while still in CommandShell by 
entering the command exit at the command line. 

Searching for a string of characters and 
redirecting output 

One useful UNIX command is called grep; it is used for finding a given string of 
characters in any file you specify. For example, suppose that you need to glance at all 
references to the word sales in the files that are in the start directory. For the 
purposes of this tutorial, assume that the phrase is in either memol or let terl, 

since they are the only pieces of business correspondence in that directory. 
Instead of looking at the results of the search on screen, you can save the information 

in a separate file so that you have it available for future reference. This requires 
redirecting the output of the search to a file rather than displaying the results on a 
screen. 
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1 In a CommandShell window, type grep and press CoMMANo-K to display the 
grep Commando dialog box. 

grep Options--------------------, 
;··· Required··· ············· ............................... , 
! Search pattern: 

Files to search 

:···Operation ....................................................................... , 

! ® List matching lines 
i 0 List non-matching lines 
i 0 List files names only 

i D Count lines 

Error D Ignore case 
~----~-----~ D Print line number(s) 

r:Command Line 

L••P 

D Print block number(s) 
D Suppress errors 

Help------------------, Cancel 
Search a file for a pattern. 'grep' SE-arch patti:orns are limiteod regular ~;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;~ 
expressions in the sty le of ed. It USE'S a compact nondeterministic ~ ~ 

~•l-'-go_ri_th_m_to_s•_•_ro_h t_he_f_ile_. --------------' I! ~.;n:p I' 

There is a text box at the upper left of the dialog box. It is marked Required because you 
cannot use the grep command without specifying the pattern of characters for which 
you are searching. 

2 In "Search pattern," type the characters you are looking for: 

sales 

3 Click "Files to search." 

4 Display the start directory's files in the file list. 

If some other directory is displayed at the top of the "Files to search" dialog box, and if 
the start folder is on the Desktop, follow these steps: 

• Select the current directory name and hold the mouse button down. 

• Choose Desktop from the pop-up menu. 

• Choose the start directory from the new menu that appears. 
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If the st art folder is not on the desktop, follow these steps: 

• Return to the root directory by choosing I from the pop-up menu that appears when 
you point to the current directory's name and hold down the mouse button. 

• Double-click the users directory, then the start directory, in the files list. 

This causes the files in the start directory files to appear in the files list. 

5 Choose the following files either by double-clicking their names or by selecting 
a filename and choosing Add: 

memol 

letterl 

The filenames (with their complete pathnames) appear in the "Select files" box. These 
are the files the system will search through for the specified string of characters. 

D letter! 
IDm:i:rnliil I 
D setup 
D •cshrc 

/a start,.., 

D •EHamplsBackUp 
D •kshrc 
D •login 
D •logout 
D •mac 

Select files: 

I users Is tart /letter I 
PllJl • " I 

6 Choose Done. 

{} 

'!'.!! 
:l:li: 

:l,l:i 

~ 0 

{} 

k 

= I 
1: je( t 

Desktop 

Done 

Cancel 

n fldd 

( Re moue 

The grep Commando dialog box reappears. 

7 Check "Ignore case" (the -i option). 

3 

The "Ignore case" option allows the search to succeed even if the characters are not all 
lowercase (as you typed them in the text box). 
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8 To redirect the output to a new ftle, select Output and hold the mouse button 
down; then choose New File in the pop-up menu. 

This displays a dialog box that allows you to enter the name of a new file in which to 
save the results of the search. 

9 Be sure that the start directory is displayed in the ftles list and type the 
following ftlename in the "Redirect to" text box: 

sales search 

The output of the search will be redirected to a new file named sales search and 
will be saved in that file. 

10 Choose OK. 

11 Choose the grep button. 

You have built the following command line: 

grep -i sales /users/start/letterl /users/start/memol 

>/users/start/salessearch 

Table 4-1 explains the meaning of each item on the command line. 

Table 4-1 Items in the command line of Step 11 

Command-line Item 

grep 

-i 

sales 

/users/start/letterl 
/users/start/memol 

> 

/users/start/salessearch 

Meaning 

search for a pattern of characters 

ignore case 

search for this pattern of characters 

search through these files 

redirect to the following file 

create this file and send the results of the search to it 

12 When the CommandShell window reappears with the complete command line, 
press RETURN to run the command. 
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To check the results, return to the Finder by clicking the start folder to make it the 
active window or by choosing Finder in the Applications menu. Note that the start 

folder now contains a file named sales search. If the start folder is not open, 
double-dick its icon to open it. Double-dick the salessearch icon to open the text file. 
This opens the TextEditor window that displays the text file. For information on 
TextEditor, see Chapter 6, "Writing with TextEditor." 

D /users/start/salessearch El~ 
I/users/start/ I et ter 1: We have i nstruc:ted our New \'ork sa I es off i c:e to remove the damaged .Q 
/users/start/letterl: Director of Sales ,---, 
/users/start/memo 1: TO: Sa I es Representatives 
/users/start/memol:GOOD PRODUCTS and GOOD SUPPORT. Every salesperson who's been with 

This shows you the file (with its full pathname) in which the characters occur and the 
line on which they occur. 

For a review of UNIX-style pathnames, see "UNIX Pathnames" in Chapter 2, "Using 
Files, Folders, and Directories." 

Looking up UNIX commands on screen 

If you need to look up information about a UNIX command, you can use the printed 
version of the A!UX Command Reference (see "Command Reference Notation" in the 
Preface of this guide). You also can display on your screen the complete text of the A/UX 
Command Reference entry (called the manual page, or the man page) for any 
command. 

The term manual page might lead you to assume that each entry is only one page 
long, but that is not the case. Some of these entries are dozens of pages long. 
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Display a man page as follows: 

• Enter man commandname 

Use the name of a command (for example, ls) in place of commandname. 

The text that appears on screen has somewhat simpler formatting than the text that 
you read in the AIUX Command Reference. For example, terms that are in italic type in 
the printed book are underlined on screen. 

Follow these directions to examine the man page for the 1 s command: 

• Enter the following on the command line: 

man ls 

D CommandShell 1 
pacer. root # man Is 

Is( 1) Is( 1) 

NAME 
Is - I i sts the contents of a di rectory 

SYNOPSIS 
Is I-al I-bl I-cl I-CJ 1-dl I-Fl 1-gl 1-i l 1-1 J 1-Ll I-ml 
1-nl 1-ol I-pl !-ql 1-rl 1-Rl !-sl !-tl 1-ul !-xl !names] 

ARGUMENTS 

.,, 

-a Lists al I entries. Usually entries whose names begin 
with a period (.) are not I isted. 

-b Fore es pr i n t i ng of nongraph i c characters to be i n the 
octal \ddd notation. 

-c Uses the time of the last modification of the i-node 

-c 

( f i I e created, mod12 changed, and so forth) for sorting 
<-t) or printing (-1 ). 

Specifies multicolumn output with entries sorted verti-

Moving down through the man display 

You can show the next screen of text or advance line by line as follows: 

• Press the space bar to display the next screen of text. 

• Press Return to advance the text one line at a time. 
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To review material that has been scrolled off the top of the screen, use the scroll bar. 

The ''Name" section 

The man page begins with the "Name" heading, which introduces a brief summary of 
what the command does: 

ls - list contents of directory 

This is the text that appears in the Help box of the Commando dialog box. 

The "Synopsis" section 

The "Synopsis" section appears below the "Name" section. It looks rather mysterious at 
first view, but it becomes clearer once you know what to look for. The 1 s synopsis 
reads as follows: 

SYNOPSIS 

ls [-R] [-a] [-d] [-Cl [-x] [-ml [-1] [-L] [-n] [-o] [-g] 

[-r] [-t] [-u] [-cl [-p] [-Fl [-bl [-q] [-i] [-s] [names] 

Don't be discouraged by the long list of bracketed items. The synopsis summarizes 
the way the 1 s command is used on the command line. It will look clearer if you 
consider its separate components one at a time. 

1 s You begin by typing the 1 s command itself. 

[-R] ... [-s] 

[names] 

These are the options. You continue by typing any of the 
bracketed options that are appropriate. 

Note that you do not type the brackets on the command line. The 
brackets are a conventional way of indicating that the bracketed 
item is optional. 

As you learned earlier in this chapter (see "Options and 
Arguments"), you can use the ls command without any options. 

Finally, you type the argument, if necessary. The fact that it is 
bracketed indicates that it, too, is optional. In this case, names 
refers to names of directories or files. 
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The "Arguments" section 

This is essentially a list of all the options and arguments. Note that options and 
arguments are listed together, in one section, and are arranged alphabetically. Some of 
the items in the list of ls command options are familiar to you. Here are two 
examples: 

-C Multicolumn output with entries sorted vertically. 

-p Put a slash (/) after each filename if that file is a 

directory. 

Some of the explanations might be expressed in technical language that is a bit 
obscure. For an alternate explanation, display the Commando dialog box and look at the 
Help message for the item that you need to learn about. See "The Help Box" in "Using 
Commando,'' earlier in this chapter. 

The "Description" section 

This section offers a full description of the operation of the command. Its length and 
complexity vary from command to command, depending on the complexity of the 
command's use. 

The "Examples" section 

Not every man page has an Examples section. The man page for 1 s presents 
1 s -1 as an example, which is discussed earlier in this chapter (see "Options and 
Arguments"). When examples are provided, they are useful for seeing how the 
command is used. 

The "Files" and "See Also" sections 

There are several sections that appear only in a few man pages ("Status Messages and 
Values,'' "Warnings,'' "Limitations," "Notes," and "Bugs"). The "Files" section and the "See 
Also" sections, however, normally do appear. 

If you are not involved in the technicalities of UNIX, the "Files" section is unlikely to 
be of use to you. It describes the files that the command uses. 

4-26 Chapter 4 Using UNIX Commands and Commando 



The "See Also" section can be useful to you. It cross references other commands that 
are associated with the command in one way or another, or whose uses parallel or 
supplement the command. 

Quitting a manual page 
To redisplay the command prompt without paging through the entire manual page, you 
can quit the manual page as follows: 

• Press C0Nmo1-C. 

Linking commands with the pipe 
A/UX allows you to take the output from running one command and to channel it (or 
pipe it) into another command. This allows you to string commands together in order to 
run a given set of data through several processes, just as oil in a refinery moves from 
process to process through pipes (See Figure 4-2). 

Output from Input to 
Command 1 Command 2 

~ r::,) (~) ~) r::,) ~ 
Conimand 1 Pipe to Command 2 Command2 

Figure 4-2 Using a pipe to channel the output of Command 1 as the input to 
Command2 

The pipe symbol is a simple vertical line (I), which is often on the backslash key(\) 
on the keyboard, though keyboards vary as to the position of this character. 

Earlier in this chapter, in "Options and Arguments," you learned that the command 
ls -1 produces a long listing of files and directories in a directory, giving you several 
items of information in addition to the name of the files and directories. One of 
those items of information is the date on which the item was last changed. 

The next exercise shows you how to use the pipe to use the output of one command 
as the input to another. The task is to find all items in the start directory that were 
created or last changed in the year 1990. To do this, you first use the 1 s -1 command 
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to create a long listing of the contents of the start directory, because a long listing 
contains the dates on which the items in the list were created or changed; then you will 
use a pipe to channel the output of the 1 s command to the grep command; then 
you use the grep command to search the output of the 1 s -1 command (the list) 
for the characters 19 9 o. 

1 On the command line in a CommandShell window, type the following: 

ls -1 /users/start 

This is the list command, the option that creates a long listing, and the argument that 
specifies which directory's contents are to be listed. For the purposes of this exercise, use 
the absolute pathname of the start directory (/users I start). 

2 Press the spacebar, type a pipe character ( I ), then press the spacebar again. 

The command line now looks like this: 

ls -1 /users/start I 

3 Type grep and press CoMMAND-K. 

The Commando dialog box for grep appears. 

rgrep Options--------------------. 
, ... Required ....................................................................... , , ... operation ..................................................................... , 
! Search pattern: i i ® List matching lines ! 
! [I J ! ! 0 List non-matching lines ! 
L. ..................................................................................................... ..! ! O List files names only i 

Files to search [ __ g···~-~-~-~-~···l·i·~-~-5. ............................................................. . 
output Error D Ignore case 
[~-----I~----~] D Print line numberls) 
._ ____ __,_ _____ _, D Print block number(s) 

D Suppress errors 

[Command Line 

~~a~!~ a file for a pattern. 'grep' search patterns are limited regular J a(;;;;;;;;;;;;;[;;;;a;;;;n;;;;c;;;;el;;;;;;;;;~ 
xpressions in the sty le of ed. It uses a compact nondeterministic K g rep »i 

i.......<.go_ri_th_m_to_s_e•_rc_ht_he_f_ile_. __________ ___, ~ p 
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4 In the "Search pattern" text box, type: 

1990 

In this exercise you will not be using any of the options, so you need only type the 
character string to be searched for. 

You do not need to use the "Files to search" button because the text that is being 
searched is the output of the 1 s -1 command, which you are channeling into the 
grep command with the pipe. 

5 Press RETURN or choose grep in the dialog box. 

The following command line appears in the CommandShell window: 

ls -1 /users/start I grep 1990 

6 Press RETURN to run the command. 

The window displays the following response: 

-rw-r--r-- 1 start project 1289 Jan 17 1990 letterl 

The pipe is useful for performing complex tasks that require processing information 
through several commands and that would take too much time and work to perform one 
command at a time. 
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5 Permissions 

This chapter teaches you the meaning and use of UNIX file and folder permissions. It 

shows how to change permissions for the three main user types (owner, group, and 

others). It also discusses the difference between UNIX permissions and Macintosh file­

sharing permissions. 

• Restricting access to files and folders 

• UNIX file access permissions 

• Folder and directory access permissions 

• Default access permissions 

• When you are denied permission 

• Changing permissions 

• Differences between UNIX and Macintosh file-sharing permissions 

If you are unfamiliar with the concept and use of access permissions, first read 

"Restricting Access to Files and Folders;" then go through whatever sections and tutorials 

are appropriate to your needs. 



Restricting access to files and folders 

A/UX is a multi-user system that allows you to share files with other users, whether all 
the users are using one computer or several computers linked by a network. It also 
provides a way to protect your files and folders so that only you (or a restricted group of 
users) can open, read, or change the file, or run the program. Chapter 1, "Starting and 
Finishing a Work Session,'' showed you that only the person who knows the password 
of an account can log in to that account. UNIX permissions extend the security of 
your files by ensuring that only users with the correct access permissions can use files 
or folders. 

The user who owns the folder or file (that is, the one who created it or who has been 
granted ownership) controls access to that folder or file. The only exception to this is the 
person who is logged in as root. That person normally has access to all files. For that 
reason, under most circumstances, only the system administrator has permission to log in 
to the root account. Because of these special privileges, the person logged in as root is 
sometimes called the superuser. 

Although it is commonly said that a given user has certain permissions, it would be 
more accurate to say that a given user account has certain permissions. Whoever knows 
the account name and password can log in to that user account and take advantage of all 
permissions assigned to that account. 

UNIX file access permissions 
File access permissions determine who (that is, which user accounts) can use a 
particular file and what they can do with it. Three types of permissions exist. You can set 
read permission, write permission, and execute permission for each file. 

• Read permission allows you to open the file and read it. 

• Write permission allows you to change the file or delete it. 

• Execute permission allows you to run an executable file, such as an application or a 
script. 
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Categories of users 

Every file's permissions grant or deny access to the file according to the user's access 
class, that is, his or her membership in one or more of three categories. A description of 
these three categories follows: 

• Owner (sometimes called user) permission applies to the person who owns the file. 
If the file has only owner permission, only the person who is logged in as the owner 
of the file can use it. The owner of a file or folder is the user who created it. 
Ownership can be transferred to a different user with the chown command. For 
further information on the chown command, see chown(l) in A/UX Command 
Reference. 

• Group permission applies to a specific named group of users. If the file has group 
permission, those who are assigned to this group can use it. 

• Others (sometimes called world) permission applies to all other users. If the file has 
others permission, everyone logged in, who is neither the owner nor in the group, 
can use it. 

Therefore, each form of permission (read, write, and execute) can be assigned to the 
owner, to a specified group of users, and to all other users logged in to the system. 

Folder and directory access permissions 
You can set the access permissions of folders or directories that you own. Folder and 
directory access permissions can be somewhat confusing because they have the same 
names as file access permissions (read, write, and execute), but they affect folders and 
directories differently than they affect files. In addition, access permissions for directories 
work somewhat differently in a command-line interface (such as CommandShell) than 
access permissions for folders in the Finder. 
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The following general rules apply to directory access permissions if you are working in 
CommandShell: 

• Read permission allows you to read the contents of a directory (that is, to list its 
contents with the ls command and many of the command's options; see Chapter 
4, "Using UNIX Commands and Commando"). However, it doesn't allow you to go 
into the directory or to add, rename, or remove any of its contents. 

• Write permission allows you to add or remove items from the directory, or to 
rename them, if you already know the items' names. However, you cannot enter the 
directory, nor can you list its contents. 

• Execute permission allows you to go into the directory with the cd command 
(see "Changing to a New Directory; Returning to Your Home Directory" in Chapter 4, 
"Using UNIX Commands and Commando"), but you cannot list its contents, nor can 
you add, remove, or rename its contents. You can access the items in the directory 
only if you know their names. 

These permissions are usually used in combination, although they can be of some 
use individually. For example, a directory that has only execute permission prevents 
unauthorized users from snooping its contents. 

UNIX directory permissions in CommandShell work differently than folder 
permissions in the Finder because in order to see what a folder contains in the Finder, or 
to remove or rename anything in the folder, you must open the folder by double-clicking 
it. Since that is equivalent to entering the folder, you need read and execute permission. 
In fact, the Finder insists that you have execute permission before you can do anything 
useful with a folder. 

The following list shows the permissions you need in order to perform various 
operations upon a folder in the Finder: 

• To open a folder and read its contents, you need read and execute permissions. 

• To open a folder and add, rename, or remove files, you need read, write, and 
execute permissions. 

• To add items to a folder that you cannot open and whose contents you cannot see, 
rename, or remove, you need write and execute permissions. This folder is 
commonly called a drop box, because once you add an item to it, that item is 
available only to a user who has at least read and execute permissions. 
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Note, however, that if you are using CommandShell, you can use UNIX commands to 
manipulate an item in a drop box, provided that you already know the name of the 
item. As mentioned above, A/UX directory permissions allow a user with write and 
execute permission to enter and change the contents of a directory. 

Default access permissions 

When you create a file or a folder, the system automatically assigns certain preset access 
permissions for the file or the folder as regards you (that is, the owner), your group, and 
other system users. As shipped, the A/UX default access permissions are as follows: 

For regular nonexecutable files The default access permissions for newly created 
regular text files are as follows: 

• Owner: read, write 

• Group: read 

• Others: read 

Folders and executable files Newly created folders and compiled programs are 
automatically assigned the following default permissions: 

• Owner: read, write, execute 

• Group: read, execute 

• Others: read, execute 

Changing default permissions For information on changing default permissions, see 
A/UX Local System Administration. 
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Shell script permission 

A shell script is a text file that contains one or more A/UX commands. These 
commands run as a program when you double-dick the shell script file icon in the 
Finder or enter its name as a command in CommandShell. A/UX does not detect that a 
newly created shell script is anything other than a regular text file. Therefore, it assigns 
the default permissions for a text file. After you create a shell script, assign execute 
permission to the text file. For directions on changing permissions of a file or a folder, 
see "Changing Permissions,'' later in this chapter. For further information on shell scripts, 
see A!UX Shells and Shell Programming. 

When you are denied permission 

If you try to work with a file or a folder in the Finder without the proper permission, alert 
boxes inform you of the problem. Figure 5-1 shows the alert boxes that appear if you try 
to open a folder or a file for which you do not have the appropriate permissions. 

The file "sample" could not be opened, 
because you do not haue enough access 
priuileges. 

K OK l) 

The folder "sample_dir" could not be 
opened, because you do not haue enough 
access priuileges. 

K OK l 
Figure 5-1 The alert boxes that inform you that you lack the appropriate 
permissions to open a file or a folder 

If you have read permission for a folder but you do not have write permission, the 
folder appears as shown in Figure 5-2. 
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Write pennission denied 

~IJ~~~~~~c1::ii~~~~~~0~ 
.ft. 24 items 75.7 MB in disk 37 .3 MB av ail ab lo 
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mao •aux_pre-fs •c:shrc: •kshro •login 
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g y ,J:'" .. L g lffJ . 
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Figure 5-2 Write permission to a folder denied 

Some file and folder icons change their appearance when you do not have 
permission to use them. See "The Finder Icons" in Chapter 2, "Using Files, Folders, and 
Directories," for descriptions of them. 

Similar warnings are displayed on the command line in CommandShell if you attempt 
to work without the appropriate permissions. 

Changing permissions 
There are several ways of changing access permissions. The traditional UNIX command­
line interface uses the chmod (or change mode) command. However, A/UX provides a 
much easier way to do this. It provides dialog boxes that allow you to look at and 
change the permissions of a file or a folder while you are working in the Finder. 

+ Note You cannot change the permissions of an alias. You must work with the 
permissions of the original file. • 

To see the permissions of the file let terl in the start folder and to change the 
permissions, perform the following steps: 

1 Withthe start folderopen,select letterl byclickingitsicon. 

Don't double-dick the icon. You need to select it, not to open it. 
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2 Open the File menu and choose UNIX Permissions. 

letter! 

UN IX Permissions 

iJ 'l'here: /users /st•rtlletter 1 
logged In As: st.rt 
Pe-r-missions: RE-.ad 1 'Write 

Re•d Write Exi:-cutie 

UNIX: Ovner: j&N I J:8] J:8] D 
UNIX Group: /project I J:8] D D 

Others J:8] D D 

The dialog box shows you the following information: 

• The name of the file or folder and its appropriate icon 

• Its pathname, so that you know its location in the file system 

• Your login name 

• Your permissions 

• A chart of the file permissions, showing check boxes with read, write, and execute 
permission for the three categories of users (owner, group, others) 

The chart also shows you the names of the owner of the file and its group. 

The chart tells you the following about the file let terl: 

• It is owned by start and the owner has read and write permission. In other 
words, if you are logged in as start, you can read the file and change it. 

• The group name is project and the group has only read permission. If you are 
logged in as one of the login names assigned to this group, you can only read this 
file. You cannot change it. 

• All other users have only read permission. They can only read this file; they cannot 
change it. 

3 To give the group write permission, click the check box in the Write column in 
the UNIX Group row. 
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4 Click the close box. 

The UNIX Permissions dialog box is now replaced by an alert box. 

Saue changes to access priuileges for 
"letter!"? 

( Don't S1111e ) [ Cancel J ( Saue B 

There are three choices: 

• Save closes the alert box and the UNIX Permissions dialog box, and saves the 
changes you have made to the permissions. 

• Don't Save closes the alert box and the UNIX Permissions dialog box without saving 
the changes you have made in the permissions. 

• Cancel closes the alert box but does not close the UNIX Permissions dialog box. 

5 Choose Save in the alert box. 

6 Redisplay the UNIX Permissions dialog box for the file 1 et t er 1. It shows that 
the group now has both read and write permission. 

7 Click the Write permissions box for the group to remove write permission; 
then save the change by repeating steps 4 and 5. 

Changing folder permissions 

Changing the permissions of a folder is no different, in principle, from changing the 
permissions of a file. 

+ Note You cannot change the permissions of an alias. You must work with the 
permissions of the original file. • 
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To check and alter the permissions of the start folder, perform the following steps: 

1 Double-click the I icon to open the I folder. 

2 Double-click the users folder icon to open it. 

3 Click the start icon to select it; then choose UNIX Permissions in the File 
menu. 

start 
UN IX Permissions 

i=---i Yhere: /users/start 
L_J Logged In "s: start 

Permissions: Read J 'w'rite J Execute 

Read 'w'rite Execute 

UN IX Owner: IHM I I2l I2l I2l 
UN IX Group : j project I I2l D I2l 

Othe-r:s I2l D I2l 
0 Mako? all curreontly i:-nclosE'd directoriE':s: like this one 

( Show MHC uiew ) 

Use this dialog box just as you used the UNIX Permissions dialog box to view and 
alter file permissions in "Changing File Permissions," earlier in this chapter. 

Note the button labeled Show Mac View, at the bottom of the dialog box. If you click 
this button, the dialog box is replaced by a dialog box that displays the folder 
permissions in Macintosh terminology rather than the UNIX terminology that the UNIX 
Permissions dialog boxes have used thus far. 

Since the effects of changing UNIX folder (or directory) permissions are confusing, 
this dialog box serves as a reminder of what you can or cannot do with the folder. 
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start 
Macintosh YieY of UNIX Permissions 

f""-1 Yhere : I users I start 
L_J Logged In As: start 

Permissions : Seo Folders and Files, Mako Changes 

See Folders Make 
and Files Changes 

UN IX o-.ner : I start 181 181 
UN IX Group : I pro jeot 181 D 

Others 181 D 
D Mako all ourrontly onolosod folders lik• this on• 

(Show UNIH uiew J 

This dialog box shows the folder's UNIX permissions in Macintosh terminology. Note 
that the button at the bottom of the dialog box now reads "Show UNIX View." You can 
toggle back to the UNIX view dialog box by clicking that button . 

.A. Warning Do not confuse the Macintosh view of UNIX folder permissions with 
Macintosh file-sharing permissions. The differences between UNIX permissions and 
Macintosh file-sharing permissions are described later in this chapter. See "Differences 
Between UNIX and Macintosh File-Sharing Permissions." • 

Differences between UNIX and Macintosh 
file-sharing permissions 

The differences between UNIX permissions and Macintosh file-sharing permissions can 
be summed up as follows: 

• Macintosh file-sharing permissions affect file sharing over AppleTalk. UNIX 
permissions affect other users on your machine and across all UNIX networks. 
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• All files and folders created within the UNIX file system (rather than in the Macintosh 
file system, such as in MacPartition), automatically are assigned default UNIX 
permissions. These default permissions are described earlier in this chapter (see 
"Default Access Permissions"). 

• Folders and their contents are assigned Macintosh file-sharing permissions only if the 
owner of the folder has made it available to other file-sharing users. 

• UNIX has three types of permission (read, write, and execute, described in "UNIX 
File Access Permissions" earlier in this chapter) that the owner of the file or folder 
can assign to every item within a folder separately (that is, each item can have any 
combination of permissions). Macintosh file sharing uses a different set of 
permissions that can only be assigned to folders, not to files. The three types of 
Macintosh file-sharing permission are as follows: 

-1 See Folders: You can open the folder. 
0 See Files: You can open any file within the folder. 
0 Make Changes: You can change the contents of any file within the folder. 

A comparison of UNIX permissions terminology and Macintosh file-sharing 
terminology is illustrated in Figure 5-3. 

UNIX permissions 

Make changes 

See folders and -~--------­ Read Write Execute 

files UN IX Ovner- : \ Tamar a I !Zl !Zl !Zl 
UN IX Group : J Art I !Zl !Zl !Zl 

Others !Zl D !Zl 
0 M.:i:ke .all currently enclosed directories llke thls one 

Macintosh file sharing access privileges 
Read -------------------, 

See s •• M•k• 
Fold•rs FllE'S Changes 

Ovn.,r: \ Tamara ... I !Zl !Zl D 
us .. r /Group: I Ari Group ... I !Zl !Zl D 

Evoryoo• D D D 

Figure 5-3 UNIX permissions terminology compared with Macintosh file­
sharing terminology 
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6 Writing with TextEditor 

This chapter describes how to use the TextEditor application to create and edit text files. 

It presents tutorials with step-by-step instructions that show you how to accomplish 

simple writing and editing tasks. 

This chapter contains the following sections: 

• What is TextEditor? 

• Starting TextEditor 

• Saving a new document 

• Editing an existing document 

• Formatting and other features 

• Printing 

• Quitting TextEditor 

If you are not familiar with Macintosh text-editing tools, read through this chapter in 

sequence. Otherwise, you should consult "Formatting and Other Features," and use 

other sections as needed. 



What is TextEditor? 

TextEditor is an application that allows you to create and edit text files using the mouse 
and menu commands in the traditional Macintosh manner. It creates a file that contains 
only the text characters that you type on your keyboard (including tab and return 
characters). This is called a text-only file (or an ASCII text file). When you create a 
document with word-processing or desktop-publishing software, unless you save the file 
as text only, the file contains many formatting commands. Although these formatting 
commands are invisible on your screen, they might confuse other programs that try to 
use your file. A text-only file can be read by any text-editing or word-processing 
application. Moreover, you can use it to write programs or shell scripts, which should 
never contain hidden formatting characters. 

To preserve the text-only nature of its text files and still allow you certain formatting 
choices, TextEditor gives you the option of saving the file's formatting information, but it 
saves this information in a separate file called a resource fork and saves the text 
characters in a text-only file. These formatting choices include adjusting the tab settings 
and choosing fonts. These features are described later in this chapter. 

Since TextEditor reads and writes text-only files, you can use it to work with files 
created with any other text-only text editor. Thus, you can edit MacWrite® files saved 
with the Text-Only option. When you select the Open command, TextEditor's standard 
file dialog box displays a list of all text files in the folder (or the current directory, in 
UNIX parlance), regardless of the program used to create the file. 

The resource fork has the same filename as the text file, but it is preceded by a 
percent sign(%). 

Like most UNIX systems, A/UX also comes with a commonly used UNIX text editor 
called vi (Visual Editor). If you are an experienced vi user, you can continue to use 
vi to read and write text files from the CommandShell command line. For information 
on CommandShell, see Chapter 3, "Using CommandShell." Naturally, TextEditor can read 
and edit text files created with vi, and vice versa. 

The following section teaches you how to use TextEditor to create a document. During 
the course of these tutorials, please be sure that you log in as st art and are working 
inthe start folder. 
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Starting TextEditor 

You can start TextEditor from the A/UX Finder by double-clicking the TextEditor icon, 
an alias of the TextEditor icon, or a text-file icon (provided that TextEditor is the default 
editor). You also can start TextEditor from a CommandShell window. 

If you are working in a CommandShell window, you can start TextEditor by entering 
the Text Edi tor command. An untitled TextEditor window appears. 

The following tutorials teach you how to work with TextEditor after starting it from 
the Finder. 

Starting TextEditor from the A/UX Finder 

This tutorial teaches you how to start TextEditor from the A/UX Finder by creating an 
alias of the TextEditor icon and by double-clicking the alias. 

To find the TextEditor icon, open the /mac/bin folder (for a description of 
pathnames such as /mac /bin, see "UNIX Pathnames," in Chapter 2, "Using Files, 
Folders, and Directories"). 

1 Double-click the icon for the / folder. 

1. 
I 

The I folder opens, displaying the mac folder icon. 

=o I 
27 itoms 81 .7 MB in disk 31 .2 MB availabl• 

• iJ iJ iJ iJ 
1111 •aux_prefs •cshrc •kshrc •login 

LJ I iJ iJ LJ 
•mac •m.ailrc •profile FILES bin 

Q 0 J~L g ~ . 
..... mill< 

¢J 
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2 Double-click the mac folder icon. 

The mac folder opens, displaying the bin folder icon. 

I 
2. = ...8.1...2J:>1e . -3: ..2..M8...= . ~ 

I= D mac 0 
5 items Bl .B MB in disk 31.2 MB availabl• 

CJ • CJ CJ CJ 
iit 

sys l!I MacX lib src 

r--
.....__ 

~ 
¢1 1¢ Qi 

3 Double-click the bin folder icon. 

The bin folder opens, displaying the TextEditor icon. 

5 ite-ms Bl .B MB in disk 31 .2 MB av ail ab l• 

bin 

CJ F=17=it=em=s=============B=1.=8=MB=i=nd=is=k=========31=.2=M=B=a=va=ila~b~=9• 
sys ilei JF9b Q c::::=i lk::!J 

p le HD SC Setup CommandShe 11 CommandShe 1124 

~ ~ ~ 
Commando Teach Text change-slz:e cm do dt?rE'Z 

~ ~ ~ 

4 Select the TextEditor icon to highlight it, choose Make Alias from the File menu, 
and drag the TextEditor alias icon to the desktop. 

If an alert box appears that asks you whether you want the alias icon to appear on the 
desktop, choose Yes. If not, drag the icon to the desktop. 

You can now use the TextEditor alias icon without having to open folders. 
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bin 
17 ltems 81 .8 MB in disk 31 .2 MB available 

liE::. Q Q c:::::J 
p le HD SC Setup CommandShe 11 CommandShe 1124 

~ ~ em ~ ~ ~ 
Commando Teach Text TextEditor ch.an9esize c:mdo dE-rez 

~ <$l ~ ~ ~ ~ ,, bunch m•o?4 ...rr.=3? '"' <otfilo 

Now that you have created the TextEditor alias icon and moved it to the desktop, use it 
to create a new document as follows: 

• Double-click the TextEditor alias icon. 

A TextEditor window named Untitled appears. You can now begin to create your 
text file. 

Entering text 

Begin by creating an office memo as follows: 

1 Type 

Dear Phil: 

Your screen should look like this: 

D /users/ start/Untitled 
Dear Phi I: 

111111 
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2 Press the RETURN key twice and type 

I received your letter about the purchase of land for a new 

office building. 

You have probably typed past the edge of the screen. Unlike many word processors, 
TextEditor does not automatically move to the next line when you type past the right 
edge of the screen. This is a feature that programmers find useful. 

3 Move the I-beam to where you want the line break to be; then click. 

This places the insertion point on the line. You also can move the insertion point to the 
left by pressing and holding the LEFT-ARROW key. 

4 Press RETURN to move the rest of the sentence to the next line. 

5 Move the insertion point to the end of the text and press RETURN twice to start a 
new paragraph. 

6 Continue typing (remember to press RETURN to go to the next line before you 
reach the edge of the screen again). 

It's true that the financial reports for the last quarter 

are not in yet, but there is a general feeling that the 

numbers look good. This might be the perfect time to submit 

your plan. 

7 Press RETURN twice to create a new paragraph, then type the following: 

I don't want to rush you, but perhaps you should get ready 

to take advantage of a real opportunity. 

Cutting and pasting text 

The sentence that you typed in step 7 might look better right before the material you 
typed in step 6. The two paragraphs would then read as follows: 
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I don't want to rush you, but perhaps you should get ready 

to take advantage of a real opportunity. 

It's true that the financial reports for the last quarter 

are not in yet, but there is a general feeling that the 

numbers look good. This might be the perfect time to submit 

your plan. 

1 Place the I-beam just before the first letter of the sentence beginning: "I don't 
want ... " 

2 Hold down the mouse button and move the mouse so that the I-beam moves 
past the period after the phrase real opportunity. 

3 Release the mouse button. 

The text is now selected. 

/users/start/Untitled 
Dear Phi I: 

I received your letter about the purchase of land for a new 
office building. 

It's true that the financial reports for the 
last quarter are not it yet, but there is a general feeling 
that the numbers I ook good . Th i s m i gh t be the perfect t i me 
to submit our Ian. 

You can perform various operations with a block of selected text. In this case, you are 
going to cut and paste the text. 

4 Choose Cut in the Edit menu. 

The selected text disappears. The passage you have cut is saved on the Clipboard. If you 
choose the Show Clipboard command in the Edit menu, you see a window showing the 
selected text saved in the Clipboard. For now, continue with Step 5. 
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5 Move the I-beam to the end of the first paragraph and click RETURN twice to 
create a new paragraph. 

This places the insertion point where you are going to paste the text that you 
just cut. 

6 Choose Paste in the Edit menu. 

The selected text appears in its new location . 

.. o /users/ start/Untitled 
Dear Phi I: 

I received your letter about the purchase of land for a new 
office building. 

I don't want to rush you, but perhaps you should get ready 
to take advantage of a real opportunity. 

It's true that the financial reports for the 
I ast quarter are not i t yetJ but ,there is a genera I fee I i ng 
that the numbers look good. This might be the perfect time 
to submit your plan. 

The selected text remains on the Clipboard until you replace it with another block of 
selected text. If you wanted to, you could paste copies of it in any number of other 
places in the document. 

To save this memo, see the next section, "Saving a New Document." 

Saving a new document 
Since this document is new, if you wish to use it again you must save it and give it a 
filename as follows: 

Follow these directions: 

6-8 Chapter 6 Writing with TextEditor 



1 Display the File menu. 

The first three of the following four commands allow you to save a file: 

• Save 

• Save As 

• Save a Copy 

• Revert to Saved 

These four commands are described at the end of this exercise, after Step 5. 

2 Choose Save As. 

The Save As dialog box asks you to select a name for the file. 

la start I 

LJ "<S!in 
U "hmmp!sH<H kUp 
D "hhn: 
C'. "h!Jh 
u "lo!)(!l!1 

Saue document as 

lmemo2 

@ Saue TeHt Only 
O Saue Format Info 

=I 

fji'd 

Driue 

Saue 

Cancel 

3 Type the name memo2 in the "Save document as" field. 

4 Be sure that the Save Text Only radio button is selected. 

If you had used any of the formatting options (described later in this chapter), you could 
have saved them in a separate file by selecting Save Format Info. The document would 
then be saved in two files, memo2 and %memo2. The second of these, the resource 
fork, would preserve the formatting information. However, since you haven't used the 
formatting options, it isn't necessary to create an extra file. 
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5 Click Save. 

The memo is saved as a file with the filename memo2. 

The other Save commands work as follows: 

• Save: If the file in the active window already has a filename, the Save command 
automatically saves it under its current name, without closing it. The original version 
of the file of that name is overwritten in the process. This menu item is dimmed (and 
therefore cannot be used) if the file hasn't been modified since it was last saved. 

• Save As: In addition to using this command to name a new file (as you have just 
done), you can use it while working on a file that already has a name. This lets you 
save an edited file under a new name, leaving the original intact. The file that you 
originally opened remains unchanged, just as it was when last saved. 

• Save a Copy: This command saves the file, in its current state, under a new filename. 
You can then continue editing the original file. 

• Revert to Saved: Use the Revert to Saved command to throw away any changes you 
have made since you last saved the document. This command is dimmed if the 
document has not been modified since it was last saved. 

Editing an existing document 
The following tutorials show how to edit or rewrite a document file that already exists. 

Opening the file 

Suppose you want to edit a text file that already exists. If TextEditor is running, you can 
open the file for editing by choosing Open in the File menu. This allows you to open any 
text-only file, regardless of what application was used to create the file. 

If you are in the Finder, and if TextEditor is your default text editor, you need only 
double-dick the icon of the file to be edited (or click it once to select it and choose 
Open in the File menu). TextEditor starts running and the file you have clicked is 
opened for editing. 
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If TextEditor is not still running, follow these steps: 

1 Open the start folder if it is not already open. 

2 Double-click the memo 1 file icon. 

The memol file is opened and the document is displayed. You are ready to alter this 
document and save it under a new name. 

If you have not quit TextEditor since the last tutorial, it is still running and you are 
working in the start folder. Be sure that you are logged in as start and are working 
in the start folder, which contains all the tutorial material. 

Follow these steps: 

1 Choose Open in the File menu. 

A dialog box appears: 

le start I 
lllUllD!I• mm 
D •cshrc 
CJ •EHamplsBackUp 
D •kshrc 
D •login 
CJ •logout 
D •profile 
D letterl 
D memol 

D Open read only 

2 Double click memo 1. 

I 
=I 

Driue 

Open 

cancel 

The document appears in a window and is ready for editing. 

+ Note You can open a file to which you have read permission but not write 
permission. To do this, be sure that you have selected "Open read only" (at the bottom 
of the Open dialog box). If you open a document to which you do not have write 
permission, a lock icon appears at the bottom right of the window, as in Figure 6-1. You 
can read the document but you cannot change it. + 
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D /•auH prefs 
lsess i on type : mac32 

oo<:i L JYY>Y>Y>Y>Y>Y>YH>Y>>Y>Y>Y>::::mm:m:m:m:mm:mm:m:I ¢ QJ 
I 

Write permission denied 

Figure 6-1 A read-only document 

Deleting and rewriting text 

Examine the beginning of the document on your screen. Notice the sentence that begins 
halfway through the second line of the first paragraph of memol ("Every salesperson 
who's ... "). 

1 Use your mouse to highlight the phrase Every sales person who's; this is 
now the selected text. 

Place the blinking cursor just before the word Every and hold down the mouse button 
while moving the mouse. Drag the cursor just past the word who's; then release the 
mouse button. 

2 When the phrase is selected, type the following: 

The salespeople who have 

The selected text disappears as soon as you begin to type. This is the fastest way to 
replace a block of text. It saves you the trouble of first deleting text and then typing the 
new text. 

3 Follow the same steps to select the letter s at the end of the word knows in 
the next line; then press Delete to delete the letter. 
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Copying and pasting between documents 

Next, you will add the entire memo you have just edited to the bottom of a business 
letter. The letter is in the start folder, in the file letterl. 

First select the material to be copied, as follows: 

1 With the window that contains memo 1 displayed, choose Select All in the Edit 
menu. 

This highlights the entire document. 

2 Choose Copy in the Edit menu. 

The selected text (in this case, the entire memo) is saved on the Clipboard. 

3 Choose Open in the File menu. 

This displays a list of all the files in the start folder. See Figure 6-10. 

Now prepare the document that is to receive the copied text, as follows: 

1 Double-click letterl. 

2 Scroll to the end of the letter (drag down the scroll box at the right of the 
screen). 

3 Place the insertion point at the end of the signature and press RETuRN twice to 
start a new paragraph; then choose Shift Left in the Edit menu to move the 
insertion point to the left margin. 

4 Type the following PS: 

PS: To give you a clear idea of our level of commitment to 

customer support, I'm appending a memo I recently sent to 

my staff. 
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5 Press RETIJRN twice to skip two lines, then choose Paste from the 
Edit menu. 

All of the copied text appears at the insertion point. 

Since other users use these tutorials, don't save the changes. 

1 Choose Revert to Saved in the File menu. 

The Revert to Saved command causes all changes to the document to be removed. A 
dialog box appears. 

Do you really want to discard changes to 
"/users/start/letterl" 

f( OK )J 

2 ClickOK. 

Cancel 

3 Click the close box of the window (the small square at the upper left· of the 
window). 

The window that contains memo 1 is still displayed. 

Close it without saving the changes, as follows: 

• Choose Close from the File menu. This is the same as clicking the close box. 

Finding and changing text 

One of the most important time-saving features of a text editor is its ability to search 
through a document for a specific word, phrase, or string of characters and to change it 
automatically. 
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Finding text 

To find a word, phrase, or character string, follow these steps: 

1 Open the start folder and double-click the memol icon to open the 
document. 

2 Choose Find in the Find menu. 

A dialog box appears. 

Find what string? 

0 Literal 
® Entire Word 

([ Find )J 

181 Case Sensitiue 
D Search Backwards 
D Wrap-Hround Search 

Cancel 

3 Click the Entire Word button and the Case Sensitive button. 

Click the Entire Word button to tell the system to find the item only when it is an 
independent word (that is, when it is not part of another word). You would click Literal 
instead of Entire Word if you wanted to search for a string of characters even when they 
are embedded in another word. Thus, if you click Literal and search for the word it, the 
system finds bit, split, flit, and so on. 

Click the Case Sensitive button to tell the system to search only for words with the same 
uppercase and lowercase letters as the word you indicate. 

4 Type GOOD in "Find what string?" 

5 Click Find. 

Notice that the word GOOD in line 2 is highlighted. 
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The Find dialog box gives you the following options as well: 

• Search Backwards: Searches backward from the current selection to the beginning 
of the file. (Normally, the search moves forward and stops at the end of the file.) 

• Wrap-Around Search: Searches forward from the location of the cursor to the end 
of the file, then starts again at the beginning of the file and continues the search up to 
the starting cursor position. 

+ Hints on using Find You can reverse the direction of a current search operation 
by pressing SHIIT as you select the menu item or by pressing SHIIT as you click OK. For 
example, if you are in the middle of a file and you want to find a string that occurs 
earlier in the document, hold down the SHIFT key as you click Find. The search then 
proceeds backward through the first part of the file. The direction is changed for the 
current search only. • 

Replacing text 

To find a word, phrase, or text string and replace it automatically with a different word, 
phrase, or text string, follow these steps: 

1 Open the start folder; then open memol. 

2 Choose Replace in the Find menu. 

The Replace dialog box appears. 

Find what string? 

Replace with what string? 

O Literal 
@ Entire Word 

ISl Case Sensitiue 
D Search Backwards 
D Wrap-around Search 

(( Replace ) (Replace Rll J Find J ( Cancel 
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3 Click Entire Word and Case Sensitive. 

Click the Entire Word button to tell the system to find the item only when it is an 
independent word (that is, when it is not part of another word). You would click Literal 
instead of Entire Word if you wanted to search for a string of characters even when they 
are embedded in another word. Thus, if you click Literal and search for the word it, the 
system finds bit, split, flit, and so on. 

Click the Case Sensitive button to tell the system to search only for words with the same 
uppercase and lowercase letters as the word you indicate. 

4 Type GOOD in "Find what string?" 

5 Type excellent in the field labeled "Replace with what string?" 

6 Click Find. 

Notice that the word GOOD in line 2 is highlighted. 

7 Click Replace (or press RETURN). 

The word GOOD is replaced by the word excellent. The next occurrence of GOOD 

is then highlighted, allowing you to repeat the operation. 

To skip this occurrence of the word without changing it, click Find. TextEditor leaves the 
highlighted word unchanged and searches for its next occurrence. 

The Replace dialog box gives you the following options as well: 

Replace All: Changes all occurrences of the word GOOD (or whatever string you 
indicate) automatically. 

Cancel: Removes the dialog box. No further action is taken. 

Search Backwards: Searches backward from the current selection to the beginning of 
the file. (Normally, the search moves forward and stops at the end of the file.) 

Wrap-Around Search: Searches forward from the location of the cursor to the end of 
file, then starts again at the beginning of the file and continues the search up to the 
starting cursor position. 
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Formatting and other features 

If you use any formatting features, you can save the formatting information by selecting 
Save Formatting Information in the Save As dialog box. This causes an extra file to be 
saved (the resource fork), which contains the formatting information. 

The Edit menu and the Window menu make the following formatting features available 
to you: 

• Selecting fonts (for screen display and for printing) 

• Selecting tab settings 

• Automatically aligning text with the previous line (Auto Indent) 

• Showing invisible characters, such as tabs, spaces, and returns 

• Shifting a block of text left or right by one tab stop 

• Aligning selected text with the top line of the selection 

• Arranging multiple windows to be stacked one over the other or tiled (placed 
alongside one another) 

• Marking a place in the file 

The following sections explain how to use these features. 

Selecting fonts 

To change fonts, follow these directions: 

1 Choose Format in the Edit menu. 

The Format dialog box appears. 
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2 Select the desired font and size. 

Font 

[hicago 
rourier 
Geneua 
Heluetica 

I • I 

Times 

3 ClickOK. 

Selecting tab settings 

To change tab settings, follow these steps: 

1 Choose Format in the Edit menu. 

The Format dialog box appears. 

2 To change the tab setting, type the desired number of spaces in the Tabs field. 

=-------------l'~·.,_1 
~ H~~:H.~~~t~e ~} . 
l!l'"'~'IW'f:r~~"'&'lo..~~ 
/>l~(ll,\~ .. l..~~~~~~~~ 
~ ·nrn>.~s ~ 

i .................................................................. J;_:j 

3 ClickOK. 

~:;;::l 

l_Jj 
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Automatically aligning text 

Auto Indent aligns a selected block of text or a line with the previous line. To turn Auto 
Indent on, follow these steps: 

1 Choose Format in the Edit menu. 

The Format dialog box appears. 

2 Click the check box so that Auto Indent is selected. 

~ .. Th~~:~~S~G ······················-··-·········-·····-~ :_;:_1 t~.\ 

~ f DUrk~r 
. mw. 
:~---

You can click it again to deselect it, thus turning Auto Indent off. 

3 ClickOK. 

Showing invisible characters 

Spaces, tabs, returns, and control characters don't appear on your screen unless you 
click Show Invisibles. Follow these steps: 

1 Choose Format in the Edit menu. 

The Format dialog box appears. 

2 Click the check box so that Show Invisibles is selected. 

You can click it again to deselect it, thus hiding the invisible characters. 

6-20 Chapter 6 Writing with TextEditor 



fT::·;;;~;;~;: ........................................... l.:;;:;:,: l~! 
~ ~~~:--n~~~n~ 
~ H~~~t::~~~~{~~ j 

D Show lnuisibles 

! ~H>~·~; [ 4 ! 
t ........ ! 

~ 1 ~ff~~:,:; ! 
~ j 

~ ................................... J~:r L. ....... k~J 

3 ClickOK. 

When you choose Show Invisibles, the invisible characters are displayed as follows: 

~ tab 

0 space 

• return 

all other control characters 

Shifting a block of text left or right 

To shift an entire block of text one tab stop to the left (or the right), follow these steps: 

1 Select the block of text. 

2 Choose Shift Left (or Shift Right) in the Edit menu. 

Aligning text with the top line of text 

To align a block of text with the top line of the selection, follow these directions: 

1 Select the block of text. 

2 Choose Align in the Edit menu. 
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Arranging multiple windows 

If you are editing several documents at once, you have a choice of stacking or tiling the 
windows. The tutorial that follows shows you how to do this. 

Stacking and tiling windows 

To see the difference, follow these steps: 

1 Choose Open in the File menu. 

2 Double-click the memol file in the start folder. 

The document appears in a window and is ready for editing. 

3 Choose Open in the File menu. 

4 Double-click the let terl file. 

The windows are stacked by default, as shown here. 

FROM: 

RE: 

Th er 
GODO 
this 
of t 

/users/stilrt/memo I 

January 11, 1990 

~~~:. ~~~· -c .. 0,, ~'"'·.I about the pr i n ters that arr i ved damaged . We i ns ti tu ted i!i!H 
investigation immediate I y. We di sc:overed that an unusua mm 
thaw caused flooding at a major warehouse in the midwest 11i~H 
have es tab I i shed that the f I ood damaged some I oad i ng equ i!i!ii 
that was being used to stack cartons stored in that 
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To tile the windows, follow this step: 

• Choose Tile Windows in the Window menu. 

The windows are laid out alongside one another. Note that the sizes of the windows 
change so that they can fit on the screen. 

/users/start/memol 
I 
12/20/89 

TO: Sales Representatives 
Customer Support Representatives 

FROM: A. Greening 

RE: Custom er comp I a i n ts 

There are two reasons for our amazing growth in the past few years: 
GOOO PRODUCTS and GOOD SUPPORT. Every salesperson who's been with 
this company for more than a few weeks knows that a healthy portion 
of their comissions are earned from repeat business and that our 

t!L 

reputation has made getting new customers relatively easy. -Qi-
¢ r T!!!!!!!!!!i!!!!!i!!!!!i!!!i!!!!!!!!!i!!!!!i!!!i!!!i!!!!!i!!!!!!!i!!!i!!!!!i!!!i!!!i!!!!!!!!!!!!!!!i!!!!!i!!!!!!!!!!!!!!!!!HI:!!!!H!i!!!l!i!!!Hi!]!Hi!i!!m!!I!f!i!!!H!H!!!i!lf ¢ 121 

Rlpha Pub I ishing 
Ra I ph Jones, D i rec tor 
Purchasing Department 
1343 Grove Avenue 
Brooklyn, N.Y. 11218 

Dear Mr. Jones: 

/users/startlletterl 

January 11, 1990 

Ellen Grant, our Product Support manager, told me this morning 
about the printers that arrived damaged. I-le instituted an 
investigation immediately. We discovered that an unusual early 

Tiling makes it easy to work with several windows at once. To use this feature most 
effectively, however, it's best to have a large monitor. On a small monitor, the windows 
might become too small. 

Important When a window becomes too small, the text in the window disappears and 
you can no longer work with it. To work with it, you must reopen the file in a larger 
window. 
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To return the windows to a stacked layout, do as follows: 

• Choose Stack Windows in the Window menu. 

The windows are now stacked. 

T1201:2or..1_=eg9~~~~~G~~~~0!ill~~~~~I~l~~ ~ /users/start/letter I E!lfl! 
Q 

/users/start/memo I J 

FROM: 

RE: 

There 
GOOD 
this 
of th 
reput 

I Som~ 

'---

January 11 , 1990 

~~~~~~~., , .... 0, -~~~. ,,,,, •• .,, •• I 
about the pr i n ters that arr i ved damaged . We i ns t i tu ted mm 
investigation immediately. We discovered that an unusua 111m 
thaw caused f I ood i ng at a major warehouse in the mi dwest mm 
have es tab I i shed that the f I ood damaged some I oad i ng equ '!if 
that was being used to stack cartons stored in that ~ 

Marking a place in the file 

If you need to return periodically to specific locations in a long or complex document, 
you can place invisible named markers at those points. You can then jump instantly to 
any of the marked places in the document. This saves you the time and trouble of having 
to scroll through the document to find those places. 

The following tutorial teaches you how to mark and unmark a document. The 
tutorial uses letterl (in the start folder) as a sample document, although 
marking is most useful in long, complex files. 

To place two named markers in let terl, the first at the beginning of the second 
paragraph ("We have instructed ... ")and the second at the beginning of the third 
paragraph ("Let me apologize ... "),follow these steps: 
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1 Highlight the word "We" at the beginning of the second paragraph. 

/users/start/letterl 

Alpha Publishing 
Ra I ph Jones 1 D i rec tor 
Purchasing Department 
1343 Grove Avenue 
Brooklyn, N.Y. 11218 

Dear Mr. Jones: 

January 11 , 1990 

Ellen Grant, our Product Support manager, told me this morning 
about the printers that arrived damaged. We instituted an 
investigation immediately. We discovered that an unusual early 
thaw caused flooding at a major warehouse in the midwest. We 
have established that the flood damaged some loading equipment 
that was being used to stack cartons stored in that 
warehouse overnight for transshipment. This faulty equipment, in 
turn, put abnormal stress on the packing, which resulted in the 
damage you reported. 

!ml have i ns true led our New York sa I es off i ce to remove the damaged 
equipment from your premises and to instal I new equipment as soon as 
i t arr i ves . We w i I I a i r express dup I i ca le equ i pm en t to you tomorrow 
afternoon. 

Let me apologize to you for this mishap. 
has not caused you any serious problem. 

2 Choose Mark in the Mark menu. 

A dialog box appears. 

Mark the selection with what name? 

I hope that the delay 

The text box contains the highlighted word, which you will use as the name of the 
marker. If you want to give the marker a different name, type it in the text box. 
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3 ClickOK. 

You have named the first marker We. 

4 Place the insertion point at the beginning of the third paragraph 
of letterl. 

5 Choose Mark in the Mark menu again. 

6 Type the numeral 2 . That is the name of the second marker. 

Mark the selection with what name? 

¢ OK , ( Cancel ) 

7 ClickOK. 

Now display the Mark menu. It contains a list of the invisible named markers that you 
have placed in the document. 

Mark ... ll€M 
Unmark ... 

We 
2 

Choose We. The insertion point moves to the We marker. Choose 2 and the insertion 
point moves to the third paragraph. 

To remove these markers, follow these steps: 

6-26 Chapter 6 Writing with TextEditor 



Printing 

1 Choose Unmark in the Mark menu. 

A dialog box appears. 

Delete which markers? 

( Delete ] Cancel J 

2 Highlight the name of the marker you want to remove. Select marker 2. 

3 Click Delete. 

If you look at the Mark menu, you can see that the marker you have deleted is no longer 
on the list. 

TextEditor allows you either to print an entire document or a selection from a document. 
Be sure that your computer is properly connected to a printer and that you use the 
Chooser (in the Apple menu) to choose a printer. For information on printer 
connections, see Chapter 7, "Printing." 

Printing an entire document 

To print an entire document, follow these steps: 

1 Open the document in TextEditor. 
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2 Choose Print Window in the File menu. 

You see the Print dialog box. 

Job 
LaserWriter "Uan Horn" 7.o Print 

Copies:llMI Pages: ® Rll 0 From:~ To: ~ [ Cancel ) 

Couer Page: ®No O First Page O Last Page 

Paper Source:® Paper Cassette O Manual Feed 

Print: ®Black & White O Color/Grayscale 

Destination: @Printer O Postscript® File 

3 Click Print to begin printing. 

Printing a selection of a document 

To print a selection of the document, first select a block of text, as follows: 

1 Place the insertion point at the beginning of the desired selection. 

2 Hold down the mouse button and drag to the end of the desired selection. 

The selected text is highlighted. 

D /users/start/memo 1 

12/20/89 

TO ; Sa I es Represen tat i ves 
Customer Support Represen tat i ves 

FROM : A . Green i ng 

RE : Customer comp I a i n ts 

There m e t1110 t ec:i.=ot 1:: f ot 01 • .w .::1 

GOOD F F:OOUC r::. and (,(i(l[I ·:.UF'F'OF:T 

Sometimes things do go wrong cmd a customer gets hurt. When that 
happens~ our po I i cy i s to g i ve the customer the bene f i t of the 
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3 Choose Print Selection in the File menu. 

The Print dialog box appears, as shown at the top of page 6-28. 

4 Click OK to start printing. 

Quitting TextEditor 

To quit TextEditor to perform other tasks or to free memory for other programs, do 
as follows: 

• Choose Quit from the File menu. 

If you have made changes to a file, you see a Save Before Quitting dialog box, which 
asks you whether you want to save those changes. 

Saue changes to /users/start/letter! 

( Don't Saue ) (( Saue JJ [ Cancel 

Click Save to save, click Don't Save to quit without saving, or click Cancel to cancel the 
Quit command. 

To save the document as text-only file, click Save Text Only in the Save As dialog box. 
To save a resource fork file with formatting information (in addition to the text file), click 
Save Format Information. 
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7 Printing 

This chapter discusses printing with the Macintosh interface and printing with the 

UNIX lpr command. It contains the following sections: 

• Understanding printing 

• Choosing a printer 

• Printing the Macintosh way 

• Printing with lpr 

• Printing the contents of a CommandShell window 

You can read this chapter in its entirety or go directly to those sections that are of use 

to you. 



Understanding printing 

A/UX provides several printing utilities that print files created by a text editor (such as 
vi or TextEditor), by a word processor, or by other Macintosh or UNIX applications. 

Before you can print a document, you must have a printer properly connected to 
your system or to the network. See Setting Up Accounts and Peripherals for A!UX for 
information on connecting a printer to the computer. For basic information on 
connecting a printer to a network, see A!UX Networking Essentials. 

Printer connections 

You can connect a printer in three basic ways: 

• Connect directly to a printer port on the Macintosh computer. 

A/UX does not support the LaserWriter SC or the Personal LaserWriter SC. 

+ Note A LaserWriter IISC printer that is directly connected to the SCSI port won't 
work with A/UX. • 

• Connect to an AppleTalk network through the LocalTalk cable system or an 
EtherTalk interface card and Ethernet cable. 

Any computer on the network can send files created with a text editor or a Macintosh 
application to the printer. The files are printed in the order in which they are 
received. 

• Connect remote UNIX printer to another A/UX or UNIX computer on a UNIX 
network. Printing is done with the UNIX print commands. 

Any computer on the network can send text files to the printer. The files are printed 
in the order in which they are received. 

Figure 7-1 shows the different printer configurations. 
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Directly connected printer 

Printer connected via an AppleTalk network UNIX text documents 
or Macintosh documents 

Remote printer connected via a UNIX network 

Figure 7-1 Three types of printer connections 
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Choosing a printer 

Before A/UX can print a file, it must know which printer to use. Use the Chooser (in the 
Apple menu) to select a printer. Some applications direct you to choose Page Setup after 
using the Chooser. For further information, see the guide that came with the application 
you are using. 

You can choose any printer that is connected to your network or your computer 
through AppleTalk software and LocalTalk (or LocalTalk-compatible) and EtherTalk 
cables. 

Follow these steps to choose a printer that is connected directly to your computer or is 
on your AppleTalk network: 

1 Choose Chooser from the Apple menu. 

The Chooser dialog box appears. You see an icon representing each of the printer types 
for which you have printer resources installed in the currently active system file. 

D 

ApploShoro 

AppleTalk Zones: 

Accounting 
Customer Support 
Engineering 
Marketing 

.lt. -llQ$Qi@ 

Research and Development 
Sales 
Security 

Chooser 

Select a LeiserWriter: 

Divine Comedy 
El Cid 
Inferno 
Odyssey 
Song of Roland 

Background Printing: @On O Off 

@Active 
AppleTalk 0 Inactive 

7.0 

2 Click the icon representing the type of printer you want to use. 

3 Select the appropriate zone from the AppleTalk Zones list. 

The zone name is highlighted. 
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4 Select the appropriate printer name in the AppleTalk printer list 

The printer name is highlighted. 

5 Click the close box. 

The Chooser dialog box disappears; you are ready to print. 

Printing the Macintosh way 

You can use the Finder to print a Macintosh file from A/UX (for example, one created by 
a third-party application or by TextEditor). You must have either a printer that is directly 
connected to the computer or to an AppleTalk network printer (or one that is compatible 
with AppleTalk software) connected through LocalTalk (or EtherTalk) cables, router, and 
built-in AppleTalk software. 

Follow these steps to print a Macintosh document from the Finder (this is the same as 
printing a document from the Finder in the Macintosh OS.): 

1 Select the document you want to print by clicking its icon. 

2 Choose Print from the File menu. 

You see the Print dialog box. 

Job 

LaserWriter "Uan Horn" 7.o Print 

Copies:llMI Pages: @ Rll 0 From: CJ To: CJ I Cancel J 
Couer Page: @ No O First Page O Last Page 

Paper source:@ Paper Cassette O Manual Feed 

Print: @Black & White O Color/Grayscale 
Destination: @ Printer 0 Postscript® File 

3 Click Print 

You also can print from within a Macintosh application. Consult the manual that came 
with the application for more information on printing. 
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PrintMonitor 

If the system has messages for you regarding a file that you are trying to print from the 
Finder, a flashing icon appears over the Applications menu in the Finder. You can read 
the message and respond as necessary by opening the Applications menu and choosing 
PrintMonitor. 

Printing with 1 pr 

You can use the A/UX lpr (line printer) command to print files created with text 
editors (such as vi or TextEditor). Several sample files exist in the start folder. 
This tutorial uses one of the sample files. 

A/UX spools the files to be printed, that is, it stores them on disk in a printing queue 
until the printer is ready for them. The spooler prints them in the order in which they are 
received. 

Figure 7-2 illustrates the printing queue. 

Figure 7-2 The printing queue 
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+ Note The lpr spooler doesn't fonnat documents. You must use a formatting 
command such as pr or troff to format documents before you send the job to the 
printer. For further information, see troff(l) and A!UX Text-Processing Tools, 
Chapter 2, "troff /nun Tutorial."+ 

Sending a file to a printer connected directly or 
through AppleTalk 

To practice using the lpr command to print on a printer that is connected to your 
computer directly or through an AppleTalk network, follow these steps: 

1 Log in to the start account. 

2 Use the Chooser to select the printer. 

3 Choose CommandShell in the Applications menu. 

4 Enter 

lpr -Piw letterl 

This command sends the file let terl to the printer. 

Sending a file to a remote UNIX printer 

To practice using the lpr command to print on a printer connected to another UNIX 
system, follow these steps: 

1 Besurethatyour /etc/printcap fileissetup. 

For information on setting it up, see A/UX Local System Administration. 

2 Log in to the start account. 
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3 Choose CommandShell from the Applications menu. 

4 Enter 

lpr -P printername letterl 

Replace the italicized word with the name of the printer that you want to use. This 
command sends the file letterl to the printer. 

Finding out how many files are waiting in the 
printing queue 

A/UX spools printing jobs, placing them in a queue. The printer handles them on a first­
come, first-served basis. If you share your printer and there are other jobs ahead of 
yours, those jobs are printed first. Your file is printed when your tum comes. 

• To display a list of the print jobs in the printing queue, enter the command 

lpq 

A list appears that looks something this: 

Rank Owner Job 

active jms 3 

1st pzp 4 

2nd alp 5 

Files 

filename 
filename 
filename 

Total size 

720 bytes 

1500 bytes 

2451 bytes 

The first column shows the rank, the second shows the owner of the file sent to the 
printer, the third shows the identification number of the print job, the fourth column 
shows the filename (including its path), and the last column shows the size of the file. 

Canceling a printing job 

To cancel a printing job before it's completed but after you've sent it to the printer, use 
the lprm command with the ID number of the printing job. 
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• Enter 
lprm ID-number 

Substitute the ID number of the printing job (such as lpr 3 9 s) for ID-number. The ID 
number is in the third column (labeled Job) in the list of printer jobs shown in the 
previous section. 

The following message appears as A/UX cancels the job: 

ID-number dequeued 

For more information about the lpr command, see lpr(l) in A!UX Command 
Reference. 

Printing the contents of a CommandShell window 

If you have a printer connected to your computer directly or through an AppleTalk 
network, you can print a selection from a CommandShell window. 

If you have a selection of text in your CommandShell window (for instance, a series 
of commands that you want to save in hard copy), print the selection as follows: 

1 Click and drag to select the text you want to print 

The text appears highlighted. 

2 Choose Print Selection from the File menu. 

The Print dialog box appears. 

Job 

LaserWriter "Uan Horn" 1.0 n. Print ] 

Copies:llMI Pages: @ Rll O From: [==1 To: [==1 ( Cancel ) 

Couer Page: @ No O First Page O Last Page 

Paper Source:@ Paper Cassette O Manual Feed 

Print: @Black & White O Color/Grayscale 

Destination: @ Printer O Postscript® File 
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3 Click OK to print or click Cancel to cancel the printing command. 

To set printing specifications for the selection, use the Page Setup command in the File 
menu. See the owner's guide that came with your computer for more information on 
Page Setup. 
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8 Customizing Your Work 
Environment 

This chapter describes features you can customize that work differently in A/UX than in 

the Macintosh OS or that are specific to A/UX. It contains the following sections: 

• Changing your session type 

• Changing your password 

• Your personal System Folder 

• Adding application programs 

• Changing shells 

• Changing the default text editor 

• Changing the time zone 

• Displaying and hiding dot files 

• Macintosh customization features that are disabled in A/UX 



Changing your session type 

When you choose Change Session Type in the Options menu (with the Login dialog box 
displayed), you see the dialog box shown in Figure 8-1. 

Change Session Type 

Name: start Password: II I 
llJllt:• :rnJ I '1Wli1'..i::::I I U1J 

v;: ( Cancel l [I,! 

A/UH Finder (24-bit) I--' 
Console Emulator ( Euery Session ) 

kE ( This Session Only JJ 

A/UH Finder (32-bit) is the normal session type. Macintosh 
applications that are not 32-bit clean will not run properly 
in this mode. 

Figure 8-1 The Change Session Type dialog box 

A/UX is shipped with the following options: 

• X-11 (Not shown in Figure 8-1): This makes the X-11 graphical interface available to 
you if it has been installed during the A/UX installation process. If you have installed 
A/UX on a disk with a capacity of less than 160 megabytes, X-11 is not installed and 
does not appear in the dialog box. 

• A/UX Finder (32-bit): This is the default setting. For a description of this option, see 
the next section,"32-Bit Address Versus 24-bit Address." 

• A/UX Finder (24-bit): For a description of this option, see the next section, "32-Bit 
Address Versus 24-bit Address." 

• Console Emulator: This session type allows you to work in the command-line 
interface only. No Finder appears. This feature is meant primarily for debugging 
purposes and to correct system problems. For more information, see "Using the 
A/UX System Console" in Chapter 3, "Using CommandShell." 
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32-bit address versus 24-bit address 

When you use A/UX with Macintosh files and with software created for the Macintosh 
computer, you might run into trouble with programs created for earlier versions of the 
Macintosh computer. The reason is that two kinds of Macintosh applications run in 
A/UX: 24-bit addressed applications and 32-bit addressed applications. The latter are 
often called 32-bit clean. These terms refer to the way the application uses memory. 

By default, A/UX is set to run in 32-bit addressing mode, which can run applications 
that are 32-bit clean. If you need to change the setting, do so before you log in. See the 
procedure described below. 

6 Important When you run applications in 24-bit addressing mode, you don't have 
access to the entire Macintosh environment that exists in 32-bit addressing mode. Tum 
on 24-bit addressing mode only when it's necessary. e, 

Unfortunately, it's not easy to tell what software will run in 32-bit addressing mode 
until you try to run it. If the software doesn't work properly, try setting the login mode to 
24-bit addressed, as follows: 

1 Choose Logout in the Special menu under the A/UX Finder. 

After a short wait, the Login dialog box appears. 

2 Type your login name in the appropriate text box. 

3 Choose Change Session Type in the Options menu. 

You see the dialog box shown in Figure 8-1. 

4 Type your login name and password in the appropriate fields. 

5 Choose A/UX Finder (24-Bit). 
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6 Click This Session Only. 

If you want to use this session type whenever you log in, click Every Session. 

The Login dialog box reappears. Note that the password, which you entered into the 
Change Session Type dialog box, is transferred to the Login dialog box. 

7 Complete the login process. 

You can also change the session type by turning 32-bit addressing on or off in the 
Memory control panel. Do this as follows: 

a. Choose Control Panels in the Apple menu. 

b. Double-click the Memory icon to open the Memory control panel. 

«fh 
8 

Disk Caohe< 
Always On 

Virtua 1 Memory 
Always On 

32-Bit Addressing 

@on 
Qott 

Memory 

Cache Size 

Av ail ab l• bui11-in momory : BM 

!ID 

( Use Defaults ) 

c. In the 32-Bit Addressing field, dick the On button to select 32-bit addressing; dick 
the Off button to select 24-bit addressing. 

d. Click the dose box to dose the control panel. 

The change of session type takes effect the next time you log in. 
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Changing your password 

It's important to change your password often to prevent others from discovering the 
password and logging in to your account. Use a password that you can remember 
without writing it down. Don't use a password that is easy to deduce, such as your name 
spelled backward, your computer login name in capital letters, or the name of a family 
member. 

Display the Login dialog box. If you are already logged in, you must choose Logout 
in the Finder's Special menu to display the Login dialog box. Follow these steps to 
change your password: 

1 Choose Change Password from the Options menu. 

The Change Password dialog box appears. 

It lists the special restrictions that apply to the characters you can use in a password. If 
your system administrator overrides these requirements, a description of them does not 
appear in the dialog box. 

2 Enter your login name. 

3 Enter your old password. 

4 Enter your new password. 

Another dialog box directs you to confirm your new password. 

5 Enter your new password again. 

The Login dialog box reappears with the Name and Password fields filled in. Thus, you 
can use the Options menu again before completing your login, if necessary. 

6 Click the Login button. 

You are logged in to NUX and your new password takes effect. You must enter it the 
next time you log in. 
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Your personal System Folder 

When a user account is created for you, a personal System Folder is normally created at 
the same time; it is placed in your home directory. 

If you do not have a personal System Folder, you can create one as follows: 

1 Choose CommandShell in the Applications menu to activate CommandShell. 

If a CommandShell window does not open, choose Open in the CommandShell File 
menu. 

2 Enter the following: 
systemfolder 

The process of creating a System Folder in your home directory takes place 
automatically. 

Your personal System Folder functions much like the System Folder in the Macintosh 
OS, and is represented by the icon in Figure 8-2. 

(lJ 
Sy :s:to?m F o ldo?r 

Figure 8-2 The personal System Folder icon 

The global System Folder, which is located in I mac I sys, is used by accounts that 
have no personal System Folder. That is, if you open the I folder, then open the mac 

folder, then open the sys folder, you will find the global System Folder. You are 
discouraged from making changes to it unless you are administering the system and 
making changes that are meant to affect all users. 

If you examine the contents of the /mac I sys folder, you will see that it contains 
two other system folders in addition to the one labeled System Folder: they are the 
Startup System Folder and the Login System Folder. 

The items in the Startup System Folder and the Login System Folder control the 
startup and login procedures, respectively. 
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The personal System Folder controls several aspects of your working environment. 
For example, you install fonts for many word-processing applications in the System 
Folder, and all applications that are to appear in your Apple menu are installed in the 
Apple Menu Items folder that is in the System Folder. Other applications that are 
activated when you log in are installed in the Extensions folder that is in the System 
Folder. These are shown in Figure 8-3. 

Apple Menu Items folder 

_o System Folder 
17 items 56 .6 MB in disk 

App le Menu Items Spoo 1 F o Ider 

n 
~ 
Finder 

~ 
ill::::..! 

Preferences 

L@:J (QJ Lill] (ljJ 
PrintMonitor Documents Extensions Startup Items Sy stem 

Extensions folder 

Figure 8-3 An open System Folder 

Adding application programs 

18.2 MB available 

Contro 1 Pane ls: 

Sor apbook File 

When you install an application program on your system, it is recommended that you 
install it in your home directory folder. If you are the system administrator and you install 
an application that is to be used by all users of the system, install it in the /mac /bin 

folder. This folder is automatically read by all user accounts that are set up with the 
adduser command (discussed in Setting Up Accounts and Peripherals for Alm). 

Add the application to the /mac /bin folder as follows: 

1 If the application is on a floppy disk, insert it into the floppy-disk drive and 
double-click its icon to display the files or folders to be transferred. 
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2 Double-click the disk icon labeled with the I to open it. 

3 Locate the mac icon and double-click it to open it. 

4 Locate the bin folder and drag the appropriate files or folders from the 
floppy disk to the bin icon. 

If you want to be able to start the application by double-clicking its icon on the desktop, 
use an alias of its icon as follows: 

• Highlight the icon and choose Make Alias in the File menu. 

You can move the alias icon to the Desktop. You also can move it to the Apple Menu 
Items folder in the System Folder to make it available in the Apple menu. 

Changing shells 
You can change the default shell to the Bourne or the Korn shell by using the chsh 

command. For further information on this command, see chsh(l) in A/UX Command 
Reference. You can change shells temporarily, while you are logged in, as follows: 

• To change to the Korn shell, display a CommandShell window and enter ksh 

• To change to the Bourne shell, display a CommandShell window and enter sh 

• To change to the C shell, display a CommandShell window and enter csh 

The three shells are described in detail in A/UX Shells and Shell Programming. 
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Changing the default text editor 
As shipped, A/UX uses TextEditor as its default text editor. This means that whenever 
you double-dick the icon of a text-only file, TextEditor begins operating, and the text 
appears in a TextEditor window. 

To set a different text editor as the default editor, you need to know where in the file 
system the editor you want is located, that is, you need to know its pathname. For 
information on pathnames, see "UNIX Pathnames," in Chapter 2, "Using Files, Folders, 
and Directories." 

If you are working in the C shell, you can change the default text editor by changing 
an environment variable in the . login file in your home directory folder. If you 
are working in the Korn or the Bourne shell, change the equivalent line in your 
profile file. Notice that the names of these files begin with a dot(.). It is therefore 
called a dot ftle. 

+ Note In A/UX, as in other versions of UNIX, dot files are used to give special 
directions to the system. Whenever you type a dot file's name in a CommandShell 
window, remember to begin the filename with a dot. However, in the A/UX Finder, the 
labels of the dot file icons are preceded by a bullet ( •) instead of a dot. • 

If you are working in the C shell, whenever you log in to your user account, the 
system reads your . login file to create your working environment. If you are 
working in the Korn shell or Bourne shell, it reads your . profile file. 

To change your default text editor, follow these steps: 

1 Make A/UX Finder the active application. 

2 Open your home directory folder. 

3 If you are working in the C shell, double-click the . login ftle icon in your 
home directory to open the ftle. If you are working in the Korn or Bourne 
shell, open the . prof i 1 e ftle. 
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4 If you are using the C shell, add a new line to the end of the . login file as 
follows: 

setenv FINDER_EDITOR edit01pathname 

If you are using the Korn or the Bourne shell, add a new line to the end of the 
. prof i 1 e file, as follows: 

FINDER_EDITOR=editorpathname 

Replace the word in italics with the full pathname of the editor you wish to set as the 
default editor. For example, if the default editor has been changed, you can change it 
back to TextEditor by typing the TextEditor's pathname as the last item on the line. If 
you are using the C shell, add the following line at the end of the . 1 og in file: 
setenv FINDER_EDITOR /rnac/bin/TextEditor 

Note that there is a space before the editor's pathname (/rnac/bin/TextEdi tor, in 
the case ofTextEditor). 

If you are using the Korn shell or the Bourne shell, in the . prof i 1 e file, type the 
following to reset the default editor to TextEditor: 

FINDER_EDITOR=/rnac/bin/TextEditor 

Do not type a space before or after the equal sign. 

5 Save the changed . login (or the . profile) file. 

6 Log out and log in again. When you log in, the system rereads the . login (or 
the . profile) file and provides you with the specified editor. 

To set the default text editor to vi, which is a commonly used UNIX editor, replace 
editorpathname (in Step 4) with the pathname 

/usr/bin/vi 

To set the default text editor to TeachText, replace editorpathname (in Step 4) with 
the pathname 

/rnac/bin/TeachText 
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Changing the time zone 

The clock in your system is set to Pacific Standard Time (PSD by default. If you live in 
another time zone, you need to set the system time. A/UX does not recognize settings 
made with the General Controls control panel or the Alarm Clock desk accessory. 

Follow these steps to set the system time: 

1 Choose CommandShell in the Applications menu (on the far right side of the 
menu bar). 

2 Enter set timezone in the CommandShell window. 

A list of major world regions appears. 

/Useful Commands/settimezone (set timezone) 
Enter the letter corresponding to your region. 

f Africa 
a Australia, New Zealand 
c Canada 
e Europe 
i Ice I and, Caribbean 
x Mexico 
m Middle East 
s South America 
u United States 
w Western Pacific, East Asia 
o Other 

- Cancel 
Enter letter: wl 

3 Enter the letter that corresponds to your region. 

For example, if you live in the United States, type u. If you live in Japan, type w for 
Western Pacific. Another menu appears, listing the time zones within the region. 

Enter the letter corresponding to your lime zone. 
c Peop I es Repub I ic of China 
h Hong Kong 
j Japan 
r Republic of China 
k Repub I i c of Korea 
m Samoa 
s Singapore 

- Re turn to prev i ous menu 
Enter letter: j 

The lime zone has been set lo Japan 
The corresponding date wi 11 be Mon Feb 19 23:08:21 JST 1990 
This change wi 11 take effect the next time you log in. 
•D 
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4 Enter the letter that corresponds to your time zone. 

For example, if you live in Japan, type j for Japan. 

If your time zone isn't listed, type o for the Other option, which lets you select your 
time zone relative to Greenwich Mean Time (GMD. For details on this method, see 
"Setting the System Time" in the AIU¥ Installation Guide. 

After you enter the time zone, a message appears, confirming the setting. 

5 Type date. 

The date command should now display the proper date and time. If it does not, 
repeat the settimezone procedure. Make sure you choose the correct time zone 
and give the correct time and date. 

Displaying and hiding dot files 

The files whose filenames begin with a dot (. ), the so-called dot files, are normally not 
displayed when you run the 1 s command in CommandShell to list the contents of a 
folder. They are therefore called hidden ftles. However, when you open a folder in the 
Finder, they are displayed (with a bullet in place of the dot) by default. 

The following sections tell you how to display the hidden files in CommandShell and 
how to hide them in the Finder. 

Displaying hidden files in CommandShell 

To display the hidden files when you list the contents of a folder with the 1 s 

command, use the - a option. 

• Enter the command as follows: 

ls -a name 

In place of name, use the name of the directory whose contents you are displaying. For 
further information on the 1 s command, see Chapter 4, "Using UNIX Commands and 
Commando." 
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Hiding dot files in the Finder 

By default, the dot files are displayed in the Finder. The st art folder appears. 

_o start 0 
10 items 51 Kin disk 43 .8 MB available 

i i i i i CJ 
~ 

•Examp lsBackUp •cshrc •kshrc: •login •logout •mac: 

i i i ~ 
•profile letterl memo1 setup 

You can choose not to display the dot files in the Finder as follows: 

1 Choose Control Panels in the Apple menu. 

D 
18 items 

~ 

~ 
Color 

~ 
~ 

je-ner a 1 Controls Key board 

. -Monitors Mouse 

~ 

Control Panels 
52.4 MB in disk 22 .5 MB av ail ab le 

[Ii] [£] ii 
Easy Access Memory File Sharing Monitor 

~ !J 
Labels Mac TCP Map 

[U] ~ ~ 
Network Sharing Setup Sound 

OOi HJ 
Startup Disk Users & Groups Views 1-=1 

¢ Jittt!!!tti!!!i!!i!!!!!!!i!]?i!t]!i!i!i!i!i!i!Hi!i!i!it!~iim!i!i!ii!Hi!i!i!i]!i!!!!tt!i!Hi!!!i!!H!!!i[ l ¢ ~ 
The Views control panel icon __/ 
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2 
~ 

Double-click the Views control panel icon. 

The Views dialog box appears. 

Uiews 
, .... A 11 Views ................................................................................................................................. , 

! Foot for views: I Geneua ..-1 IEll6 ! 
! 181 Show hidden UNIX files (for example, •login) ! 
! ............................................................................................................................................................ J 
~····loon Views ............................................................................................................................... : 

! D D D D @straight grid ! 
i D Always soap to grid i 
j D D D D Q Staggered grid j 
t ............................................................................................................................................................ l 
····List Views ............................................................................................................................... , 

qi <#I D 181 Show size 
~ 181 Show kind 

® 0 0 181 Show label 

0 Calculate folder sizes 

D Sho'vl dts:k info in t.eadeir 

181 Show date 

D Show version 

D Show comments 

3 Click the check box "Show hidden UNIX files" to tum it off. 

After you close this dialog box, the start folder displays no dot files. 

~D start E!];; 
3 iteims 51K in disk 43 .8 MB available 

~ 

i i ~ 
letter1 memo1 setup 

~ 
¢1 1¢ Q] 

You can redisplay the dot files by repeating the steps listed above to recheck "Show 
hidden UNIX files." 
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Macintosh customization features tliat are 
disabled in A/UX 

Most of the customization features in the Macintosh OS that are available to A/UX users 
work just as they do under the Macintosh OS and are therefore not described in this 
guide. The following sections describe Macintosh customization features that are 
diasabled in A/UX. 

Virtual memory 

In the Macintosh OS, the Memory control panel allows you to turn virtual memory on 
and off. A/UX does not permit this. Virtual memory is always on. The Memory control 
panel, which appears after you double-click the Memory icon in the Control Panels 
folder (under the Apple menu), indicates this, as is shown in Figure 8-4. 

D 

Disk Cache 
Always On 

Vidua l Memory 
Always On 

32-Bit Addr-essing 

@on 
Qoff 

Memory 

Cache Size 

Av ail ab le built-in memory : SM 

~ 

[ Use Defaults ) 

Figure 8-4 The Memory control panel 
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Key repeating 

In the Macintosh OS, the Keyboard control panel (found in Control Panels, under the 
Apple menu; see Figure 8-5) allows you to change the key repeat rate and the delay until 
repeat. These options are disabled in A/UX. 

!i!O Keyboard 

Koy Repeat Rate Do lay Until Repeat 

000@0 0 0@00 
Slow Fast Off Long Short 

Koy board Lay out 

1§;1 Svensk ~ -I'·--<>· l§;!Vlaams (AZERTV 0,0) 
l§;!Vlaams (AZERTV 0.0) 

Macintosh and Macintosh Plus Koy boards 

r ... ·j·~~;;;;~·j ..... ! I ~;;w.'*;'1 I 
j Domi:-stio ~ lntern.ationa 1 
; .................•........... ; 

Figure 8-5 The Keyboard control panel 
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9 A/UX Reference 

This chapter provides a quick reference for the menu commands that you encounter 

while working in the Finder environment, the CommandShell environment, the terminal 

emulator, and the TextEditor application. This chapter describes the function of each 

command in the order in which they appear in each menu. 

This chapter contains these sections: 

• The Finder environment 

• The CommandShell environment 

• Terminal emulation 

• The TextEditor application 



The Finder environment 

This section describes the commands to which you have access when you are working 
in the Finder. The Finder is an application that allows you to have more than one 
application open and running at the same time. The Finder also grants you easy access 
to all of the files, applications, and utilities on your system. 

The Apple menu 

The Apple menu contains the list of available desk accessories and information items 
identifying versions of software and their developers. Figure 9-1 shows a sample Apple 
menu. Your Apple menu contains the desk accesrnries that you have installed on your 
system. 

Rbout This Macintosh ... 

\'.b Rlarm flock 
filill Calculator 
t;g Chooser 
g CommandShell alias 
(±] Control Panels 
(@)Key Caps 
b:J Note Pad 
~Puzzle 
m Scrapbook 

Figure 9-1 The Apple menu 

About This Macintosh 

This command identifies the hardware and system software you are using and presents 
various items of information regarding the allocation of memory. When you change to 
another application, this command becomes "About application name ... " and displays 
proprietary information about the active application. Figure 9-2 shows the About This 
Macintosh dialog box. The system software you are using is shown beside System 
Software. 
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D Rbout This Macintosh E!l 

System Softwar-e 
!·--!Macintosh II © Apple Compuler, Inc. 1983-1992 

Total M"morg: 5,120K Largest Unused Block : 2,563K 

!JI Command She 11 384K ~ ,Q 
~ System Software 2,140K 

-0 
~ 

Figure 9-2 About This Macintosh dialog box 

Desk accessories 

Desk accessories are like mini-applications that you can use while you're working in the 
Finder or another application. Several desk accessories-Alarm Clock, Calculator, 
Chooser, Control Panels, Key Caps, Note Pad, Puzzle, and Scrapbook-are shipped with 
your computer. You can add others by placing them in the Apple Menu Items folder that 
is in your System Folder. See the guide that came with your Macintosh computer for 
information about these desk accessories. 

The File menu 

The File menu, shown on the left in Figure 9-3, contains the commands that manage 
your desktop environment. If you hold down the OPTION key while displaying the File 
menu, the OPTION-File menu appears, which is shown on the right in Figure 9-3 . The 
only differences are that the Close command in the File menu is replaced by Close All in 
the OPTION-File menu and the Sharing command of the File menu is missing from the 
OPTION-File menu. 
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New Folder OON New Folder OON 
Open 000 Open 000 
Print OOP Prin\ :..;p 
Close Window oow Close Rll oow 

······································· 
Get Info 001 Get Info 001 
Sil<ffin!J '" UNIH Permissions ... 
UNIH Permissions ... hi/kid(1 :oi:n 
Duplicate 000 Make Rlias 
Make Rlias Put Rway OOY 
FH\ !i!mq : .. ;v ································ 

Find ... OOF 
Find ... OOF Find Rgain OOG 
Find Rgain OOG 

Page Setup ... 
Page Setup ... Print Window ... 
Print Window ... 

Figure 9-3 The File menu (on the left) and the OPTION-File menu (on 
the right) 

New Folder 

This command creates a new folder, also called a directory, in the active window. Each 
new folder is created with the name Empty Folder. You can immediately change the 
name of the folder by typing a new name while the title is still selected. The Command­
key equivalent is CoMMAND-N. 

Open 

This command opens the selected item in the Finder. This can be a folder, an 
application, or a file. The Command-key equivalent is COMMAND-0. 

Print 

This command prints whatever item is selected in the Finder. The Command-key 
equivalent is Command-P. 

Close Window 

This command closes the active window. The Command-key equivalent is CoMMAND-W. 
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Close All 

To choose this, display the Finder menu with the OPTION key held down. The Close All 
command closes all open windows on the desktop. 

Get Info 

This command displays a window that contains file information about the currently 
selected item. Figure 9-4 shows the Get Info window for the letterl file in the 
start folder. 

§0 letter! Info 

Iii letter! 

Kind: document 
Siz" : 2K on disk ( 1 ,289 by \es used) 

Yhere: I: st.ad: 

Cr..at"d: Thu, S•p 5, 1991, 2 :06 PM 
Modifi"d: Thu, Sep 5, 1991 , 2 :06 PM 
Version : n I a 

Comments: 

0Locbd D Station.,rg pad 

Figure 9-4 The Get Info window 

The Get Info window reports the kind of file, its size, its location, its creation date, 
the date the file was last modified, and the version of the application that was used to 
create the file. The window also contains a text field in which you can enter and store 
comments about the file. It is useful to store such information as the version of the file, 
other files related to this one, or the version of the application, if it's not reported by the 
application. The Command-key equivalent is COMMAND-I. 
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Sharing 

This command allows you to specify the Macintosh file-sharing permissions for the 
folder that is highlighted when you display the Sharing dialog box (as shown in 
Figure 9-5). 

•mac 

LJ'l'he..-e: 

Connected As: 

I: start: 

Privileges : 

See See 
Folders Files 

Owner: Im I 0 0 
Use..- /6..-oup : I pro jed I 0 0 

Everyone- D D 
0 M.:iko:- all curri:-ntly e-nclo:s:i:-d folde-rs like this one 

D C.:in't be- moved, renami:od or delete-d 

Figure 9-5 The Sharing dialog box 

UNIX Permissions 

Make 
Changes 

0 
D 
D 

If you choose this with a file icon selected, the UNIX Permissions dialog box for files 
appears, as shown in Figure 9-6. 

letterl 
UNIX Permissions 

iJ 
Yhere: 
logged In As : 
Permissions: 

UNIX owner: Im 
UNIX 6..-oup: jprojeot 

Others 

/users /start /lelter 1 
start 
Read, 'w'rite 

Road Write 

I 0 0 
I 0 D 

0 D 

Execute 

D 
D 
D 

Figure 9-6 The UNIX Permissions dialog box for file permissions 

If you have highlighted a folder before choosing UNIX Permissions, the UNIX 
Permissions dialog box for folders appears, as shown in Figure 9-7. 
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start 

r""'-1 Yh•r•: /users/start 
LJ Logg•d In As: start 

Permissions : Read 1 'vlrite 1 Exeoute 

Read 'Write Exeoutei 

UNIX 0Yn•r: I+ I IZI IZI IZI 
UN IX Group : I pro jeot I IZI D IZI 

Others IZI D IZI 
D Make all ourrently enolosed direotories like this one 

( Show MAC uiew J 

Figure 9-7 The UNIX Permissions dialog box for folders 

This shows the permissions of the selected folder in UNIX terminology. You can 
display its permissions in Macintosh terminology by clicking Show Mac View. The dialog 
box shown in Figure 9-8 appears. 

start 
Macintosh View of UN IX Permissions 

r""'-1 Yhere: /u:s:E-rs/st.art 
LJ Logged In As: start 

Permissions: See Folders and Files, Make Changes 

See Folders Make 
and Files Changes 

UN IX 0-.ner : I start IZI IZI 
UN IX Group : I pro jeot IZI D 

Others IZI D 
D Make all ourrentl':I enclosed folders like this one 

(Show UNIH uiew) 

Figure 9-8 The Macintosh view of UNIX folder permissions 

Duplicate 

This command makes a copy of a selected file, folder, or application. The Command-key 
equivalent is CoMMAND-D. 
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Make Alias 

This command creates an alias of the selected file. The alias is named with the original 
filename and the word alias. You can move the alias to any location in the file system 
and double-click its icon to open and use the file. 

Put Away 

This command restores to its original location a file, folder, or application that was 
moved to the desktop. The Command-key equivalent is Command-Y. 

Find 

This command enables you to find a file anywhere on the system. It allows you to select 
criteria for the search and to broaden or narrow the area to be searched. If you choose 
Find, the dialog box shown in Figure 9-9 appears. This allows you to search for a file by 
its name. This search is not case sensitive. The Command-key equivalent is Command-F. 

Find 

Find: 

( More Choices J ( Cancel J ([ Find JJ 

Figure 9-9 The Find dialog box with the minimum choices 

If you click on More Choices, the dialog box shown in Figure 9-10 appears. This 
allows you to add more criteria for your search. For example, the "name" button displays 
a pop-up menu of search criteria (name, size, kind, label, date created, date modified, 
and so on). The pop-up menu that is displayed when you click on the "contains" button 
varies, depending on the choice you have made in the "name" pop-up menu. 
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Find 

Find and select items whose 

._I _n_a_m_e ___ ... _.11 contains 

Search I on all disks "' I Dall at once 

(Fewer Choices J ( Cancel J ([ Find ]J 

Figure 9-10 The Find dialog box after choosing More Choices 

The Fewer Choices button redisplays the initial dialog box. 

Find Again 

This command allows you to repeat the search you performed with Find. See Find, 
above. The Command-key equivalent is Command-G. 

Page Setup 
This command presents the Page Setup dialog box for the printer type that you have 
selected in the Chooser. Figure 9-11 shows the Page Setup dialog box for a LaserWriter 
printer. 

Stl 
LaserWriter Page Setup 1.0 ( OK ) 

Paper: ® US Letter O R4 Letter 
O US Legal O 85 Letter 0 l.__Ta_b_lo_i_d ___ ... _.I [ Cancel J 

Reduce or IHmil% 
Enlarge: 

Orientation 

11[!£)] 

Printer Effects: (Options J 
IZI Font Substitution? 
IZI TeHt Smoothing? 
IZI Graphics Smoothing? 
IZI Faster Bitmap Printing? 

Figure 9-11 The LaserWriter Page Setup dialog box 
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Print Window 

This command prints a listing of the contents of the active window. When you choose 
this command, the Print dialog box appears. When you click OK, a directory listing is 
sent to the printer you have selected in the Chooser. 

The Edit menu 

The Edit menu, shown in Figure 9-12, contains commands that you use to edit text in 
windows. You also can use the editing commands with most desk accessories. 

1hHh o)(? 

1: ut o\<H 

t !!!H_j o)(<[ 

PesH o)l:!J 

th'm 
Select All 3!:H 

Show Clipboard 

Figure 9-12 The Edit menu 

Undo 

This command nullifies the last text editing or formatting change that you made. It does 
not nullify command execution. The Command-key equivalent is CoMMAND-Z. 

Cut 

This command copies any selected text to the Clipboard and removes the text from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as the 
result of another Cut or Copy command. The Command-key equivalent is COMMAND-X. 

Copy 

This command copies any selected text to the Clipboard but does not remove it from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as the 
result of another Cut or Copy command. The Command-key equivalent is COMMAND-C. 
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Paste 

This command inserts the contents of the Clipboard into the window starting at the 
insertion point. The Command-key equivalent is COMMAND-V. 

Clear 

This command removes any selected text from the window and does not copy it to the 
Clipboard. Text removed with the Clear command is no longer available. Choosing Clear 
is equivalent to pressing the DELETE key. 

Select All 

This command selects all of the text in the window. The Command-key equivalent is 
COMMAND-A. 

Show Clipboard 

This command displays the contents of the Clipboard in a separate window. 

The View menu 

The View menu provides commands to alter how the contents of a disk or a folder are 
displayed in the Finder. A check mark appears next to the active listing type. The View 
menu is shown in Figure 9-13. 

by Small Icon 
by Icon 

v'by Name 
by Size 
by Kind 
by Label 
by Date 

Figure 9-13 The View menu 
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Small Icon 

When you view the contents of a disk or folder by small icon, you see a miniaturized 
representation of the icons of the different files, applications, and folders it contains. 
Figure 9-14 shows a folder whose contents are viewed by small icon. 

-0 
6 items 

Mac Partition 0 
2 .5 MB in disk 1 .3 MB available 

Ui:JSystem Folder LJbin ~ 
[2"1 launch '""'1 [;;;>, booLcd '°"'1 

¢1 J/t:!:!!i :ill!<: >Uw+:: > 'H•H>imi >n:n; J[¢ Qi 

Figure 9-14 A folder's contents viewed by small icon 

Icon 

When you view the contents of a disk or folder by icon, you see the full-size 
representation of the icon of each file, folder, or application. Figure 9-15 shows a folder 
whose contents are displayed by icon. 

Mac Partition 
6 iti:-ms 2.5 MB in disk 1 .3 MB available 

liJ LJ d~i 
CZ'fu 

A/U:O: 
SystE'm Folder bin A/UX Startup 

{? {? Pl 
.:i.1vx i:.1ux. ~H~ 

l.:iunch booLcd es: ch 

¢ 

Figure 9-15 A folder's contents viewed by icon 
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Name 
When you view the contents of a disk or folder by name, an alphabetized list of the 
different files, applications, and folders appears in the window. Figure 9-16 shows a 
folder whose contents are displayed by name. 

;;;o 

<31 AIUX Startup 

[> 0 bin 

D boot. • ..od 

D ••ch 
D launch 

[> 0 System folder 

Mac Partition 
Size Kind Label 

209K application program -

- folder 

19K A /UX Startup doou... -

125K AIUX Startup docu... -

14K A /UX Startup do cu... -

- folder 

Last Modified 

fri,Sep6, 1991, 1.Q 

Mon, Aug26, 1991 

Sun, Aug25, 1991, 

Sun, Aug 25, 1991, 

Sun, Aug25, 1991, 

Tue,Sep:!i, 1991, 1 

¢_{ ]!i!i!i!i!!!!!!!!!]!!!i!!i!!!!!i!!!!!!i!!i!!!:!I!!i!!!!!!!i!!!!i!lm!!!:!!!!!:!!!i!!!!!!!i!!!:!!!I!!:!!!!!:!!!:!!!i!!!!!!!!!i!!!!!:!!!i!!!!!!!!!i!!!i!!!!!!!!!!!!!i!!!n!J!!!!!!!!i!r!!!1 ¢ '21 

Figure 9-16 A folder's contents viewed by name 

The list you see has five columns: 

• Name: This column shows the name of the files, folders, or applications in the 
window. 

• Size: This column shows how much memory the item occupies on the disk. 

• Kind: This column shows whether an item is an application, folder, or file. If it is a 
file, the file type is shown. 

• Label: This column shows what label you have given to the item by using the Label 
menu (described later in this chapter). 

• Last Modified: This column shows the date and time that the file, application, or 
folder was last changed. 

• Note You can enlarge the window to see all of the information. • 
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Size 

When you view the contents of a disk or folder by size, the applications, files, and 
folders in the window are listed in order, from largest to smallest. Figure 9-17 shows a 
folder's contents viewed by size. 

D Mac Partition t!J 
Name Sizeo Kind Label Last Modified 

<31 A/UX Startup 209K app lk:ation program - Fri, Sep 6, 1991, 1 S: 
D esch 125K A /UX Startup docu ... - Sun, Aug 25, 1991, 

D boot....cd 19K A /UX Startup docu ... - Sun, Aug 25, 1991, 

D launch 14K AIUX Startup docu ... - Sun, Aug 25, 1991, 

[> D bin - fold-:-r Mon, Aug26, 1991 

[> D System Foldor - folder Tue, Sep 3, 1991, 1 

Figure 9-17 A folder's contents viewed by size 

The size of a file, application, or folder is the amount of memory it occupies. After 
the name of the item you see a number followed by a K, or kilobyte, which is equal to 
1024 bytes. The number 390K next to the application HyperCard means that it occupies 
390 kilobytes of memory on the disk. A standard double-sided floppy disk can hold up 
to SOOK of memory. The average hard disk containing A/UX can hold up to 160 
megabytes (MB) of information. A megabyte is equal to 1024 kilobytes. 

Kind 

When you view the contents of a disk or folder by kind, the files, folders, and applications 
are listed alphabetically by type. Figure 9-18 shows a folder's contents viewed by kind. 

D Mac Partition t!J 
Name Slze Kind Label Last Modified 

<31 AIUX Startup 209K applk:ahon program - Fri, Sep 6, 1991, 1 S: 
D boot....cd 19K A /UX Startup docu ... - Sun, Aug 25, 1991, 

D esch 125K A /UX Startup doou ... - Sun, Aug 25, 1991, 

D launch 14K A /UX Startup doou ... - Sun, Aug 25, 1991, 

[> D bin - folder Mon, Aug26, 1991 

[> D Sy stem Folder - foldor Tue, Sep 3, 1991, 1 

Figure 9-18 A folder's contents viewed by kind 
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Label 

The Label menu in the Finder allows you to give a label to every file or folder, which 
categorizes the items in the folder (see "The Label Menu" later in this chapter for further 
information). Viewing the contents by label sorts them in the order in which the labels 
occur in the Label menu. See Figure 9-19 for a folder that uses labels and is viewed by 
label. 

H/UH Pubs 
Name Size Kind last Modified 

~ D IMPORTANT FOR USERS... - folder Essential Fri, Sep 6, ;ft 
~ D Kathy's - folder lo Progress Sun, Jun 1 ITTm; 

~ D Kristi - folder lo Progress Tue, Apr 9 ~ 

....ILQ. laura's - folder Personal W'ed Nov 7 -0 
¢ L Jm:mmm:r::rm:mmm:m:mmm:m:mmm:mmmmmm:mm:::mm:mm:mmmmmmmmmmmm:m:m:mmm:m:mmmm:mrn: ¢> 121 

Figure 9-19 A folder's contents viewed by label 

Date 

When you view the contents of a disk or folder by date, the different files, applications, 
and folders in the window are displayed with the most recently created or modified one 
listed first. Figure 9-20 shows a folder's contents viewed by date. 

-o 
Name 

41 l\/UX Startup 

~ D System Folder 

~ D bin 

D launch 

D boot....cd 

D esch 

Mac Partition 
Size Kind labol 

209K application pro gr am -

- foldor 

- folder 

14K A /UX Startup do cu... -

19K A /UX Startup docu... -

125K A /UX Startup doou... -

last Modified 

Fri,Sop6, 1991, 1 :56Pt1Q 

Tue, Sep 3, 1991, 11 :06 ~ 

Moo, Aug 26, 1991, 10:5 

Sun, Aug 25, 1991, 1 :37 

Sun, Aug 25, 1991, 1 :37 

Sun, Aug 25, 1991, 1 :37 

¢ l ]t::::::::::::::::::::::::m:m:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::m:::::::::::::::::::::::::::::::::::::::::::::m:::::::::::::::::::::::m:::::::::::::m:::::::::::::::::m::::::n ¢> 121 

Figure 9-20 A folder's contents viewed by date 
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The Label menu 

The Label menu supplies a list of labels that you can apply to any file or folder. You can 
then choose Label in the Views menu to list items according to the labels you have 
assigned to them. Figure 9-21 shows the Label menu. 

Essential 
Hot 
In Progress 
Cool 
Personal 
Project I 
Project 2 

Figure 9-21 The Label menu 

The Special menu 

The Special menu contains the commands you use to log out, shut down the system, and 
restart the computer. It also provides commands that you use for special tasks, such as 
deleting the files that you placed in the Trash. Figure 9-22 shows the Special menu. 

Cle<m Up Window 
!:mph_~ Trnsti._, 

Eject Disk i!CE 
Erase Disk ... 

Restart 
Shut Down 

Logout 

Figure 9-22 The Special menu 
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Clean Up Window 

This command rearranges icons on a disk or in a folder so that they are easier to see. 
You can use this command only when you are viewing the contents of a disk or folder 
by icon or by small icon. 

Empty Trash 

This command deletes any items you have placed in the Trash. Once you empty the 
Trash, the items cannot be recovered. 

Eject Disk 

This command causes a floppy disk in the floppy disk drive to be ejected. The 
Command-key equivalent is CoMMAND-E. 

Erase Disk 

This command completely erases any information on the selected disk. To use this 
command, you must first highlight the name of the disk you want to erase. 

Restart 

This command shuts down the computer and starts it up again. When you use A/UX, 
you must enter the root account password to use this command. 

Shut Down 

This command shuts down the computer. You must enter the root password to use this 
command. 

Logout 

This command ends the current work session. When you choose this command, all open 
applications are closed and you return to the Login dialog box. 
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The Balloon Help Menu 

The Balloon Help menu makes balloon help available or turns balloon help off. This 
menu is shown in Figure 9-23. 

Rbout Balloon Help ... 

Show Balloons 

Finder Shortcuts 

Figure 9-23 The Balloon Help Menu 

About Balloon Help 

This displays a brief description of how balloon help works. 

Show Balloons 

This causes a balloon with a brief help message to appear whenever you position the 
pointer on a menu or a menu item. 

Finder Shortcuts 

This choice offers you one or more quick summaries of ways to use the features of the 
Finder. 

The Applications menu 

This menu is labeled by the icon of the active application at the far right of the menu bar. 
The Applications menu contains a list of the available applications (for example, 

Finder, CommandShell, and any other applications that are currently running). To make 
an application active, choose it in this menu. Figure 9-24 shows the Applications menu 
with the Finder selected. 
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Hide Finder 
Hide Others 
Show im 

Q CommandShell 
../~Finder 

.. 

Figure 9-24 The Applications menu 

Hide Application 

This command hides the currently active application. In the case of Figure 9-24, the 
current application is the Finder. 

CommandShell 

This command makes CommandShell the active application, which displays an untitled 
CommandShell window like the one in Figure 9-25. If you have used a CommandShell 
window earlier and have not closed it, it is brought to the front of the other windows and 
becomes the active window. 

;;;o CommandShell 1 
•I 

Figure 9-25 A CommandShell window 

Finder 

This command returns you to the Finder desktop from whatever process A/UX is 
running. 
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The CommandShell environment 

This section describes the commands to which you have access when you're working 
with CommandShell. You access CommandShell by choosing it in the Apple menu. 

The CommandShell File menu 

The CommandShell File menu contains the commands that manage the CommandShell 
window environment. Figure 9-26 shows the CommandShell File menu. 

New 3€N 
Open... 3€0 
Close 3€W 
S<H'H \dPdion.-. 

Page Setup ... 
Frid §e!w thiL" 

Close All Windows 
Quit 3€0 

Figure 9-26 The CommandShell File menu 

New 

This command creates a new CommandShell window and places it on the desktop. The 
Command-key equivalent is CoMMAND-N. 

Open 
This command displays a dialog box that allows you to open a selected file. The 
Command-key equivalent is CoMMAND-0. 
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Close 

This command closes the active window. The Command-key equivalent is COMMAND-W. 

Save Selection 

This command displays a dialog box that allows you to save, under a name you specify, 
any text you select in a CommandShell window. 

Page Setup 

This command displays a dialog box that allows you to alter printer settings. 

Print Selection 

This command displays a dialog box that allows you to send to the printer any data you 
have selected in a CommandShell window. 

Close All Windows 

This command closes all CommandShell windows on the desktop. 

Quit 

This command turns off CommandShell. Use this only when it is necessary to turn off all 
applications in order to load fonts; otherwise leave CommandShell by reactivating the 
Finder or whatever other application you need to use. If you choose Quit, 
CommandShell is no longer available in the Applications menu. The Command-key 
equivalent is CoMMAND-Q. You can restart CommandShell from the Apple menu, because 
there is an alias of the CommandShell file in the Apple Menu Items folder that is in the 
System Folder. Do not remove this alias. 
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The CommandShell Edit menu 

The CommandShell Edit menu, shown in Figure 9-27, contains the commands that you 
use to edit text in windows. In addition, you can also access the Commando utility from 
this menu. 

[ !J \ :":H 
Copy *C 
!'as1o Ai! 
tkm 
Select Rll *R 

Commando *K 

Figure 9-27 The CommandShell Edit menu 

Undo 

This command nullifies the last text editing or formatting change that you made. It does 
not nullify command execution. The Command-key equivalent is COMMAND-Z. 

Cut 

This command copies any selected text to the Clipboard and removes the text from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a 
result of another Cut or Copy command. The Command-key equivalent is COMMAND-X. 

Copy 

This command copies any selected text to the Clipboard but does not remove it from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a 
result of another Cut or Copy command. The Command-key equivalent is COMMAND-C. 

Paste 
This command inserts the contents of the Clipboard into the window, starting at the end 
of the text. The Command-key equivalent is CoMMAND-V. 
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Clear 

This command removes any selected text from the window and does not copy it to the 
Clipboard. Text removed with the Clear command is no longer available. Choosing Clear 
is equivalent to pressing the DELETE key. 

Select All 

This command selects all of the text in the window. The Command-key equivalent is 
COMMAND-A. 

Commando 

This command invokes the Commando command-line building application. This is 
especially useful when you are creating a compound command line in a CommandShell 
window. The Command-key equivalent is CoMMAND-K. 

The CommandShell Window menu 

The CommandShell Window menu contains the commands you use to manipulate and 
access CommandShell windows. Figure 9-28 shows the CommandShell Window menu. 

•!.Ulil I m:Jm 

Tile 
Tile Horizontal 
Tile Uertical 
Standard Positions 

3€1 

Standard Size 3€S 
Full Height 3€F 
Zoom Window 3€/ 
Hide "CommandShell 2" 3€H 
Show Rll Windows 
Pre11ious Window 3€L 
Rotate Windows 3€R 

R/UH System Console 3€0 
(C©Wl!iiUilrncil~lillilDD U 3€ 1 
(C©Wl!Iillilrncil~lillilDD ~ 3€ 2 

Figure 9-28 The CommandShell Window menu 
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Tile 

This command rearranges all windows on the desktop as shown in Figure 9-29. 

CommandShell I CommandShell 2 
localhost.start 1 Ill D IQ1 localhost.start 1 Ill D [Q 

~ lQJ 

CommandShell 3 §0 CommandShell 4 0§ 
localhost.start 1 Ill D ~ I oca I host. start 1 Ill I IQj 

~ ~ 
Figure 9-29 Tiled windows 

The Command-key equivalent is COMMAND-T. 
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Tile Horizontal 

This commands rearranges all windows on the desktop as shown in Figure 9-30. 

CommandShell 1 
I oca I host. start 1 II! D IQl 

~ 
CommandShell 2 

localhost.start 1 II! D IQ 

2 

CommandShell 3 
localhost.start 1 II! D IQ 

~ 
~D CommandShell 4 ~ E!l 
localhost.start 1 II! I ~ 

~ 
~ 

Figure 9-30 Horizontally tiled windows 
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Tile Vertical 

This command rearranges all windows on the desktop as shown in Figure 9-31. 

CommandSh CommandSh Command Sh §0~ CommandSh §0§ 

"0 IQj "D ~ "0 IQ "0 ~ 

~ lQ ~ ~ 

Figure 9-31 Vertically tiled windows 
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Standard Positions 

This command rearranges all windows on the desktop as shown in Figure 9-32. 

..Lmnnutn..d.S.h.elL 1J f- CommandShell 2 p 
CommandShell 3 1 p~ 

pa D CommandShell 4 0 
pacer. start 1 IS I ~ 

'-I 
'-- -0 

'-- ~ 

Figure 9-32 Standard window positioning 

This is the standard stacking arrangement of all CommandShell windows as they are 
created. 

Standard Size 

This command returns the active window to its standard size, if it has been changed. The 
Command-key equivalent is CoMMAND-S. 

Full Height 

This command changes the size of the active window so that it is as long as the screen 
allows. The Command-key equivalent is COMMAND-F. 
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Zoom Window 

This command increases the size of the active window so that it is as large as the screen 
allows. Choosing Zoom Window is equivalent to clicking the zoom box in the upper­
right corner of the window. The Command-key equivalent is COMMAND-/. 

Hide "Window Name" 

This command hides the active window from view. The window name appears in place 
of the phrase Window Name. The window is not closed but merely hidden from view. 
All accessible CommandShell windows are listed at the bottom of the Window menu. 
The Command-key equivalent is CoMMAND-H. 

Show All Windows 

This command displays all of the CommandShell windows listed at the bottom of the 
Window menu, including the A/UX System Console window, which contains system 
messages about all of the currently running A/UX system processes. 

Previous Window 

This command redisplays the last window you accessed before you activated the current 
window. The Command-key equivalent is CoMMAND-L. 

Rotate Windows 

This command brings the rear window to the front each time the command is chosen 
from the menu. The Command-key equivalent is COMMAND-R. 

A!UX System Console 

This command activates the A/UX System Console window, which contains system 
messages about all of the currently running A/UX system processes. The Command-key 
equivalent is COMMAND-0 (zero). 
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Names of all accessible CommandShell windows 

This is a list of all currently accessible CommandShell windows. This list includes any 
hidden windows as well. Choosing a window name in the list activates that window. 

The CommandShell Fonts menu 

The CommandShell Fonts menu, shown in Figure 9-33, contains the list of available fonts 
that you can use in CommandShell windows. Only monospaced (fixed width) fonts are 
supported in CommandShell. When you choose a font, all of the text in the window, not 
just the selected text, is displayed in that font. 

Courier 
Monaco 

./UT100 

..,1@ !Pmnmu 
1 O Point 
u~ !Pmnmu 
14 Point 
18 Point 
24 Point 
36 Point 
Other ... 

Figure 9-33 The CommandShell Fonts menu 

The CommandShell Fonts menu allows you to specify which of the available fonts to 
use in the CommandShell window, as well as the point sizes that determine the size of 
the text as displayed on the screen and as printed. The smallest preselected point size is 
9 point, and the largest is 36 point. 

The last item in the menu (Other) allows you to enter any desired type size. When 
you select Other, the dialog box shown in Figure 9-34 appears. 

Font size: ~II -~ 

( Cancel ) ( OK 

Figure 9-34 The Font Size dialog box 
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The CommandShell Commands menu 

The CommandShell Commands menu allows you to change the environment within 
CommandShell windows. The CommandShell Commands menu is shown in Figure 9-35. 

Don't Record Lines Off Top 
1: kar !.he~ Oil fop 

Redraw Screen 

Figure 9-35 The CommandShell Commands menu 

Don't Record Lines Off Top 

This command marks the window as the barrier for text entry. Any text exceeding the 
boundaries of the active window is not recorded and thus not accessible. 

Clear Lines Off Top 

This command erases any information that scrolls off the top of a CommandShell 
window. 

Redraw Screen 

This command redraws all of the pixels that make up the screen. You use this command 
if, at some point, a window is not completely redrawn. 

The CommandShell Preferences menu 

The CommandShell Preferences menu allows you to edit some of the properties of a 
CommandShell window. Figure 9-36 shows the CommandShell Preferences menu. 
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•:iu· .. 
Notification Leuels ... 

New Window Settings ... 
Actiue Window Settings ... 3€E 

Saue Preferences 
HPs1 (ff(~ frnm Pn: li'ffntet 

Figure 9-36 The CommandShell Preferences menu 

Notification Levels 

This command displays a dialog box that allows you to control how system messages are 
displayed when CommandShell is not the active application. 

New Window Settings 

This command displays a dialog box that allows you to set some of the default 
parameters, such as font and font size, for a new CommandShell window. 

Active Window Settings 

This command displays a dialog box that allows you to alter some of the properties 
of the active window, such as the name of the window. The Command-key equivalent 
is COMMAND-E. 

Save Preferences 

This command saves any changes you have made to a CommandShell window. 

Restore From Preferences 

This command causes a CommandShell window to revert to the state it was in when you 
last saved the preferences, if you have made any changes since then. If you have not 
altered the window, the command is dimmed on the menu. 
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The Keys menu 

The Keys menu is a part of the Vf 102 tenninal emulation, and it allows you to choose 
from both a keypad and a cursor-movement pad. The Keys menu is shown in 
Figure 9-37. 

Keypad ., 
Cursor ., 

Figure 9-37 The Keys menu 

Keypad 

This command provides an on-screen keypad that you can use with your mouse pointer. 
The keypad is shown in Figure 9-38. 

Figure 9-38 The keypad 

Cursor 

This provides an on-screen cursor pad from which you can choose cursor movements 
with your mouse pointer. The cursor pad is shown in Figure 9-39. 

Figure 9-39 The cursor pad 
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No Scroll 

This is a VT102 feature that is not used under A/UX. 

Terminal Emulation 

You can configure your terminal emulation by clicking on Terminal Settings in the Active 
Window Settings or the New Window Settings dialog box. These dialog boxes are 
displayed if you choose either Active Window Settings or New Window Settings in the 
Preferences menu. 

Click on Terminal Settings to display the Terminal Settings dialog box, which is 
shown in Figure 9-40. 

General setup options 

When you display the Terminal Settings dialog box, the General icon is highlighted, and 
the settings icons shows in Figure 9-40 are displayed. 

Terminal Settings n OK i1 
Emulation: C:ommandShe ...... I ( Cancel J 

• ~ 
Soree-n 

Keyboard 

.i£ T ormina 1 Mode : I ANS I IVT1 02 "' l I Text Cursor 

i ·····~·==i··········~--~-~--~;-~:··············i .:::I( ~ ~~o:.krline 

l!l:i! ................ ~.=:!. ............... ~--~~-°-~-~--~~-~~ ....... ! ..................................................... . 

I 
-0 

D Show Status Bar 

D Show Tab Ruler 

Answerback Message [~-----~J 

Figure 9-40 The Terminal Settings dialog box 
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This offers the following choices: 

• Terminal Mode 

• On Line or Local Echo 

• Show Status Bar 

• Show Tab Ruler 

• Answerback Message 

• Text Cursor 

Terminal Mode 

This allows you to choose between ANSI/VT102 and the VT52 emulation. If you choose 
VT52, the Character Set dialog box (discussed in "Character Set Setup Options," later in 
this chapter) is disabled. 

On Line/Local Echo 

This allows you to choose whether your computer is on line (that is, able to 
communicate with another computer) or off line. With On Line selected, you should also 
select the Local Echo option so that characters you type to send to another computer are 
also displayed on your screen. The Local Echo option is disabled if you unclick On Line, 
because then your screen automatically displays what you type. The default setting is On 
Line, Local Echo. 

Show Status Bar 

The status bar appears at the top of the window. It is shown in Figure 9-41. 

fl/UH System Console 

y 
Shows whether Shows whether the The remote computer's 
On Line and Local Echo keyboard is locked application controls the 
are off or on meaning of these 

indicators 

Figure 9-41 The VT102 status bar 
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The status bar shows whether you have turned On Line and Local Echo on or off. It 
also shows whether the remote computer to which you are sending data has turned off 
your keyboard temporarily. This happens if you are sending data too fast for it to handle. 
It turns your keyboard on again when it is ready to receive more data. By default the 
status bar is not displayed. 

Show Tab Ruler 

Select this to display a tab ruler at the top of the window, just below the status bar, if it 
too is displayed. The tab ruler is shown in Figure 9-42. 

~D R/UH System Console 

l!J 10 20 30 40 50 50 ~ 70 ~8 2 
.Lii' I I 111111 I 1111111I1111111I1I1 111111111111II11 1111 111I1111I1 :::,~I I 11I1 ~,= ~l~I 

Set new tabs Clear all tabs Reset default tabs 

Figure 9-42 The VT102 tab ruler 

Choose this to reset the tabs, which are set every 8 spaces by default. You can set 
new tabs by dragging tab icons from the new tabs icon at the left of the ruler. Click and 
drag existing tabs to move them. The buttons at the right clear all set tabs and reset the 
default tabs every 8 spaces. By default, Show Tab Ruler is turned off. 

Answerback Message 
This allows you to supply an identification response of 1 to 20 characters to the remote 
computer, if it requires one. The VT102 Tool sends the answerback string when the 
other computer requests it. To send the answerback string manually, press CoNTROL­
RETURN. To ask for the answerback string from the remote computer, press CoNTROL-E 

Text Cursor 

This allows you to choose whether the cursor is an underline or a block. The default 
is a block. 
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Screen setup options 

When you select the Screen icon at the left of the dialog box, the box shown in 
Figure 9-43 appears. 

Terminal Settings 

Emulation: CommandShe ... ,.. I 

Keyboard 

Width: I 80 Columns "' I 
Size : I 9 point "' I 

0 Show Control Ch.arac:ters 

IS] Auto Wrap to Next Line 

D Origin at Scrolling Margin 

(( OK J) 
( Cancel ) 

Scroll Text 

@ Jump 0 Smooth 

80 

r~~~5~l~~~~ample ofifr• ]]-II . . 
!Th; s ; s a samp 1 e of vT! Option preview area 

l.1.~~ t~.~.~:..... ... ...... ... .. .. .: ] 

D Inverse Video 

Figure 9-43 Screen setup options dialog box 

The option preview area shows you how your window will look if you select various 
options. It displays changes you make in the width and size of the characters, whether to 
display control characters, to wrap to the next line automatically, whether text should 
scroll smoothly or jump a line at a time, whether to display in inverse video, and whether 
added text should be inserted or should overwrite existing characters. 

Width/Size 

When you click the Width field, a pop-up menu appears that allows you to choose an 
80-column or a 132-column line. If your CommandShell window is set at a different 
width, that width appears as a third option in the pop-up menu. The scale in the option 
preview area changes according to your selection. The default is 80 columns. 

... Warning Save any currently displayed text that you want to keep before you change 
the width setting. When you change the width setting, any text displayed in your 
window is lost. Text that was recorded as it scrolled off the top of the window is still 
available to be scrolled back into the window. ..&. 
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When you click the Size field, a pop-up menu appears that allows you to choose 9-
point or 12-point screen characters. If you have chosen a different size type from the 
CommandShell Font menu, that font size appears as a third option. The default is 9-point 
type (or whatever you have chosen in the CommandShell Font menu) 

Show Control Characters 

Under most circumstances, you do not need to display control characters (for instance, 
Carriage Return). To display these characters, check this box. By default, this box is 
unchecked. 

Auto Wrap to Next Line 

This forces the text to continue on the next line automatically when it reaches the edge 
of the window, rather than going beyond the edge of the window. This option is 
unavailable when Show Control Characters is checked. By default, Auto Wrap is 
unchecked. 

Insert Characters 

When this check box is unchecked, text inserted before existing text writes over the 
existing text. If you check this box, the new text is inserted and pushes existing text to 
the right. Characters pushed beyond the right margin are lost. This option is unchecked 
by default. 

Origin at Scrolling Margin 

This determines whether the cursor can move outside the scrolling region (the area 
between the top and bottom margins). In addition, this option determines whether 
screen addressing is in absolute or relative coordinates. Usually, the remote computer 
determines the appropriate setting for this option. The default setting for this option is 
unchecked. 
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Scroll Text (Jump or Smooth) 

When new data are sent to the window but the window is already filled with text, it 
automatically scrolls down to display the newly arriving information. If you select 
Smooth, the text scrolls more slowly than if Jump is selected, but it scrolls smoothly, 
which makes it easier to read the text as it scrolls by. If Jump is selected, the text moves 
jerkily a line at a time. The default is Jump. 

Inverse Video 

If this check box is unchecked, the window displays black text on a white background. 
If it is checked, the window displays white text on a black background. The default is 
unchecked. 

Keyboard setup options 

When you select the Keyboard icon, the dialog box shown in Figure 9-44 appears. 

Terminal Settings 

Emulation: l CommandShe ... -.. I 

Numeric Koy pad Goner ates 

@ N1Jmeric Sequi:-nces 

0 Application Sequences 

Cursor KE-y s Gener ate 

ID @ANSI Cursor Sequences 

[;Jill 0 Application Sequences 

rzJ Swap 'Backspace' and 'Delete' 

(( OK ) 

( Cancel ) 

Ho ldin9 Down Koy s 'vi ill 

rzJ Auto Repeat Koy s 

rzJ Repeat Control Koy s 

<l 
D Keyclick Sound 

D New Line on a Return 

Figure 9-44 The Keyboard setup options within the Terminal Settings 
dialog box 
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Numeric Sequences/Application Sequences 
If Numeric Sequences is selected, the keys on the keypad generate characters that match 
the typical numeric, comma, period, and minus sign keys on the VT102-type keyboard 
(in accordance with ANSI specifications). If Application Sequences is selected, the keys 
on the keypad generate special escape sequences (specified by Digital Equipment 
Corporation). Numeric Sequences is selected by default. 

ANSI Cursor Sequences/Application Sequences 

If ANSI Cursor Sequences is selected, when you press cursor keys, ANSI cursor-control 
sequences are transmitted to the remote computer. If Application Sequences is selected, 
when you press cursor keys, cursor-control functions (specified by Digital Equipment 
Corporation) are transmitted to the remote computer. By default, Cursor Sequences is 
selected. 

+ Note If unexpected characters appear when you press cursor keys or choose them 
from the Keys menu (see "The Keys Menu" earlier in this chapter) and the cursor does 
not move, the application on the remote computer might not be accepting input from 
cursor keys. Perhaps the cursor key setting does not match what the remote application 
expects. • 

Swap Backspace and Delete 

If this is unchecked, pressing DELETE sends a backspace character (ASCII 08); pressing 
OPTION-DELETE sends a delete character (ASCII 127). 

If this is checked, pressing the DELETE key sends a delete character (ASCII 127); 
pressing OPTION-DELETE sends a backspace character (ASCII 08). 

Auto Repeat Keys 
When this box is checked, TAB, RETURN, BACKSPACE, ENTER, ESCAPE, and noncontrol keys 
repeat when held down. If it is not checked, they do not repeat. This box is checked by 
default. 

Terminal Emulation 9-39 



Repeat Control Keys 

When this box is checked, keys used to generate control characters repeat when held 
down. When it is unchecked, they do not repeat. Generate control characters by 
simultaneously pressing both CoNI'ROL key and another key. By default, this box is 
unchecked. 

Keyclick Sound 

When this box is checked, pressing a key causes the computer to create an audible 
clicking sound. The default setting for Keyclick is unchecked. 

New Line on a Return 

When this option is unchecked, a line feed is interpreted as only a line feed (not as a 
carriage return/line-feed pair). When a line-feed character is received from the remote 
computer, the cursor moves down one line, but stays in the same column, rather than 
moving to the beginning of the next line. Pressing the Return key sends a carriage return 
character 

When this option is checked, a line feed is interpreted as a carriage return/line-feed 
pair. When a line-feed character is received from the remote computer, the cursor moves 
to the first position on the next line. Use this option when incoming data do not move 
down to the beginning of the next line. Pressing the Return key sends both a carriage 
return character and a line-feed character. 

The default setting is for the box to be unchecked. 

Character Set setup options 

When you select the Character Set icon, the dialog box shown in Figure 9-45 appears. 
This dialog box allows you to specify character sets for display on your screen. If you 

selected the VT52 mode in the General settings, this dialog box is not available. 

9-40 Chapter 9 A/UX Reference 



Terminal Settings K OK 1 
Emulation: CommandShe ... "" I ( Cancel ) 

National Replacement Set : I US ASCII ~1 

Screen 

Active Character Sets Temporary Character Sets 

Keybo~rd 
@ Go:i USASCll 

Q G1 : ._I ..;;U;;;;.S.:.:A;;;;;SC;.;,;11 __ ~_.I 

G2: I us ASCII 

G3: I us ASCII 

Figure 9-45 The Character Set options dialog box 

National Replacement Set 

Click this to display a pop up menu (shown in Figure 9-46) for choosing a national 
replacement set. 

Dutch 
Finnish 
French 
French Canadian 
German 
Italian 
Norwegian /Danish 
Portuguese 
Spanish 
Swedish 
Swiss 
UK ASCII 

Figure 9-46 The National Replacement set menu 

US ASCII, the standard set of letters, numbers, and symbols used in North American 
English computers, is the default character set on this menu. UK ASCII is the same as US 
ASCII but with the pound sterling symbol(£) instead of the number sign(#). Dutch, 
Finnish, French, French Canadian, German, Italian, Norwegian/Danish, Portuguese, 
Spanish, Swedish, and Swiss are various character sets with accented characters. 
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When you specify anything other than US ASCII, the International option becomes 
available when you pop up any of the GO-G3 menus, as shown in the lower portion of 
the Character Set dialog box illustrated in Figure 9-47. For instance, when you select 
French as the National Replacement set, French also appears when you pop up any of 
the GO-G3 menus. 

~ National Replacement Set: ~I _Fr_en_ch __ _ 

/\dive Char ader Sets 

@ GO: I us ASCII 

0 

Temporary Char ad er Sets 

G2: I us ASCII 

G3:I US ASCII 

Figure 9-47 Active and Temporary character sets available if 
French is selected 

Active Character Sets 

These pop-up menus (GO and G 1) specify the active character set and an alternate. Both 
menus contain the same list of character sets, and US ASCII is the default for both menus. 
The GO menu is the default for the active character set. 

You can change the selection on either of these menus by pulling down the menu 
and choosing a different character set; you can change the active character set by 
clicking the other button. 

Temporary Character Sets 

These pop-up menus (G2 and G3) specify the two temporary character sets. Both menus 
contain the same list of character sets, and US ASCII is the default for both menus. You 
can change the selection on either of these menus by pulling down the menu and 
choosing a different character set. 

The character sets specified in the G2 or G3 menus can be swapped for only one 
character at a time (that is, either G2 or G3 temporarily becomes the active character set, 
one character is generated, and then the Vf102 Tool switches back to either GO or Gl, 
whichever was the last active character set). 

9-42 Chapter 9 A!UX Reference 



The Keys menu 

See "The Keys Menu" in "The CommandShell Environment," earlier in this chapter. 

The TextEditor application 

TextEditor is a word-processing application with which you create text documents using 
the mouse and Macintosh-like editing techniques. 

The TextEditor File menu 

The TextEditor File menu, shown in Figure 9-48, contains the commands for creating, 
opening, printing, closing, and saving TextEditor files. 

New... 8€N 
Open... WO 

Close WW 
Saue ws 
Saue as ... 
Saue a Copy ... 
Reuert to Saued 

Page Setup ... 
Print Selection WP 

Quit 

Figure 9-48 The TextEditor File menu 

New 

This command creates a new document. When you choose New, you see the New 
dialog box, shown in Figure 9-49. In this dialog box, you enter a name and select a 
folder location for the document to be stored. The Command-key equivalent is 
COMMAND-N. 
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@ Saue TeHt Only 

O Saue Format Info 

Figure 9-49 The New dialog box 

Open 

=I 

( Desktop J 

ll New D 
( Cancel J 

This command allows you to open documents created with TextEditor and any text-only 
file stored in the A/UX file system. When you choose Open, you see an Open dialog box 
that allows you to select any text file. The Command-key equivalent is COMMAND-0. 

+ Note If you try to open a document that's already open in another window, 
that window is brought to the front. Whenever you open a file, it appears in 
a new window. • 

Close 

This command closes the active window. The Command-key equivalent is COMMAND-W. 

Save 

This command saves the file in the active window under the file's current name, without 
closing the window. This menu item is dimmed if the contents of the window haven't 
been modified since the file was last saved. The Command-key equivalent is COMMAND-S. 
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Save As 

This command displays a dialog box that allows you to make a copy of the currently 
active file and to save it under a different name. This action allows you to continue 
editing the file under a new name. The old file is closed under its original name without 
being changed. 

Save a Copy 

This command displays a dialog box that allows you to save the current state of the 
active window to a new file on a disk with the name Copy Of Filename. You can then 
continue editing the old file. 

Revert to Saved 

This command throws away any changes you have made since you last saved the file in 
the active window. This command is dimmed if the file has not been modified since you 
last saved it. 

Page Setup 
This command displays a dialog box that allows you to set parameters for printing a file. 
The standard Page Setup dialog box for the type of printer that you have selected in the 
Chooser is displayed. See the guide that came with your Macintosh computer for more 
information about the Page Setup dialog box. 

Print Selection 
This command prints the entire contents of the active window. 

Quit 

This command closes the TextEditor application and returns you to the Finder, first 
allowing you to save all open files. The Command-key equivalent is CoMMAND-Q. 

The TextEditor application 9-45 



The TextEditor Edit menu 

The TextEditor Edit menu, shown in Figure 9-50, contains a few special menu items in 
addition to the usual Macintosh editing commands. You use these commands to edit or 
change the contents of the active window. 

Undo OOZ 

Cut OOH 
Copy WC 
Paste WU 
Clear 

Select Rll WR 
Show Clipboard 

Format... WY 

Rlign 
Shift Left 00[ 
Shift Right WI 

Figure 9-50 The TextEditor Edit menu 

Undo 

This command nullifies the last text editing or formatting change that you made. The 
Command-key equivalent is COMMAND-Z. 

Cut 

This command copies any selected text to the Clipboard and removes the text from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a 
result of another Cut or Copy command. The Command-key equivalent is COMMAND-X. 

Copy 

This command copies any selected text to the Clipboard but does not remove it from the 
window. The text is stored in the Clipboard until it's replaced by text sent there as a 
result of another Cut or Copy command. The Command-key equivalent is CoMMAND-C. 
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Paste 

This command inserts the contents of the Clipboard into the window at the insertion 
point. The Command-key equivalent is COMMAND-V. 

Clear 

This command removes any selected text from the window. Once text is removed using 
the Clear command, it is no longer available. Choosing Clear is equivalent to pressing the 
DELETE key. 

Select All 

This command selects all of the text in the window. The Command-key equivalent is 
COMMAND-A. 

Show Clipboard 

This command displays the contents of the Clipboard in a separate window. 

Format 

This command displays a dialog box offering a selection of fonts and sizes that you can 
apply to text selected in a TextEditor window. Figure 9-51 shows the TextEditor Format 
dialog box. 

Font Size 

Chicago ~ llml 181 Auto Indent 
Courier D Show I n11isibles 
Gene11a 

UJ 
Tabs: EJ Hel11etica 

I ' I ([ ) Times 

~ 
OK 

( Cancel 

Figure 9-51 The TextEditor Format dialog box 
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The Command-key equivalent is CoMMAND-Y. 

+ Note All of the text in the active window, not just the current selection in that 
window, is shown in the selected font and font size. • 

Align 

This command aligns any selected text with the top line of the selection. 

Shift Left 

This command moves any text that you select in a TextEditor window one tab stop to the 
left. The Command-key equivalent is COMMAND-[. 

Shift Right 

This command moves any text that you select in a TextEditor window one tab stop to the 
right. The Command-key equivalent is COMMAND-]. 

+ Note If you hold down the SHIFT key while choosing Shift Left or Shift Right, the 
selected text shifts by one space rather than by one tab. • 

The TextEditor Find menu 

The TextEditor Find menu, shown in Figure 9-52, contains the commands for searching 
for and replacing text. 

Find... ~F 

Find Same ~G 

Hnd <,dpcHon 'Ji<H 
Display Selection 

Replace... ~R 

Replace Same ~T 

Figure 9-52 The TextEditor Find menu 
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Find 

This command displays the Find dialog box and finds the string that you specify. By 
default, the editor searches forward from the currently selected text in the active window 
(and does not wrap around). The Command-key equivalent is CoMMANo-F. 

Find Same 

This command repeats the last Find operation on the active window. The Command-key 
equivalent is CoMMANo-G. 

Find Selection 

This command finds the next occurrence of the search string in the active window. The 
Command-key equivalent is COMMAND-H. 

Display Selection 

This command causes the currently selected text in the active window to scroll into view. 

Replace 

This command searches for a specified string throughout a file and replaces that string 
with a different string. The Command-key equivalent is CoMMAND-R. 

Replace Same 
This command repeats the last Replace operation. The Command-key equivalent 
is COMMAND-T. 
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The TextEditor Mark menu 

A marker is a portion of text that has been given a name. Markers are useful for 
navigating within a document, and they can simplify many search expressions. The 
upper part of the TextEditor Mark menu contains the commands Mark and Unmark, and 
the lower part lists all existing markers. To jump to the location of a marker, you simply 
choose the name of the marker you want from the TextEditor Mark menu, shown in 
Figure 9-53. 

Mark... :3€M 
Unmark ... 

We 
2 

Figure 9-53 TextEditor Mark menu 

Mark 

This command displays a dialog box that allows you to create a new marker within a 
TextEditor file. The Command-key equivalent is COMMAND-M. 

Un mark 

This command displays a dialog box that allows you to remove a marker from a 
TextEditor file. 

The TextEditor Window menu 

The TextEditor Window menu allows you to tile or stack any TextEditor windows on the 
desktop. The TextEditor Windows menu is shown in Figure 9-54. 
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Tile Windows 
Stack Windows 

..//Untitled 

Figure 9-54 The TextEditor Window menu 

Tile Windows 

This command tiles any open windows as shown in Figure 9-29. 

Stack Windows 

This commands stacks any open windows as shown in Figure 9-32. 

List of open windows 

This is not a command, but a list of all currently open TextEditor windows. A check mark 
appears next to the active window. 
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10 Troubleshooting 

This chapter lists some common problems users encounter and gives some suggested 

remedies. This is by no means a complete list of all the problems that can arise. 

However, the chapter describes some useful techniques to try when you don't know 

what to do and you can't find an expert in the next office. 

This chapter contains the following sections: 

• Startup problems 

• Problems at login 

• The pointer "freezes" on the screen 

• Handling A/UX System Console alert messages 

• The printer does not respond 

• The icons have disappeared from the Finder 

• The alert sound is deactivated in CommandShell 

• The Console Emulator appears at login 

• A Macintosh application does not open 



Startup problems 

This section lists some signs of trouble when you start up and suggests some remedies. 

The computer won't start 

If the computer fails to respond when you press the POWER ON key, follow these steps: 

1. Check to see that the power cord is properly plugged in to a power source and to the 
computer itself. 

The computer might be plugged into an outlet that has no power or to an extension 
power strip that has no power. 

2. If the power source is functioning, check the cable that connects the keyboard to the 
computer. 

Perhaps your keypress is not being sent to the computer. 

A floppy disk icon with a question mark appears 

This icon means that the system cannot find the startup disk. Try the following steps: 

1 Be sure that the external hard disk is turned on. 

2 Restart the computer (with the restart switch). The computer might not have 
recognized all your disks during startup. 

3 Be sure that the SCSI cables are connected properly and that the SCSI chain is 
terminated properly. 

This is described in Setting Up Accounts and Peripherals for A/UY. 

4 Try reinstalling your Macintosh system software. 

See the installation manual that came with the software. 
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Problems at login 

When you log in to the system, several error messages might appear. A few are listed 
here. 

Unknown login name 

The following message appears: 

Sorry, that user name is unknown. Please retype the name or 

contact the system administrator. 

Either you have typed your login name incorrectly or your login name has not been 
entered correctly in I etc/passwd. 

Try retyping your login name; be sure to duplicate the uppercase and lowercase 
letters of the name exactly. A/UX is case sensitive. 

If that doesn't help, contact your system administrator. 

Incorrect password 

The following message appears: 

Sorry, your password in incorrect. Please reenter it. 

When you reenter your password, be sure to duplicate the uppercase and lowercase 
letters of the password exactly. A/UX is case sensitive. 

If that doesn't help, contact your system administrator. 

Inaccessible home directory 

The following message appears: 

Your home directory, ----, is inaccessible. Perhaps that 

directory is on a file system which is not mounted. Please 

contact the system administrator. 

Contact your system administrator. 
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The pointer "freezes" on the screen 

If the screen doesn't respond when you are working in the Finder and you can't log out 
or shut down, try the following: 

1 Check the connections between the mouse, the keyboard, and 
the computer. 

2 If these connections are in order, press CoMMAND-CONTROL-E to redisplay the 
Login dialog box. 

You can then choose Restart or Shut Down from the Special menu. 

If you are working in a CommandShell window and the screen stops accepting input 
from the keyboard, try the following steps: 

1 Check the connections between the mouse, the keyboard, and the computer. 

2 Type stty sane and press CONTROL-}. 

Although the screen doesn't respond when you type stty sane, pressing CONTROL-] 

is equivalent to pressing RETURN and should force a line break. After the line breaks, your 
screen might respond normally. 

3 If the computer is still frozen, press CoMMANo-CoNTRoL-E to redisplay the Login 
dialog box. 

You can then choose Restart or Shut Down from the Special menu. 

Handling A/UX System Console 
alert messages 

When the system alerts you to a problem, a message flashes on your screen. In order to 
read the message, you need to open CommandShell and display the A/UX System 
Console window. Follow these steps: 

10-4 Chapter 10 Troubleshooting 



1 If you are working in the A/UX Finder, you see a diamond-shaped 
icon blinking beside the CommandShell command in the Apple menu. 
Choose CommandShell. 

2 When CommandShell opens, choose A/UX System Console from the Windows 
menu. 

The A/UX System Console window appears and displays the warning message. 

For further information on the A/UX System Console window, see "Using the A/UX 
System Console" and "How A/UX Warns you of an Alert" in Chapter 3, "Using 
CommandShell." 

Typical A/UX System Console alert messages 

Shutdown warning 

Normally, when the A/UX System Console displays an alert message, it also gives 
directions for dealing with the situation. The most common alert message concerns the 
imminent shutdown of the system. 

When planning to shut down the system for maintenance, the system administrator is 
prompted to broadcast a message warning users of the fact. This gives you time to save 
your files and to log out of the system so that your work is not damaged. 

File system full 

If the message File system full blinks on and off several times a minute, a process that is 
filling up the file system might be running. If you are running the process, stop the 
process and clear the space. If you are not the sole user and you are not running the 
process, see the system administrator. 
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The printer does not respond 

If the printer does not respond when you send a file to be printed, try the following: 

1 Check the cable between the printer and the computer. Be sure that the 
connectors have been plugged in to the correct ports. 

2 Check that the printer is turned on. 

3 Be sure that the printer has paper. 

4 Be sure that the printer is selected in the Chooser. 

The icons have disappeared from the Finder 
If the desktop file becomes corrupted, you can often repair it by rebuilding the desktop 
database. One symptom of this problem is that the icons do not appear in the Finder. 
Another is that the screen inappropriately displays a message that the application you 
need can't be found. 

+ Note Rebuilding the desktop database might take 20 minutes or more. If you have 
other UNIX file systems mounted in addition to A/UX, it can save a lot of time if you 
unmount them before performing this operation. • 

Rebuild the desktop database as follows: 
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1 Choose Logout from the Special menu in the Finder. 

2 When the Login dialog box reappears, type your login name and password and 
click Login. 

3 A window with the message Login session for (and your login name) 
appears. When that message disappears, leaving a blank screen, press CoMMAND­
OPTION and hold it down until the dialog box described in Step 4 appears .. 

4 A dialog box appears, asking you whether you want to rebuild the desktop 
database. Click OK. 

The alert sound is deactivated 
in CommandShell 

If the alert sound doesn't work when it should, reactivate it as follows: 

1 Choose Control Panels in the Apple menu. 

2 Double-click the Sound icon. 

3 If the volume is turned too low, raise the indicator on the Speaker Volume bar. 

4 Click the close box. 
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The Console Emulator appears at login 

If you log in and the Console Emulator appears instead of the A/UX Finder, it might 
mean that someone was using your user account and changed the session type to 
Console Emulator. Follow these steps: 

• At the command line, enter 
mac32 

• If you want to display the A/UX Finder for 24-bit addressed software, enter 
mac24 

For further information on the Console Emulator, see Chapter 3, "Using 
CommandShell." For further information on 32-bit and 24-bit addressing, see "Changing 
Your Session Type" in Chapter 8, "Customizing Your Work Environment." 

A Macintosh application does not open 

If you are trying to use a Macintosh application and it refuses to open or respond 
properly, it might be that you do not have the proper file access permissions for the 
application. 

Follow the directions for checking permissions given in Chapter 5, "Permissions." 
If you do not have read permission for the application, you will not be able to open it. 
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11 Where to Go From Here 

This chapter presents a brief overview of the places you might look to learn more about 

A/UX and your Macintosh computer. This chapter contains the following sections: 

• Finding resource material 

• Learning more about system administration 

• Learning more about commands 

• Leaming more about creating, formatting, and printing documents 

• Leaming about developing in the A/UX environment 



Finding resource material 

Apple Computer, Inc. provides a variety of reference material to help you use your 
computer and its operating systems. You can find information in the sources listed here: 

A!UX Essential Manuals 

This set contains the guides necessary to install and configure A/UX, to use it, and to 
learn about the system and its documentation. It comes with the operating system 
software. 

Macintosh accessory set 

This set contains the system software and guides necessary to set up and use a Macintosh 
computer. This set comes with the computer. 

A/UX user's documentation suite 

This suite is available in several different bundles addressing the needs of specific users. 
You can purchase this suite through your authorized A/UX dealer or representative. 

This suite includes the following sets: 

• A/UX Essential Manuals 

• A/UX Administration Manuals 

• A/UX Programming Manuals 

For a complete list of the guides contained in each of these bundles, see 
Road Map to A!UX. 

Apple Technical Library 

This set of books describes the hardware and software of the Macintosh family of 
computers. The books are official technical publications from Apple Computer, Inc., and 
are published by Addison-Wesley Publishing Company. You can find these books in 
most well-stocked bookstores. 
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Learning more about system administration 

To help you learn about A/UX system administration tasks, Apple Computer, Inc. 
provides the following guides: 

Setting Up Accounts and Peripherals for A/llX 

This book describes how to add user accounts and peripheral devices, such as printers 
and additional hard disks, to an A/UX system. 

This guide comes in the A/UX Essential Manuals set. 

A/llX Local System Administration 

This book describes the duties of the administrator of a single A/UX system. It includes 
information on making backups of files and maintaining a healthy file system. 

This guide is available as part of the A/UX Administration Manuals set. 

A/llX Networking Essentials 

This book presents basic information for those who need to use their systems on a 
network, but whose technical expertise is below that of an experienced system 
administrator. 

This guide is available in the A/UX Essential Manuals set. 

A/llX Network System Administration 

This book describes how to set up and maintain a simple network. It includes a 
discussion of TCP/IP software utilities, Network Information (Yellow Pages) services, 
and Network File Services (NFS). It also contains information on how to print using the 
AppleTalk network and AppleTalk protocol. 

This guide is part of the A/UX Administration Manuals set. 
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A/DX System Administrator's Reference 

This reference manual contains an entry for each system administration command. Each 
entry gives the command name, describes the syntax, lists the associated files, and 
provides cross-references. This reference includes a section of entries for device drivers 
and device interfaces and a section of entries for system-maintenance procedures. 

This reference is part of the A/UX Administration Manuals set. 

Learning more about commands 

You can use the following resources to learn about commands: 

Type commandname CoMMAND-K in a CommandShell window. 

In response, the computer displays a Commando dialog box that describes available 
options and demonstrates the correct command syntax. For further information on 
Commando, see Chapter 4, "Using UNIX Commands and Commando." 

Enter man commandname in a CommandShell window. 

In response, the computer displays the reference manual page that describes the 
command in detail. You can read through the entire description or find only the options 
that you need. Each manual entry presents an example of the correct syntax. 

A/DX Command Reference 

This reference manual contains an entry for each command. Each entry lists the 
command name, describes the syntax, and lists the associated files and commands. This 
manual also includes similar entries about the game programs included with A/UX. 

A/DX Reference Summary and Index 

This guide catalogs the other reference manuals in three ways. It presents a list of all 
A/UX commands by function, synopses of all A/UX commands organized alphabetically, 
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and a keyword index of all the command reference entries. The command synopses and 
list of commands by function lead you to the information in A!UX Command Reference 
and A/UX System Administrator's Reference. The index serves all volumes. 

These guides are part of the A/UX Programming Manuals set. 

Learning more about creating, formatting, 
and printing documents 

To learn more about using the A/UX text-processing and text-formatting tools, see the 
guides listed here: 

A/UX Text-Editing Tools 

This book describes the editing tools provided with A/UX. It contains detailed 
instructions and sample sessions for using vi, ex, ed, and s ed. This guide is part of the 
A/UX Administration Manuals set. 

A/UX Text-Processing Tools 

This book describes the text-formatting tools that make up AT&T's Documentor's 
Workbench (DWB), version 3.0. It also describes other text-processing tools that come 
with A/UX, such as grap and Transcript. 

This guide is available in the A/UX Administration Manuals set. 

To find out more about using Macintosh applications to write, design, lay out, and 
print documents, see the guides that come with each application. 

To learn about printing documents with A/UX tools you can consult several guides. 

Setting Up Accounts and Peripherals for A/UX 

This book describes how to set up a printer to use with your computer. It comes with the 
A/UX software in the A/UX Essential Manuals set. 
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A/UX Networking Essentials 

This book describes how to add a printer or a computer to a network and how to print 
on a network. It is available in the Essential Manuals set. 

A/VX Local System Administration 

This book describes the duties of a system administrator for a single A/UX system. It 
includes information on setting up and configuring the kernel for peripheral devices, 
such as printers. 

This guide is part of the A/UX Administration Manuals set. 

A/UX Shells and Shell Programming 

This book describes the Bourne, C, and Korn shell programs distributed with 
A!UX. You use the shell language to communicate with the operating system to 
accomplish tasks. 

This guide is available in the A/UX Programming Manuals set. 

Learning about developing in 
the A/UX environment 

To learn about development platforms and tools, see the following guides, all of which 
are part of the A/UX Programming Manuals set: 

A/UX Toolbox: Macintosh ROM Intetface 

This book describes what the A/UX Toolbox is and how to use the A/UX Toolbox to 
implement the Macintosh user interface on applications that run under the A/UX 
operating system. 
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A/UX Programming Languages and Tools, Volumes 1 and 2 

These books describe the programming languages, their accompanying subroutine 
libraries, the utility programs, the compilers, and the associated program-generating 
tools provided with A/UX. 

A/lJX Programmer's Reference, Volumes 1 and 2 

These reference manuals contains information for programmers. These 
manuals consists of entries for system calls, subroutines, file formats, and 
miscellaneous facilities. 

A/lJX Porting Guide 

This book describes how to port existing UNIX applications to A/UX and presents a 
comprehensive overview of the porting process. 

Building A/UX Device Drivers 

This book describes how to build A/UX device drivers and how peripheral devices 
interact with A/UX. 

This book is available from APDA as part of the set called A/UX Device Drivers Kit. 

A/lJX Network Applications Programming 

This book describes the A/UX programming interfaces for the programmer who wishes 
to write network applications based on AppleTalk, Network File Services (NFS), Yellow 
Pages, and Internet software. 

This book is available from APDA. 
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Glossary 

A/UX command The name of an executable file 
distributed with the NUX operating system. For 
example, ls is a binary executable file distributed in 
the /bin directory that prints directory information to 
the terminal; typing /bin/ls as a command causes the 
file to execute. See also shell program. 
A/UX Startup The Macintosh application that launches 
NUX. Under most circumstances, if you cancel the 
automatic launch of NUX, you are in MacPartition 
from which you can run some system administration 
commands. 

A/UX Toolbox Libraries, subroutines, and utilities that 
provide access from NUX to the Macintosh Operating 
System and to the Macintosh Toolbox in the Macintosh 
ROM. 

absolute pathname The complete name of a file, given 
by listing all of the directories leading down to that file, 
starting from root ( I) and concluding with the filename 
itself. The directories leading to the file are separated 
from each other and from the filename by slashes. For 
example, /etc/passwd is the absolute pathname of 
the system password file, passwd, located in the etc 

directory beneath the root ( I) directory. 

access class In UNIX, designation for access 
permissions to NUX files and directories; the three 
access classes are owner, group, and others. The 

owner is the person who created the file; the group 
consists of people, including the owner, who typically 
work together and need to share files easily; the others 
class consists of other people using a local system. A file 
or directory can be set to have different access 
permissions for each class. 

active window The window with which the user can 
interact, and where the next action takes place. An active 
window title bar is highlighted; it is in the foreground of 
the screen. 

alias In Macintosh terminology, an icon that represents 
a specific file, folder, or disk icon, and that you can open 
in place of the original icon. This allows you to leave the 
original file in its place while moving the alias icon to 
another place in the file system for convenience. By 
default, the alias icon uses the name of the original file, 
plus the word alias. 
application A program used to perform a particular 
task, such as computer-aided drawing, document 
preparation, accounting, or payroll management. 

argument A piece of information included on the 
command line in addition to the command; the shell 
passes this information to the command, which then 
modifies its execution in some particular way. Filenames, 
for example, are often supplied as arguments to com­
mands, so that a command operates on the named file. 

GL-1 



argument list All the arguments passed to a program. 

ASCII text file See text file. 

background job A process executed by the Korn or C 
shell such that the shell is not suspended while waiting 
for the process to finish. By default, a process starts in 
the foreground, and the shell waits until the process has 
finished executing before the shell returns its prompt. 
You run a process in the background by appending an 
ampersand character(&) to the end of a command line; 
the shell prompt reappears instantly, allowing you to run 
multiple processes simultaneously. See also foreground 
job. 

backslash The \ character, often used as an escape 
character. 

binary file A file, such as a machine-language program, 
whose data is to be interpreted in binary form. See also 
text file. 

boot To start an operating system by loading it into the 
computer memory. 

boot device The peripheral device that reads the initial 
startup instructions of an operating system. 

boot disk The disk that contains the initial startup 
instructions for an operating system. 

Bourne shell The standard UNIX System V command 
interpreter. See also shell. 

button A push-button image in dialog boxes that you 
click to designate something resembling an action. 

case sensitive Able to distinguish between uppercase 
characters and lowercase characters. Programming 
languages are case sensitive when they require all 
uppercase letters, all lowercase letters, or proper use of 
uppercase and lowercase letters. For example, AppleSoft 
BASIC recognizes only uppercase letters. Instant Pascal, 
however, is not case sensitive; you can use any 
combination of uppercase and lowercase letters. 

central processing unit (CPU) The "brain" of the 
computer; the microprocessor that performs the actual 
computations in machine language. 
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check box A small box associated with an option in a 
dialog box or window. When you click the check box, 
you can change the option or affect related options. An 
option is on when you see an x in the check box. 

choose To pick a command by dragging through a 
menu. You normally choose a command after you select 
something for the program to act on, for example, 
selecting a disk and choosing the Open command from 
the File menu. 

click (verb) To position the pointer on something, and 
then press and quickly release the mouse button. (noun) 
The act of clicking. 

close box The small box on the left side of the title bar 
of an active window. Clicking it closes the window. 

command line The entire input string that you enter in 
response to the shell prompt to issue a command or to 
start a program. The command line includes the 
command itself and any arguments and options. 

command-line interface The convention for 
interacting with A/UX by entering a command line. 

command mode The operating state in which a 
program (such as a text editor) interprets the characters 
you type as commands, rather than as data to be entered 
into a file. 

Commando A command-building tool in A/UX that 
displays a dialog box for A/UX commands. This allows 
you to select the options and arguements you want 
without having to use the command-line interface. 
Commando also allows you to pipe commands. 

CommandShell An A/UX application that displays a 
window for using the command-line interface. You 
can manipulate CommandShell windows just as you do 
Macintosh windows. 

control character A nonprinting character that orders 
an action to be performed. For example, the interrupt 
character (by default, entered by holding down The 
CONTROL key and pressing C) interrupts program 
execution and returns you to the shell prompt. 



C shell The standard BSD and A/UX command 
interpreter. See also shell. 

current directory The directory in which you are 
currently working. This directory is the starting reference 
point for all relative pathnames you enter. Also called 
the working directory. 

cursor A symbol on the screen that indicates your 
position on the command line or inside a file. The cursor 
is usually a small box or an underscore, and it usually 
blinks. 

device A part of the computer, or a piece of external 
equipment, that can transfer information. 

device driver Kernel-level software that controls the 
exchange of information between a process and a 
device. 

dialog box A box that contains a message requesting 
information from you. Sometimes the message warns 
you that you're asking your computer to do something it 
can't do, or that you're about to destroy some of your 
information. In these cases, the message is often 
accompanied by a beep. 

directory A file that contains a list of other files; similar 
to a folder in a Macintosh hierarchical file system. 

directory hierarchy The collection of all files on the 
currently mounted file systems. See also hierarchy. 

dot file A file whose filename begins with a dot. UNIX 
reads these files for specific information concerning login 
and configuration of the environment, the shell, and so 
on. 

double click (noun) Two mouse clicks in quick 
succession, interpreted as a single command. The action 
of a double click is different from that of a single click: 
for example, clicking an icon selects the icon; double­
clicking an icon opens it. (verb) To position the pointer 
where you want an action to take place, and then press 
and release the mouse button twice in quick succession 
without moving the mouse. 

drag To position the pointer on an object on the screen, 
press and hold the mouse button, move the mouse, and 
release the mouse button. When you release the mouse 
button, you either confirm a selection or move the object 
to a new location. 

environment A list of characteristics that identifies you 
to the system and influences and constrains your access 
to it. You can modify many of these characteristics. See 
environment variable. 

environment variable An assigned value that controls 
your use and access of the system and that is available to 
the current shell and all the child processes invoked from 
that shell. 

Ethernet A hardware medium designed to provide high 
speed interconnection between computers. 

Executable file A file that contains instructions or 
commands that direct the activity of the computer. See 
also program. 

field A data item separated from other data by blanks, 
tabs, or other specific delimiters. 

file (1) For UNIX operating systems, an array of bytes; 
no other structure is implied by UNIX systems, which 
even treat peripheral devices like files. (2) For the 
Macintosh Operating System, any named, ordered 
collection of information stored on a disk. Application 
programs and documents are examples of files. You 
create a file when you type text or draw graphics, give 
the material a name, and save it on a disk. 

filename On UNIX System V operating systems, the 
name of a file, consisting of up to 14 characters and 
specified without listing the directory under which the 
file is located. For example, passwd is the filename for 
the system password file. See also pathname. 

file system A logical device that contains the data 
structures that implement all or part of the directory 
hierarchy. 
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Finder The application that maintains the Macintosh 
desktop and starts up other programs at the request of 
the user. You use it to manage documents and 
applications and to get information to and from disks. It 
controls the desktop you see upon starting up your 
computer, unless you specified a different session type. 

folder (1) A holder of documents and applications on 
the Macintosh desktop. Macintosh folders, like UNIX file 
system directories, allow you to organize information in 
a hierarchical fashion. (2) For the BSD mailx program, 
a file that you create for saving similar mail messages. 

font A collection of print characters unified by a 
distinctive look. Times Roman, for example, is the 
default font for troff. 

foreground job The process attached to the terminal. 
The shell waits until the foreground job finishs executing 
before the shell returns its prompt and gives you control 
again of the terminal. See also background job. 

fork One of the two parts of a Macintosh file; the data 
fork contains data accessed through the Macintosh File 
Manager, and the resource fork contains data used by the 
application, such as menus, fonts, and icons. 

format (1) To divide a disk into tracks and sectors 
where information can be stored. Blank disks must be 
formatted before you can save information on them. (2) 
To process a text file for output with a utility such as 
nroff or troff. 

group ID (GID) A number that indicates a group to 
which you belong at login time. As a member of a group, 
you have access to certain files and directories shared by 
other members of your group. Each user login name has 
at least one group ID associated with it. 

group permission Permission for the designated 
group of users to use a file or a directory. 

hierarchical file system (HFS) A method of 
organization in which disk files are grouped together 
within directories and subdirectories (folders within 
folders). HFS is used on hard disks and on floppy disks. 
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In a hierarchical file system, a file is specified by its 
pathname, rather than by a single filename. 

hierarchy A directory and any files or subdirectories 
residing under it. See also directory hierarchy. 

highlight To make something visually distinct. For 
example, when you select a block of text using 
MacWrite, the selected text is highlighted-it appears as 
light letters on a dark background, rather than dark 
letters on a light background. 

home directory Usually the first directory you enter 
upon login, as designated in the file /etc/passwd. You 
can tailor your environment by modifying various files in 
your home directory. 

home directory folder The folder that represents the 
user's home directory on the NUX Finder. 

icon An image on the screen, usually representing an 
item such as a file, document, disk, or application 
program that you can select and open. 

interactive editor A utility for entering and 
manipulating text while you view the text. TextEditor 
and vi are both interactive. 

job A process that can be stopped, restarted, and moved 
between foreground and background processing from 
the C shell or Korn shell. 

job number The identification number of a process 
executed in the background under the C shell or Korn 
shell. The job number appears next to the command 
name when you execute the jobs command. 

kernel A UNIX program that manages the system 
hardware. For example, the kernel manages files, 
communicates with peripherals, and handles other low­
level resource management tasks. 

Korn shell A command interpreter that combines many 
of the best features found in the standard System V shell 
(the Bourne shell) and the standard BSD shell (the C 
shell). See also shell. 

list To display on a monitor, or print on a printer, the 
contents of memory or of a file. 



local system The computer from which a user 
originates a network command. See also remote 
system. 

local system administration Management of a single 
computer system. This includes such functions as starting 
up and shutting down the system, adding and removing 
user accounts, and backing up and restoring data. See 
also network administration. 

log in To identify yourself to the system by entering the 
login name of your account and your account password. 

login name The name of a user's account. Used for 
identification purposes. Same as the account name. 

login prompt The prompt (usually login: on UNIX 
systems) by which a system tells you that it is ready to 
accept your login name. 

login shell The shell that automatically runs after you 
successfully log in. See also shell. 

long listing (ls -1) A listing of the files in a directory. 
This is called a long listing because it lists more 
information than a simple listing, including the 
permissions, the size of each file, the owner, the number 
of links, and the date on which the file was last modified. 

lpr system A collection of programs and files that are 
used to manage UNIX printer operations. These include 
the print spooler and a series of maintenance commands. 

Macintosh Operating System The lowest-level 
software in the Macintosh. It does basic tasks such as 
1/0, memory management, and interrupt handling. 

Macintosh user interface The standard conventions 
for interacting with Macintosh computers. The interface 
ensures users a consistent means of interacting with all 
Macintosh computers and the applications designed to 
run on them. 

MacPartition The name of the partition that contains 
the A/UX Startup application and some A/UX utilities 
such as f sck and ed. 

manual page (or "man" page A screen display of the 
material in the A!UX Command Reference concerning a 

specific command. Display a man page by entering man 

commandname in CommandShell. 

menu A list of choices presented by an application 
program, from which you can select an action. With 
Macintosh-style programs, menus appear when you use 
the mouse to point to and press on titles in the menu bar 
at the top of the screen. Dragging through the menu and 
releasing the mouse button while a command is 
highlighted chooses that command. 

mount To install a file system onto the directory 
hierarchy. See also unmount. 

mouse A small device you move around on a flat 
surface next to your computer. The mouse controls a 
pointer on the screen whose movements correspond to 
those of the mouse. You use the pointer to select 
operations, move data, and draw with in graphics 
programs. 

mouse button The button on the top of the mouse. In 
general, pressing the mouse button initiates some action 
on whatever is under the pointer, and releasing the 
button confirms the action. 

multitasking The ability of an operating system like 
A/UX to execute multiple processes simultaneously by 
sharing its central processor and peripherals among 
processes. 

multi-user A mode or ability of an operating system to 
support several people using the same computer 
simultaneously. 

network A collection of interconnected, individually 
controlled computers, along with the hardware and 
software used to connect them. A network allows users 
to share data and peripheral devices and to exchange 
electronic mail. 

network administration The management of the 
software and hardware that connects computers in a 
network. This includes such functions as assigning 
addresses to hosts, maintaining network data files across 
the network, and setting up internetwork routing. See 
also local system administration. 
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operating system Low-level software that controls a 
computer by performing such basic tasks as I/0, memory 
management, and interrupt handling. 

option An argument included on the command line that 
instructs a program to alter its output or change its mode 
of execution. An option is usually a hyphen followed by 
one or more characters. For example, the -1 option to 
the ls command makes this utility print extra 
information, such as the date a file was last saved. 
Options are sometimes referred to as flag options, or 
command options. 

others permission Permission to use a file, granted to 
all the users of a system who are neither the owner of the 
file nor are in the designated group. 

page offset The left margin of a printed page. The 
default page offset for nroff and troff is 1 inch. 

pathname A filename preceded by its containing 
directory. A pathname can contain a list of directories, 
separated from the filename and from each other by 
slashes. Each item in a pathname is located in the 
directory named to its left. For example I etc /passwd 

is a pathname for the system password file, passwd, 

located in the etc directory beneath the root (I) 

directory. See also absolute pathname and relative 
pathname. 

peripheral device A piece of hardware, such as a disk 
drive, modem, printer, or terminal, that is connected to a 
computer and used for reading or writing data. 

permissions Authorization to read, write, or execute a 
file or directory. Under UNIX operating systems, each 
capability is assigned on an individual, group, and 
system-wide basis. Also called the file mode. 

physical disk The entire set of disk blocks that exist on 
the actual disk drive hardware. 

pipe (noun) (1) A command line that connects two or 
more commands in a series so that the output of one 
command becomes the input to the next. (2) An 
intermediate file in which data is passed from one 
process to another. (verb) To connect two or more 
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commands in a series so that the output of one command 
becomes the input to the next. 

pipeline A command line that contains one or more 
pipes. 

pointer (1) An arrow or other symbol on the screen that 
moves as you move the mouse. You use the pointer to 
choose commands, select and move icons and text, and 
draw images. (2) An item of information consisting of the 
memory address of some other item. The 68030 chip 
uses one of its internal registers as a pointer to the top of 
the stack. 

port (noun) (1) A socket on the back panel of a 
computer where you plug in a cable for connection to a 
network or a peripheral device. (2) A connection 
between the central processing unit and main 
memory or a device (such as a terminal) for transferring 
data. (verb) To move software from one computer 
environment to another. 

print spooler A utility that writes a representation of a 
printed image of a document to disk or to memory, 
schedules it to print in a queue of other jobs, and then 
prints it. 

process An instance of a program in execution. Usually 
one copy of a program is stored on a UNIX system like 
A/UX, but multiple instances of the program-each 
having its own address space-can be executed 
simultaneously as separate processes. 

program A file containing coded instructions to the 
computer. A compiled program is a file created first in 
source code, then transformed by the compiler into 
object code. A shell script is a program that does not 
need to be compiled because it is interpreted by the 
shell. 

prompt A character or string of characters displayed on 
the terminal when a program is waiting for input from 
you. The Bourne and Korn shells, for example, are set by 
default to display the dollar sign($) as their prompt; the 
C shell is set by default to display the percentage sign 
(%) as its prompt. 



pull-down menu A menu that is hidden until you 
move the pointer to its title and press the mouse button. 

radio button A common type of control in dialog 
boxes. Radio buttons are small circles organized into 
families. Clicking any button on turns off all the others in 
the family, like the buttons on a car radio. 

redirection A feature of the shell that allows you to 
pass the output of a command to a file or device instead 
of to the terminal screen, and to supply a command with 
input from a file or device instead of from the keyboard. 

relative pathname The name of a file, given by listing 
the directories leading to that file in relation to the 
current working directory. Directories common to both 
the working directory and the file are not included in the 
relative pathname. See also absolute pathname. 

remote system On a network, any computer other than 
the local system. 

resource fork The part of a file that contains data used 
by an application, such as menus, fonts, and icons. The 
code of an executable file is also stored in the resource 
fork. Sometimes called a resource file. 

ROM An acronym for read-only memory, which is 
memory whose contents can be read, but not changed, 
and is used for storing permanent information. For 
example, the ROM in the Macintosh contains the routines 
for the Macintosh user interface. 

root (1) The top directory in a UNIX directory hierarchy. 
Written as a slash(/), it is the first element in every 
absolute pathname. (2) The user with unlimited system 
privileges. Also called the superuser. 

root directory See root (1). 

root file system The file system that is always present 
on a UNIX system; the root file system can never be 
unmounted. 

root user See root (2). 

script A file containing commands. See also shell 
script. 

scroll bar A rectangular bar that can be along the right 
or bottom of a window. Clicking or dragging in the scroll 
bar causes your view of the document to change. 

SCSI See Small Computer System Interface. 

select (verb) To designate where the next action takes 
place. To select something using a mouse; you click an 
icon or drag across text. In some applications, you can 
select items in menus by typing a letter or number at a 
prompt, by using a combination keypress, or by using 
arrow keys. (noun) A command to a device such as a 
printer to place it into a condition to receive data. 

shell A utility that accepts your commands, interprets 
them, and passes them on to the appropriate programs 
for execution. A/UX provides three shells: Bourne, C, 
and Korn. Each can be used as an interpreted 
programming language. Through shell variables and 
environment variables, you can tailor the environment 
of your shell for your own needs. 

shell program A series of commands to be executed 
by the shell. A shell program can be entered at the shell 
prompt or stored in a file. Shell programs that are stored 
in files are referred to as shell scripts. Shell programs 
are sometimes called user-defined commands. 

shell prompt A character or string of characters 
displayed on the terminal to show that the shell is 
waiting for input from the user. The Bourne and Korn 
shells, for example, are set by default to display the 
dollar sign($) as their prompt; the C shell is set by 
default to display the percentage sign(%) as its prompt. 

shell script A shell program contained in a text file. 
Entering the name of the shell script from the command 
line executes the commands listed in the shell script. See 
shell program. 

Shift-click A technique that enables you to extend or 
shorten a selection by positioning the pointer at the end 
of what you want to select and holding down the Shift 
key while clicking the mouse button. 
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shutdown permission Access granted to the root user 
to run the shutdown program. The shutdown program 
brings the system to a nearly inactive state before you 
tum off its power. 

size box A box in the lower-right comer of some active 
windows. Dragging the size box resizes the window. 

Small Computer System Interface (SCSI) A 
specification of mechanical, electrical, and functional 
standards for connecting small computers with intelligent 
peripherals such as hard disks, printers, and optical 
disks. 

spooler See print spooler. 

Stand-Alone Shell The A/UX Startup application that 
launches A/UX. You can run a limited number of system 
administration commands from the Stand-Alone Shell. 

standard error output The data stream used for error 
messages returned by a program. By default, the shell 
directs error output to your terminal screen. 

standard input The data stream used for input to a 
command. By default, the shell accepts as input the 
characters you type from your keyboard. The less-than 
sign ( <) directs the shell to accept input from a file or 
device. 

standard output The data stream used for output from 
a command. By default, the shell directs this to the 
terminal screen. The greater-than sign(>) directs the 
shell to write the output to a file or device. 

substitute user (su) The substitute user command (su) 
allows you to work in an account other than the one you 
are currently logged in to. 

superuser The user with unlimited system privileges. 
Also called root. 

System V The AT&T standard UNIX operating system. 
System V Release 2 forms the foundation of the A/UX 
system. 

System Folder A folder containing Macintosh system 
software. An A/UX system contains a minimum of five 
system folders. 
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system software Software that supports application 
programs by managing memory and by communicating 
with input and output devices. 

terminal A device through which you interact with the 
computer; namely, the keyboard, mouse, or other input 
device and the monitor. See also console. 

terminal emulation An imitation of a terminal type. 

text box The place or places in any dialog box where 
you can type information. 

text file A file containing information expressed in text 
form and whose contents are interpreted as characters 
using the American Standard Code for Information 
Interchange (ASCII) format. See also binary file. 

text-only file See text file. 

32-bit addressed See 32-bit clean. 

32-bit clean Macintosh applications whose memory 
addressing is completely compatible with A/UX. 
Software that is not 32-bit clean is referred to as 24-bit 
addressed. A/UX allows you to select a 24-bit addressed 
session type if you need to use earlier Macintosh 
applications that are not 32-bit clean. 

tile To arrange a group of windows so that their edges 
are touching one another (like the tiles on a tiled floor), 
rather than overlapping one another. 

title bar The horizontal bar at the top of a window that 
shows the name of the window. When the window is 
active, the title bar is highlighted with a series of 
horizontal lines. You can move the window by dragging 
the title bar. 

tree structure The layout of a UNIX directory 
hierarchy. Organized like an inverted tree, the directory 
hierarchy begins with the root directory at the top. 
Branching downward from the root are the rest of the 
directories and files in the system. 

24-bit addressed See 32-bit clean. 



UNIX operating system A general-purpose time­
sharing system and related set of utilities, originally 
developed at AT&T Bell Laboratories. A/UX is an 
enhanced version of the UNIX operating system for 
certain Macintosh computers. 

unmount To remove a file system from the directory 
hierarchy. See also mount. 
user account The permission to log in to A/UX under 
an assigned login name, usually with a unique password, 
and usually with a specifically assigned home directory. 

user interface The rules and conventions by which a 
computer system communicates with the person 
operating it. 

user name See login name. 
user permission Permission for the ower of the file to 
use it. If a file has only user permission, no other users 
can read it, write to it, or run it. 

utility A software tool used for building or maintaining 
systems or applications. UNIX provides hundreds of 
utilities, including compilers, editors, and text formatters. 

window (1) The area that displays information on a 
desktop; you view a document through a window. You 
can open or close a window, move it around on the 
desktop, and sometimes change its size, scroll through it, 
and edit its contents. (2) The portion of a collection of 
information (such as a document, picture, or worksheet) 
that is visible in a viewport on the display screen. Each 
window is internally represented in a window record. 

working directory See current directory. 
world permission See others permissions. 

write permission Permission to write to a file. 

zoom box A small box in the top-right comer of some 
windows. Clicking on the zoom box resizes the window 
so that you can see all of its contents (if possible); 
clicking it again returns the window to its original size. 
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Active Window Settings (in 

CommandShell) 3-12 to 3-13, 9-31 
Align 6-21, 9-51 
cd 4-5 to 4-6 
Change Session Type 8-2 
Chooser 7-4 
chown 5-3 
chsh 8-8 
Clean Up Window 9-17 
Clear (in CommandShell) 9-23 
Clear (in Finder) 9-11 
Clear Lines Off Top 

(in CommandShell) 3-10, 9-30 
Close (in CommandShell) 3-8,. 9-21 
Close (in TextEditor) 9-44 
Close All (in Finder) 9-5 
Close All Windows 

(in CommandShell) 3-9, 9-21 
Close Window (in Finder) 9-4 
Commando 9-23 

CommandShell 3-2 to 3-3, 9-19 
Copy (in Finder) 9-10 
Copy (in CommandShell) 3-18. 9-22 
Copy (in TextEditor) 9-46 
csh 8-8 
cursor 9-32 
Cut (in CommandShell) 9-22 
Cut (in Finder) 9-10 
Cut (in TextEditor) 6-7, 9-46 
Date 9-15 
Don't Record Lines Off Top (in 

CommandShell) 3-7, 9-30 
Duplicate 9-7 
Eject Disk 9-17 
EmptyTrash 9-17 
Erase Disk 9-17 
exit 4-19 
Find 9-8 to 9-9 
Find Again 9-9 
Finder 9-19 
Finder Shortcuts 9-18 
Find (in TextEditor) 6-15, 9-49 
Format 6-18 to 6-21, 9-47 
Full Height (in CommandShell) 9-27 
Get Info (in Finder) 9-5 
grep 4-20 to 4-23 
Hide Application 9-19 
Hide CommandShell 3-22 
Hide "Window Name' (in 

CommandShell) 9-28 
Icon 9-12 
Keypad 9-32 
Kind 9-14 
ksh 8-8 
Label 9-15 
Logout 8-3, 9-17 
lpq 7-8 
lpr 7-6 to 7-8 
lprm 7-9 
ls 4-6 to 4-9 
Make Alias 1-6, 9-8 
man 4-24 
Mark 6-26 
Name 9-13 



New (in CommandShell) 3-4, 9-22 
New (in TextEditor) 9-43 
New Folder (in Finder) 9-4 
New Window Settings (in 

CommandShell) 3-13 to 3-14, 9-31 
Notification Levels (in 

CommandShell) 3-11, 9-31 
Open (in CommandShell) 9-20 
Open (in Finder) 9-4 
Open (in TextEditor) 6-11, 9-44 
Page Setup (in CommandShell) 

9-21 
Page Setup (in Finder) 7-10, 9-9 
Page Setup (in TextEditor) 9-45 
Paste (in CommandShell) 3-18, 9-24 
Paste (in Finder) 9-11 
Paste (in TextEditor) 6-8, 9-47 
Previous Window (in 

CommandShell) 9-28 
Print 7-5 
Print (in Finder) 9-4 
Print Selection 7-9 
Print Selection (in CommandShell) 

3-20, 9-21 
Print Selection (in TextEditor) 9-45 
Print Window (in Finder) 9-10 
PutAway 9-8 
pwd 4-2 to 4-3, 4-5 
Quit (at startup) 2-10 
Quit (in CommandShell) 9-21 
Quit (in TextEditor) 6-29, 9-45 
Replace 6-16 
Restart 1-21, 2-10, 9-18 
Restore From Preferences (in 

CommandShell) 3-15, 9-31 
Revert to Saved (in TextEditor) 

6-10, 6-14, 9-45 
Rotate Windows (in CommandShell) 

9-28 
Save a Copy (in TextEditor) 6-10, 

9-45 
Save As (in TextEditor) 6-9, 9-45 
Save (in TextEditor) 6-9, 9-44 

Save Preferences (in CommandShell) 
3-14to3-15, 9-31 

Save Selection (in CommandShell) 
3-19 to 3-20, 9-21 

Select All (in CommandShell) 9-23 
Select All (in Finder) 9-11 
Select All (in TextEditor) 9-47 
settimezone 8-11 
sh 8-8 
Sharing (in Finder) 9-6 
Shift Left/Right 6-21, 9-48 
Show All Windows (in 

CommandShell) 9-28 
Show Balloons 9-18 
Show Clipboard (in Finder) 9-11 
Show Clipboard (in TextEditor) 6-7, 

9-47 
Show Invisibles 6-20 to 6-21 
Shut Down 1-21 to 1-22, 9-17 
Size 9-14 
Small Icon 9-12 
Stack Windows 6-24 
Standard Positions (in 

CommandShell) 9-27 
Standard Size (in CommandShell) 

9-27 
SU 4-18 tO 4-19 
Terminal Settings 3-16 to 3-17 
Tile Horizontal (in CommandShell) 

9-25 
Tile (in CommandShell) 9-24 
Tile Vertical (in CommandShell) 

9-26 
Tile Windows 6-23 
Undo (in CommandShell) 9-22 
Undo (in Finder) 9-10 
Undo (in TextEditor) 9-46 
UNIX Permissions 5-8, 9-6 to 9-7 
Unmark 6-27 
whoami 4-4 to 4-5 
Zoom Window (in CommandShell) 

3-14, 9-28 

Commands menu (in CommandShell) 
9-30 

CommandShell 2-3 
activating 3-2 to 3-3 
alerts 3-11 
displaying hidden files in 8-12 
leaving 3-20 to 3-21 
switching to Finder from 3-3 

CommandShell windows. See also A/UX 
System Console window 

active 3-2 to 3-3, 3-8 
arranging 3-5 to 3-6, 9-25 to 9-29 
changing appearance of 3-13 to 

3-14 
changing default settings of 3-13 to 

3-14 
changing font of text 3-18 to 3-19 
closing 3-8 to 3-9 
copying text 3-18 
customizing 3-12 to 3-15 
displaying 3-4 to 3-6 
erasing recorded lines 3-8 
maximum number open 3-4 
pasting text into 3-18 
print contents 3-20 
printing from 7-9 to 7-10 
recording lines scrolled off top 3-6 
restoring preferred layout 3-15 
saving the contents in a file 3-19 to 

3-20 
selecting text 3-17 
shrinking 3-6 
stop recording lines scrolled off top 

3-7 
tiling 3-5 

commands (UNIX) 
learning more about 11-4to11-5 
linking with a pipe 4-27 to 4-29 

computer frozen 10-4 
Console Emulator appears at login 10-8 
Console Emulator option 8-2 
Copy command (in CommandShell) 

3-18, 9-22 
Copy command (in Finder) 9-10 
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Copy command (in TextEditor) 9-46 
copying a file 2-14 
copying text between documents 

(TextEditor) 6-13 to 6-14 
copying text from CommandShell 

windows 3-18 
creating 

a new document (in TextEditor) 
6-3 to 6-10 

a personal System Folder 8-6 to 8-7 
current directory 4-2 

and CommandShell 2-17, 2-19 
defined 2-17 
determining 4-5 
listing the contents of 4-6 to 4-9 

Cursor command 9-32 
Customizing CommandShell windows 

3-12to3-15 
Cut command (in CommandShell) 9-22 
Cut command (in Finder) 9-10 
Cut command (in TextEditor) 6-7, 9-46 
cutting and pasting text (in TextEditor) 

6-6 to 6-8 

D 
data file icon, binary 2-5 
date 

setting 8-11 to 8-12 
Date command 9-15 
default file access permissions 5-5 
default shell 3-2, 8-8 
default system time setting 8-11 
default text editor 

changing 8-9 to 8-10 
deleting text (in TextEditor) 6-12 
desk accessories 9-3 
desktop database, rebuilding 10-6to10-7 
determining your current directory 4-5 
developing for A/UX, learning more 

about 11-6 to 11-7 

IN-4 Index 

directories 
current 2-17 
changing 4-5 to 4-6 
defined 2-3 
slash (/) 2-14 to 2-17 

directory and folder access permissions 
changing 5-7 to 5-11 
default settings 5-5 
types of 5-3 to 5-5 

disk formatting dialog boxes 2-12 
disk initialization dialog boxes 2-13 
disks, floppy, using to make backups 

2-11 to 2-14 
displaying 

Commando dialog boxes 4-10 
to 4-11 

CommandShell windows 3-4 to 3-6 
hidden files 8-12 
invisible characters 6-20 to 6-21 
man pages 4-23 to 4-27 

Don't Record Lines Off Top command 
(in CommandShell) 3-7, 9-30 

documentation 11-1 to 11-7 
dot files 8-9 

displaying and hiding 8-12 to 8-14 
drop box folder, permissions 5-4 to 5-5 
drop box icon 2-4 
Duplicate command 9-7 

execute permission 
files 5-2 
folders 5-4 

exit command 4-19 
exiting CommandShell 3-20 to 3-21 

F 
file access permissions 

default settings 5-5 
types of 5-2 

file icons 2-5, 2-6 
File menu (in CommandShell) 9-20 

to 9-21 
File menu (in Finder) 9-3 to 9-10 
File menu (in TextEditor) 9-43 to 9-45 
file permissions 

changing 5-5 
default settings 5-5 
restricting 5-2 
types of 5-2 

files 
access permissions, changing 5-7 to 

5-9 
access permissions, default 5-5 
backing up 2-10 to 2-14 
copying 2-13 
icons 2-5 to 2-6 
listing 4-6 to 4-9 
naming or renaming 2-7 

E restoring 2-13 to 2-14 
editing an existing file (TextEditor) 6-10 restricting access to 5-2 

to 6-17 specifying location 2-14 to 2-19 
Edit menu (in CommandShell) 9-23 file sharing permissions 5-11 to 5-12 
Edit menu (in Finder) 9-10 to 9-11 and CommandShell 2-27 
Edit menu (in TextEditor) 9-46 File system full message 10-5 
Eject Disk command 9-17 file system icons 2-6 
Empty Trash command 9-17 Find Again command 9-9 
entering text (TextEditor) 6-5 to 6-6 Find command 9-8 to 9-9 
Erase Disk command 9-17 Find command (in TextEditor) 6-15, 
erasing recorded window lines 3-8 9-49 
executable file icon (no read permission) Find dialog box 9-8 

2-6 Find dialog box (in TextEditor) 6-15 
executable files 4-2 



Finder 
A/UX 2-2 to 2-3 
hiding dot files 8-13 to 8-14 
icons 2-4 to 2-6 
icons disappearing in 10-6 to 10-7 
menus in 9-2 to 9-19 
switching to CommandShell from 3-3 

to 3-4 
Finder command 9-19 
Finder commands reference 9-1 to 9-19 
Finder Shortcuts command 9-18 
finding text (in TextEditor) 6-15 to 6-16 
floppy disks 

formatting 2-11 to 2-13 
inserting 2-11 
using to make backups 2-10 to 2-14 

folder access permissions 5-2 to 5-5 
changing 5-9 to 5-11 
default settings 5-5 
type of 5-4 to 5-5 

folder icons 2-4 
folders 

and directories 2-3 to 2-4 
icons 2-4 
naming or renaming 2-7 
permission limitations 2-7 

fonts 
changing in CommandShell windows 

3-18 to 3-19 
changing in TextEditor 6-18 to 6-19 

Font Size dialog box (in CommandShell) 
3-19, 9-29 

Fonts menu (in CommandShell) 9-29 
Format command 6-18 to 6-21, 9-47 
Format dialog box 6-18 to 6-19 
formatting 

floppy disks in Finder 2-11 
to 2-12 

floppy disks in CommandShell 
2-11, 2-12 to 2-13 

text in TextEditor 6-19 to 6-23 
Full Height command (in 

CommandShell) 9-27 

G 
Get Info command (in Finder) 9-5 
Get Info window (in Finder) 9-5 
global System Folder 8-6 
grep command 4-20 to 4-23 
grep Commando dialog box 4-20 
group permission 

file access 5-3 
Guest account, logging in to 1-13 to 1-14 

H 
Help box in Commando dialog boxes 

4-12 
hidden files 

displaying 8-12 
Hide Application command 9-19 
Hide CommandShell command 3-21 
Hide "Window Name' command (in 

CommandShell) 9-28 
hiding CommandShell windows 3-21 
hiding dot files 8-12 to 8-14 
home directory folder 1-9 to 1-10 
home directory folder icon 2-4 
home directory inaccessible 10-3 

I, J 
Icon command 9-12 
icons (Finder) 2-4 to 2-6 

not appearing 10-6 to 10-7 
inaccessible home directory 10-3 
incorrect password 10-3 
invisible characters in TextEditor 

6-20 to 6-21 

K 
Keyboard options dialog box 9-38 
Keypad command 9-32 
key repeating 8-16 
Kind command 9-14 
Korn shell 3-2, 8-9 
ksh command 8-8 

L 
Label command 9-15 
Label menu 9-16 
lack of power 10-2 
leaving CommandShell 3-20 to 3-21 
linking commands 4-27 to 4-29 
listing a directory's contents 4-6 to 4-9 
locked folder icon 2-4 
logging in 1-8 to 1-15 

and case sensitivity 1-12 
Console emulator appears 10-8 
Guest account 1-13 to 1-14 
home directory folder 1-9 to 1-10 
problems 10-3 
root account 1-14to1-15 
tutorials 1-12to1-13 
user account 1-9, 1-14 to 1-15 

logging out 1-20 
Login dialog box 1-11 

Guest account 1-13 
loginname 1-10,1-12 

case sensitivity 1-12 
tutorial account 1-12 

Login System Folder 8-6 
Logout command 8-3, 9-17 
looking up UNIX commands on screen 

4-23 to 4-27 
lpq command 7-8 
lpr command 7-6 to 7 8 
lprm command 7-9 
ls command 4-6 to 4-7 

-c option 4-8 
-1 option 4-8 
with Commando 4-12 to 4-17 

ls dialog box 4-11 

M 
Macintosh features disabled in A/UX 

8-15 to 8-16 
Macintosh file sharing permissions 5-11 

to 5-12 
Macintosh file system icon 2-6 
Macintosh file systems and programs 2-8 
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Macintosh floppy disk icon 2-6, 2-11 
Macintosh HFS hard disk 2-10 
Macintosh Operating System 

switching to 2-8 to 2-10 
MacPartition 1-2 
MacPartition icon 1-4 
Make Alias command 9-8 

in the File menu 1-6 
man command 4-24 
man pages 4-23 to 4-27 

displaying 4-24 
quitting 4-27 

manual pages. See man pages 
Mark command 6-26 
Mark dialog box 6-25 
markers 6-24 to 6-27 
marking text (in TextEditor) 6-24 to 6-27 
Mark menu 6-25 
Memory control panel 8-4 
Messages button 1-8 
monitor screen frozen 10-4 

N 
Name command 9-13 
naming files and folders/ directories 2-7 
National Replacement set menu 9-41 
New command (in CommandShell) 3-4, 

9-25 
New command (in TextEditor) 9-43 
New dialog box 9-44 
New Folder command (in Finder) 9-4 
New Window Settings command (in 

CommandShell) 3-13, 9-32 
New Window Settings dialog box 3-13 
Notification Levels command (in 

CommandShell) 3-11, 9-31 
Notification Levels dialog box 3-11 

0 
Open command (in CommandShell) 9-20 
Open command (in Finder) 9-4 
Open dialog box (in TextEditor) 6-11, 

9-44 

IN-6 Index 

opening a file (in TextEditor) 6-10 to 
6-11 

options 4-6 to 4-7 
others permission, file access 5-3 
output 4-3 

redirecting 4-3, 4-19 to 4-23 
standard 4-3 

owner permission, file access 5-3 
ownership, file or folder 5-3 

p 
Page Setup command 7-10, 9-9, 9-45 
Page Setup command (in 

CommandShell) 9-21 
Page Setup dialog box 9-9 
passwords 1-11 to 1-13 

changing 8-5 
incorrect 10-3 
start account 1-12 

Paste command (in CommandShell) 
3-18, 9-24 

Paste command (in Finder) 9-11 
Paste command (in TextEditor) 6-8, 

9-47 
pasting text into CommandShell 

windows 3-18 
pathnames 

absolute 2-17 
definition 2-14 
relative 2-17 

permissions (UNIX) 
default settings 5-5 
denied 5-6 to 5-7 
directory and folder access, changing 

5-7 to 5-11 
directory and folder access, types of 

5-3 to 5-4 
file access, changing 5-7 to 5-9 
file access, types of 5-2 
and icons 2-4 
purpose of 5-2 
restricting 5-2 

personal System Folder 8-6 to 8-7 

piping commands 4-27 to 4-29 
power, lack of 10-2 
Previous Window command (in 

CommandShell) 9-28 
Print command 7-5 
Print command (in Finder) 9-4 
Print dialog box (in CommandShell) 

3-20, 7-9 
Print dialog box (in TextEditor) 6-28 
print queue 7-8 to 7-9 

displaying 7-8 
Print Selection command 7-9 
Print Selection command (in 

CommandShell) 3-20, 9-21 
Print Selection command (in TextEditor) 

9-45 
print spooler 7-6 
printers 

connections 7-2 to 7-3 
failing to respond 10-6 
selecting with the Chooser 7-4 to 7-5 

printing 7-5 to 7-10 
A/UX text files 7-5 to 7-8 
canceling 7-8 to 7-9 
choosing a printer 7-4 to 7-5 
CommandShell window contents 

3-20, 7-9 to 7-10 
from TextEditor 6-27 to 6-29 
learning more about 11-5 to 11-7 
Macintosh way 7-5 
PrintMonitor 7-6 
queue 7-8 to 7-9 

PrintMonitor 7-6 
Print Window command (in Finder) 

9-10 
problems, correcting 10-1 to 10-8 
programming for A/UX, learning more 

about 11-6 to 11-7 
Put Away command 9-8 
pwd command 4-2 to 4-3, 4-5 



Q 
Quit command (at startup) 2-10 
Quit command (in CommandShell) 9_21 
Quit command (in TextEditor) 6-29, 9-45 

R 
read-only icon (in TextEditor) 6-12 
read permission 

files 5-2 
folders 5-4 

rebuilding the desktop database 10-6 to 
10-7 

recording lines scrolled off CommandShell 
windows 3-6 to 3-8 

redirecting the output of a command 
4-19 to 4-23 

reference notation format xxiv 
relative pathnames 2-17 
Replace Command 6-16 
Replace dialog box 6-16 
replacing text (in TextEditor) 6-16 to 

6-17 
resource fork (for saving formatting 

information) 6-2 to 6-10 
Restart command 1-21, 2-10, 9-18 
restarting 2-8 to 2-10 
restricting access to files and folders 5-2 
Restore From Preferences command (in 

CommandShell) 3-5 
restoring files 2-10 to 2-11 
restoring the preferred layout of 

CommandShell windows 3-15 
Revert to Saved command (in 

TextEditor) 6-10, 6-14, 9-45 
Revert to Saved dialog box 6-14 
rewriting text (in TextEditor) 6-12 
root account, logging in to 1-14 to 1-15 
root of the file system 2-14 
Rotate Windows command (in 

CommandShell) 9-28 

s 
Save a Copy command (in TextEditor) 

6-10, 9-45 
Save As command (in TextEditor) 6-9, 

9-45 
Save As dialog box (in TextEditor) 6-9 
Save Before Quitting dialog box 6-29 
Save Changed Preferences dialog box 

3-15 
Save command (in TextEditor) 6-9 to 

6-10, 9-44 
Save Preferences command (in 

CommandShell) 3-15 
Save Selection command (in 

CommandShell) 3-19 to 3-20, 
9-21 

Save Selection dialog box 3-19 
saving files in TextEditor 6-8 to 6-lO 
screen or computer frozen 10-4 to 10_5 
Screen setup options dialog box 9-36 
searching for character strings (grep) 

4-19 to 4-23 
searching for text (TextEditor) 6-15 to 

6-16 
Secure Startup 1-17 
Select All command (in CommandShell) 

9-23 
Select All command (in Finder) 9_ 11 
Select All command (in TextEditor) 9-47 
selecting text in CommandShell 

windows 3-17 
session types 

changing 8-2 to 8-4 
options 8-2 to 8-4 
24-bit and 32-bit 4-11, 8-2 to 8-4 

settimezone command 8-11 
setting the system date 8-11 to 8-12 
setting the system time 8-11 to 8-12 
Sharing command (in Finder) 9-6 
Sharing dialog box 9-6 
sh command 8-8 

shell script icon 2-5 
shells 3-2 

changing 8-8 
defined 3-2 
types of 3-2 

shell scripts, default permissions 5-6 
shifting text left or right (in TextEditor) 

6-21 
Shift Left/Right command 6-21, 9-48 
Show All Windows command (in 

CommandShell) 9-28 
Show Balloons command 9-18 
Show Clipboard command 6-7, 9-47 
Show Clipboard command (in Finder) 

9-11 
showing invisible characters (in 

TextEditor) 6-20 to 6-21 
shrinking CommandShell windows 3_6 
shrinking TextEditor windows 6-23 
Shut Down command 1-21to1-22, 9-l7 
Shut Down dialog box 1-21 
shutdown warning 10-5 
shutting down 

A/UX 1-20 to 1-21 
CommandShell 3-20 to 3-21 
the computer 1-21to1-22 

Size command 9-14 
slash (/) directory 2-14 to 2-17 
slash(/) folder icon 1-17 
Small Icon command 9-12 
Special menu 9-16 to 9-17 
stacking windows (TextEditor) 6-24 
Stack Windows command 6-24 
standard output 4-3 
Standard Positions command (in 

CommandShell) 9-27 
Standard Size command (in 

CommandShell) 9-27 
start account 

logging in to for tutorials 1-12 to 1-13 
maintaining 1-22 

start folder, locating 1-17 to 1-18 
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starting 
A/UX 1-4 to 1-8 
CommandShell 3-2 to 3-4 
the computer 1-3 
problems 10-2 
TextEditor 6-3 to 6-5 

Startup Items 
in MacPartition System Folder 1-6 

startup problems 10-2 
Startup System Folder 8-6 to 8-7 
substitute user (su) 4-18 to 4-19 
su command 4-18 to 4-19 
superuser 5-2 
switching between CommandShell and 

the Finder 3-3 to 3-4 
system administration 1-22 

documentation 11-3 to 11-4 
system date, setting 8-11 to 8-12 
System Folder 

global 8-6 
in MacPartition 1-6 
Login 8-6 
personal 8-6 to 8-7 
Startup 8-6 

system time 
default 8-10 
setting 8-11 to 8-12 

T 
tab settings in TextEditor 6-19 
terminal emulation (in CommandShell) 

3-16 to 3-17, 9-33 to 9-43 
active character sets 9-42 
ANSI cursor/application sequences 

9-39 
answerback message 9-35 
auto repeat keys 9-39 
auto wrap to next line 9-37 
character set setup options 9-40 to 

9-43 
general setup options 9-33 to 9-35 
insert characters 9-37 
inverse video 9-38 

IN-8 Index 

keyboard setup options 9-38 to 
9-40 

keyclick sound 9-40 
Keys menu 9-32 
national replacement character sets 

9-41to9-42 
new line on a Return 9-40 
numeric/application sequences 9-39 
on line/local echo 9-34 
origin at scrolling margin 9-37 
repeat Control keys 9-40 
screen character width/ size 9-36 to 

9-37 
screen setup options 9-36 to 9-38 
scroll text (jump/smooth) 9-38 
show control characters 9-37 
show status bar 9-34 
show tab ruler 9-35 
swap backspace and delete 9-39 
temporary character sets 9-42 
terminal mode 9-34 
text cursor 9-35 

Terminal Settings command 3-16 to 3-17 
Terminal Settings dialog box 3-16, 9-33 
terminology conventions xxvi to xxxi 
text editor 

default 8-9 to 8-10 
learning more about 11-5 

TextEditor 
and access permissions 6-11 to 6-12 
aligning text 6-20 to 6-21 
arranging windows 6-22 to 6-24 
Auto Indent check box 6-20 
changing tab settings 6-19 
Clipboard 6-7 to 6-8 
copying between documents 6-13 to 

6-14 
creating a new document 6-3 to 

6-8 
cutting and pasting text 6-6 to 6-8 
deleting text 6-12 
description of 6-2 
editing an existing file 6-10 to 6-17 
entering text 6-5 to 6-6 

finding text 6-15 to 6-16 
fonts, selecting 6-18 to 6-19 
invisible characters, showing 6-20 to 

6-21 
marking text 6-24 to 6-26 
printing an entire document 6-27 to 

6-28 
printing part of a document 6-28 to 

6-29 
printing with lpr 7-6 to 7-8 
quitting 6-29 
replacing text 6-16 to 6-17 
rewriting text 6-12 
resource fork (for saving formatting 

information) 6-2 to 6-10 
saving a new document 6-8 to 6-10 
searching for text 6-15 to 6-16 
shifting text left or right 6-21 
shrinking windows 6-23 
stacking windows 6-24 
starting 6-3 to 6-5 
tabs, selecting 6-19 
tiling windows 6-23 
unmarking text 6-27 

text file icons 2-5 
text files, printing 

Macintosh 7-5 to 7-6 
A/UX 7-6 to 7-9 

text-only file 6-2 
32-bit option 4-11, 8-2 to 8-4 
Tile command (in CommandShell) 9-24 
Tile Horizontal command (in 

CommandShell) 9-25 
Tile Vertical command (in 

CommandShell) 9-26 
Tile Windows command 6-23 
tiling windows 

CommandShell 3-5 
TextEditor 6-23 

time 
setting 8-11 to 8-12 

Time zone menu 8-11 
Time zone submenu 8-11 
troubleshooting 10-1 to 10-8 



tutorials, logging in for 1-12 to 1-13 
24-bit option 4-11, 8-2 to 8-4 
typing text (in TextEditor) 6-5 to 6-6 

u 

user permission file access 5-3 to 5-5 
users, categories 5-3 

v 
vi (visual editor) 6-2 

Undo command (in CommandShell) 9-22 View menu 9-11 
Undo command (in Finder) 9-10 Views control panel 8-14 
UNIX command icon 2-5 virtual memory 8-15 
UNIX commands, looking up on screen whoami command 4-4 to 4-5 

4-23 to 4-27 Window menu (in CommandShell) 9-23 
UNIX, definition xxii 
UNIX file hierarchy icon 1-16 
UNIX Permissions command 5-8, 9-6 to 

9-7 
UNIX Permissions dialog box 5-8, 9-6 
UNIX permissions. See permissions 
UNIX text files, printing 7-6 to 7-7 
Unmark command 6-27 
Unmark dialog box 6-27 
unmarking text (in TextEditor) 6-27 
user accounts 1-9 to 1-12 

changing 4-18 to 4-19 
logging in 1-11 to 1-12 

windows 
A/UX System Console 3-10 
A/UX System Console, alerts 3-11 
A/UX System Console, clearing 3-10 
A/UX System Console, closing 3-10 
A/UX System Console, viewing 

contents 3-10 
CommandShell. See CommandShell 

windows 
TextEditor, shrinking 6-23 
TextEditor, stacking 6-24 
TextEditor, tiling 6-23 

w 
world permission, file access 5-3 
write permission 

files 5-2 to 5-4 
folders 5-4 

X,Y 
X-11 option 8-2 

z 
Zooming (enlarging) windows in 

CommandShell 3-14 
Zoom Window command (in 

CommandShell) 3-14, 9-28 

Index IN-9 
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